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FCC Part 15 Compliance
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital 
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can radiate radio frequency energy and, if not installed and used in accordance with the 
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interference by one or more of the following measures:
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(PBB) and polybrominated diphenyl ethers (PBDE) exceeding their specified maximum 
concentration values tolerated by weight in homogeneous materials, except for the exemptions 
set in ANNEX Ill of the Directive and its amendments.

This information is offered in good faith to the best of our knowledge, but is subject to revision 
as new information becomes available.

California Proposition 65 Warning
This Product contains chemicals known to the State of California to cause cancer, birth defects, 
or other reproductive harm.
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Installation

Checking the Product
Open the packing box and confirm its contents.

Printer
• Printer

• Print cartridges (One each of yellow, magenta, cyan, black, and white*1)

*1: QL-300s only

• Power cord

Note: The package does not include a LAN cable, USB cable, or hub. Procure them 
separately.

Note: The packing box and packing materials are needed to transport the machine. Keep them 
and do not throw them away.
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Unwinder
• Unwinder

• Mounting screws (x3)

• Cable clamps (x3)

Choosing an Installation Location
For safe and comfortable operations, install the product in a location that satisfies the conditions 
in the following sections.

• “Precautions Related to Installation” on page 12

• “Choosing an Installation Location” on page 12

• “Installation Space” on page 14

Be sure to read these sections before starting installation work.

Precautions Related to Installation

Warnings
• Do not install the equipment in a location that is near open flame or may become very hot.

• Do not install the equipment in a location prone to chemical reactions (laboratory, etc.).

• Do not install the equipment in a location that is near flammable liquids, such as alcohol 
or paint thinner.

• Do not install the equipment in a location that is accessible by small children.
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• Do not install the equipment in a location that is unstable (on a wobbly table or inclined 
place).

• Do not install the equipment in direct sunlight or in a very dusty or humid location.

• Do not install the equipment in an environment subject to salt air, NOx, SOx or corrosive 
gases.

• Do not install the equipment in a location that is subject to excessive vibration.

• Do not install the equipment in a location where the machine's vents are blocked. Check 
the positions of the vents in the following illustrations.

Cautions
• Do not install the equipment on a thick-piled carpet or rug.
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• Do not install the equipment in a location that is poorly ventilated or stuffy.

• Pay attention to ventilation when operating the equipment continuously for a long period 
in a small room.

• Install the equipment away from sources of strong magnetic or electric noise.

• Install the equipment away from monitors or televisions.

• Remember to use ventilation when printing large volumes or operating the equipment 
continuously for a long period.

Installation Environment
Consider the following environment conditions when you select the installation location.

Use a location that is within the following ranges for temperature and humidity.

• Be careful that condensation does not form.

• If you install the equipment in a location where the humidity is in a range of less than 30%, 
use a humidifier or anti-static mat.

• The equipment satisfies the certification standards relevant to emissions for Eco-mark 
No. 155 printers in regard to dust, ozone, styrene, benzene, TVOC, and dispersion of 
ultrafine particles. (Testing has been done based on the testing methods in the Blue 
Angel RAL UZ-171: 2012 appendix S-M as regards to black and white and color printing 
by using toner in a genuine QuickLabel print cartridge.)

Installation Space
• Select an installation location that is level and can support the weight of the machine 

(weight of equipment is about 95 lbs (43 kg)* for the printer and about 42 lbs (19 kg) for 
the unwinder).

* Including the print cartridge and other wear items.

• Install the machine near a power socket. Also, install the equipment so the power socket 
is within easy reach so the power plug can be pulled out in an emergency.

• Do not place things around the machine.

To install the printer and the unwinder on a stand, the stand must be at least 42 inches (1050 
mm) wide and 20 inches (500 mm) deep. If you install the printer and the unwinder on a stand 
that is too small, they may fall off if they are hanging over the edge of the stand.

Temperature and Humidity Specification

Temperature range 10 to 30 º C

Humidity range 20 to 70% RH (relative humidity)

Maximum wet-bulb temperature 25 º C
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Install the equipment according to the equipment installation space shown in the diagrams.

Unpacking

Unpacking Precautions

Cautions
• Be sure to use two people to lift the equipment because it weighs about 95 lbs (43 kg).

• Hold the handles on the equipment when lifting it.

• Do not hold the control panel while lifting. There is a risk of injury if you hold the control 
panel, because the control panel may come off and you could drop the equipment.

• Place the equipment on the floor to remove the packing materials and the plastic bag.

There is a risk of dropping the equipment and causing injury if you hold the equipment 
while working.

• Be careful about handling the plastic bag.

• Dispose of the desiccant appropriately.
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Unpacking the Printer
This section describes how to unpack the printer.

Note: The packing box and packing materials are needed to transport the machine. Keep them 
and do not throw them away.

1. Open the top of the packing box and remove the machine's accessories.
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2. Remove the top layer of packing materials.
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3. Remove the handles (4 pieces), and then remove the top of the packing box.
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4. Open out the bottom part of the box, place your hands on the printer's handles (2 in 
front/2 in back) and support the printer as you remove the front and back packing 
materials on the bottom.
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5. Cut and remove the bands that secure the printer.

6. Remove the plastic bag.
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7. Remove the desiccant.

8. Place the printer in the installation space that you have confirmed in advance.

Allow enough space to work when installing the unwinder.

The weight of the equipment, including wear items, is about 95 lbs (43 kg). Install it on a 
stand that is strong enough.

9. Grasp the top cover open lever and open the top cover.
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10. Remove the Pad-TC from the top of the print cartridge, and then remove the tape that is 
securing the lift up lever.

11. The print cartridges lift up, so turn the lift up lever to lower the print cartridges.

Print cartridge when lifted up

Print cartridge when down
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12. Pull out the sheet-protection.

13. Close the top cover.

Caution: When closing the top cover, there is a risk of pinching your fingers or hands in 
the top cover or the top cover’s support. Press on the top of the top cover to close it.

Caution: There is a risk of pinching your fingers or hands if you hold the LED head while 
closing the top cover. Press on the top of the top cover to close it.
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Unpacking the Unwinder
This section describes how to unpack the unwinder.

Note: The packing box and packing materials are needed to transport the unwinder. Keep 
them and do not throw them away.

1. Open the top of the packing box.

2. Remove the top layer of packing materials.
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3. Remove the unwinder.
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4. Remove the plastic bag from the unwinder, and then remove the accessories.



Installation

QL-300 User Guide 27
 

5. Peel off the tape from two locations.
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Installation

Installing Cable Clamps
Cable clamps are provided with the unwinder. Use them to run the cable connected to the 
printer's interface along the front.

1. Install cable clamps (x 3 pieces).
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Installing the Unwinder on the Printer
After unpacking the unwinder, install it to the printer.

Caution: Be careful that you do not drop the unwinder.

Caution: Be careful that you do not pinch your hands or fingers between the unwinder and the 
printer.

Caution: Securely tighten the three screws. If they are loose, there is a risk that the unwinder 
may fall off or the print quality may be degraded.

1. Check whether the adjuster on the unwinder is raised up. If the adjuster is not raised, 
before you mount it on the printer, rotate it to the up position.
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2. Hold the unwinder close to the mounting pins and mounting hole, and then press it 
against the right side of the printer and lower it.
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3. Use three screws to secure the unwinder to the printer.

Tighten the screws in order 1, 2, then 3, as shown in the following diagram.

4. Extend the adjuster so it contacts the stand. Be careful not to extend the adjuster too far.

1

3

2
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Power

Precautions about the Electric Power

Symbol Warning

Be sure to turn off the power switch before attaching or removing the 
power cord or ground wire. Leaving the power turned on could result 
in a fire or electric shock.

Be sure to connect the ground wire to a dedicated ground terminal. 
Using the equipment without a ground wire connected could result in a 
fire or electric shock.
If you cannot connect to ground, contact the dealer where you bought 
the equipment.

Never connect a ground wire to a water pipe, gas pipe, telephone wire 
ground, lightning rod, or anything similar. Fire, electric shock, or gas 
explosion could result.

Always hold the power cord by the plug when you plug or unplug it. 
Pulling on the power cord could damage the power cord and result in 
a fire or electric shock.

Plug the power plug securely all the way into the power socket. Not 
plugging it all the way in could result in a fire or electric shock.

Do not plug or unplug the power plug if your hands are wet. Electric 
shock could result.

Do not step on or place objects on the power cord. The cord could be 
damaged and result in a fire or electric shock.

Do not use the power cord while it is tied or bundled up. The cord 
could overheat, be damaged and result in a fire or electric shock.

Do not use a damaged power cord. Fire or electric shock could result.
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The following conditions are required for the power source.

• If the power source is unstable, use a voltage regulator.

Do not plug too many power cords into a single power socket. Fire or 
electric shock could result.

Do not connect other electronic products to the same power socket as 
the machine. The machine may malfunction due to the electronic 
noise particularly if you connect an air conditioner, copier, shredder, or 
other device at the same time. If you must connect them to the same 
power socket, use a commercially available noise filter or noise cut 
transformer.

Do not use extension cords. If you use an extension cord, the drop in 
AC voltage may cause the machine to not operate correctly. If you 
must use one, use one that is rated for at least 100 V at 15 A. Fire or 
electric shock could result if you use one that is outside the specified 
range.

Do not turn off the power or unplug the power plug while printing. 
Damage or electric shock could result.

If the equipment will not be used for a long period, such as during an 
extended holiday or vacation, unplug the power cord to be safe.

Use the power cord provided with the machine. Do not use a power 
cord from a different product. Electric shock or fire could result.

The power cord provided with the machine is for the machine only. Do 
not use it for a different product. Electric shock or fire could result.

Operations are not guaranteed when using a UPS (uninterruptible 
power source) or inverter.
Do not use an uninterruptible power source or inverter. There is a risk 
of fire.

Voltage: 110 - 127 VAC (Range 99 - 140 VAC)
220 - 240 VAC (Range 198 - 264 VAC)

Frequency: 50/60 Hz ± 2%

Symbol Warning
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• The machine's maximum power consumption is 1200 W. Be sure that the power source 
has sufficient capacity.

• Operations are not guaranteed when using a UPS (uninterruptible power source) or 
inverter. Do not use uninterruptible power source or inverters.

Connecting a Power Cord
1. Securely insert the power cord provided into the power connector on the machine.

2. Plug the power plug into the power socket.

Turning on the Power
1. Press and hold the POWER button for approximately 1 second.

When the power is turned on, the LED lamp on the POWER button turns on.

When the machine starts, the startup screen appears on the LCD on the control panel. 
After a short time, the idle display appears and printing is possible.
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Turning off the Power
1. Press and hold the POWER button for approximately 1 second.

The message “Shutting down. Please wait. Printer will turn off automatically.” appears on 
the control panel and the LED lamp on the POWER button flashes at one second inter-
vals.

Wait a moment, and the machine's power automatically turns off and the LED lamp on 
the POWER button turns off.

Pressing the POWER button for five seconds or longer forces the power to turn off. Do 
this only if some trouble occurs. See “Troubleshooting” on page 268.

Warning: Do not touch the power plug or power socket if your hands are wet. There is 
a risk of electric shock.

Warning: Do not insert any metal objects, such as a screw driver, into the power socket. 
There is a risk of electric shock.

Test Printing

Adjusting Density and Test Printing
1. Set a roll of paper on the unwinder. Use continuous paper that is 5.12” (130mm) wide. 

See “Loading Media” on page 92.

2. Press the POWER button on the control panel to turn on the printer's power.

3. Press the scroll button ▼ several times to select Calibration, and then press the OK 
button.
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4. Press the scroll button ▼ several times to select Adjust Density, and then press the OK 
button.

5. Check that Execute has been selected, and press the OK button.

6. Press the scroll button ▼ several times, and when Print Information appears, press the 
OK button.

7. Press the scroll button ▼ to select DEMO Page, and then press the OK button.
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8. Check that DEMO1 has been selected, and press the OK button.

Paper feeds and a demo page is printed.

If the paper does not feed well or there are printing issues, confirm that the printer is 
installed correctly.

Adjusting the Position of the Sensor
You need to adjust the positions of the unwinder’s black mark/gap sensors and the printer, 
according to the media you are using. See “Calibrating the Sensor” on page 104.

Printer Black mark/Gap sensor:
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Unwinder Black mark/Gap sensor:
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PC Connection

Driver Installation Process Overview
This section describes how to connect the printer to a computer and how to install the printer 
driver.

Connecting to a PC with a Network Connection
1. Turn on the printer.

2. Set the printer's IP address.

3. Connect the cable.

4. Turn on the computer.

5. On the computer, set the IP address and configure other settings.

6. Install the printer driver.

Connecting to a PC with a USB Connection
1. Connect the cable.

2. Turn on the printer.

3. Turn on the computer.

4. Install the printer driver.

Operating Environment
This printer supports the operating systems (OS) listed below.

• Windows 10/Windows 10 (64-bit version)

• Windows 8.1/Windows 8.1 (64-bit version)

• Windows 8/Windows 8 (64-bit version)

• Windows Server 2016

• Windows Server 2012 R2

• Windows Server 2012

• Windows 7/Windows 7 (64-bit version)

• Windows Server 2008 R2

• Windows Server 2008/Windows Server 2008 (x64 version)

With Windows 10, Windows 8.1 and Windows 8, only the desktop mode is supported.
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Connecting Cables
This printer can connect to a computer or a network.

It comes with a LAN (network) interface connector and a USB interface connector as standard. 
A LAN cable can be used to connect to a network, while a USB cable can be used to connect 
to a computer.

Connecting a LAN Cable
When the printer is connected to a LAN (Ethernet) or other network, it can be shared by the 
computers on the network.

This printer is equipped with a network interface compatible with 10BASE-T/100BASE 
-TX/1000BASE-T as standard.
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If the cable is routed in front of the device, use the cable clamps attached to the unwinder. 
Passing the cable through the clamps avoids problems with unwinder operation.

1. Prepare a LAN cable and hub.

Note: The printer does not come with a LAN cable or hub. If you need a LAN cable 
(Category 5e or higher, twisted cable, straight) and hub, it is up to you to prepare them.

Note: The initial factory default setting of the Admin Setup is “Gigabit network: Disabled.” 
This setting needs to be changed in order to use a 1000BASE-T connection. Setting 
Procedure: On the control panel, input your password in Admin Setup, and then select 
Network Setup > Gigabit Network > Enable.

2. Connect the LAN cable to the printer's LAN (network) interface connector (1).

3. Connect the other end of the LAN cable to a hub connector (2).
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Connecting a USB Cable
Use this connector when connecting the printer to a computer with a USB cable.

Note: Do not connect the USB cable until prompted during the installation process. See 
“Installing the Printer Driver (USB)” on page 54.

1. Prepare a USB cable.

Note: The printer does not come with a USB cable. You need to prepare a USB 2.0 cable 
that is no longer than two meters.

Note: If you are planning to connect using the USB 2.0 Hi-Speed mode, you need to 
prepare a Hi-Speed USB 2.0 cable.

Note: USB 3.0 is not supported.

2. Taking care to orient the connector correctly, connect the square end of the USB cable 
to the printer (1).

3. Connect the other (flat) end of the USB cable to the computer (2).

Note: Do not plug the USB cable into the printer's LAN (network) interface connector. 
Doing so can cause malfunction of the printer.

Note: Do not plug or unplug the USB cable while the computer or printer is turned on. 
Doing so can cause malfunction of the printer.
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Network Connection
To connect the printer to a computer over a network connection, you first need to set the 
printer's IP address. Next, install the printer driver on the computer.

If there is no DHCP server or BOOTP server on the network, you need to manually set IP 
addresses for the computer and printer.

Fixed IP address settings specified by enterprise network administrators, providers, or router 
manufacturers must also be set manually.

Network Setup Flow
1. Turn on the printer.

2. Set the printer's IP address.

3. Turn on the computer.

4. On the computer, set the IP address and configure other settings.

5. Install the printer driver.

Note: A wrong IP address can cause a network to go down and make it impossible to connect 
to the internet. Check with your enterprise network administrator or internet service provider for 
the IP address you need to set on the printer, etc.

Note: Servers (DHCP, etc.) existing on a network depend on the network environment. For 
detailed information, check with your enterprise network administrator, internet service 
provider, or router manufacturer.

Note: PC administrator privileges are required for the setup.

Setting the Printer’s IP Address on the Control Panel
When configuring a small-scale network to connect the printer to a single computer, set an IP 
address as shown below (RFC1918 compliant).

• Computer

– IP address: Any address from 192.168.0.1 to 254

– Subnet mask: 255.255.255.0

– Default gateway: Not used

– DNS server: Not used

• Printer

– IP address specification: Manual 192.168.0.1 to 254 (Use an address different 
from that of the computer.)

– Subnet mask: 255.255.255.0

– Default gateway: 0.0.0.0

– Network scale: Small
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For this example, we show how to configure the settings below.

1. Press either the scroll button ▲ or ▼ on the control panel to display the Functions 
screen.

2. Press the scroll button ▼ several times to select Admin Setup, and then press the OK 
button.

3. Use the numeric keypad to input the administrator password.

The factory default password is 999999. Press the OK button after inputting each char-
acter.

4. Press the OK button.

IP address: 192.168.0.3 (computer)
192.168.0.2 (printer)

Subnet mask: 255.255.255.0

Gateway address: 192.168.0.1
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5. Check that Network Setup is selected, and then press the OK button.

6. Press the scroll button ▼ several times to select IP Address Set, and then press the OK 
button.

7. Choose whether to set the IP address manually or obtain an IP address automatically.

• To set the IP address manually, press the scroll button ▼ to select Manual, and 
then press the OK button.

Go to step 8.

• When obtaining an IP address automatically, confirm that Auto is selected, and 
then press the OK button.

Go to step 14.
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8. Press the scroll button ▼ several times to select IPv4 Address, and then press the OK 
button.

9. Press the scroll buttons ▲ and ▼ or the numeric keypad to input the first three digits of 
the IP address, and then press the OK button. Use the same operation to input the next 
three digits. After input is complete, press the BACK button.

To move to the next box, press the OK button.

Note: The IP address in the screen is an example. Check with your enterprise network 
administrator for the value to actually input.

10. Press the scroll button ▼ to select Subnet Mask, and then press the OK button.

11. Input the subnet mask the same way as the IP address. After input is complete, press the 
BACK button.
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12. Press the scroll button ▼ to select Gateway Address, and then press the OK button.

13. Input the gateway address the same way as the IP address. After input is complete, press 
the BACK button.

14. Press the ON LINE button to exit the network setup.

Configuring the IP Address and Other Settings on the Computer
If your computer already has an IP address and other settings configured, or if an IP address 
is obtained automatically, advance to “Installing the Printer Driver (Network)” on page 50.

1. Turn on the computer.

2. Click Start, and then select Control panel in Windows.
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3. Click View network status and tasks.

4. Click Change adapter settings.

5. Click the icon showing the name of the Network adapter.
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6. On the “Ethernet Status” screen, click Properties.

7. Select Internet Protocol Version 4(TCP/IPv4), and then click Properties.
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8. Input the IP address, subnet mask, default gateway, and DNS server, and then click OK.

Note: When obtaining an IP address automatically from a DHCP server, select Obtain 
an IP address automatically without inputting an IP address.

Note: If a default gateway or DNS server is not to be used, do not input its address.

9. Exit the “Ethernet Properties” screen.

Installing the Printer Driver (Network)
1. Ensure the QL-300 is powered on and connected to the network via a LAN cable. See 

“Connecting a LAN Cable” on page 40.

2. Start the driver installation software. You can obtain the software from 
www.QuickLabel.com/downloads.

3. When the language selection window is displayed, select a language. Then click OK.
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4. Read the Software License Agreement, and then click Accept.

5. Verify the pre-installation check items, and then click Next.
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6. Click Easy Installation (Network).

7. The driver searches for printers. After supported printers are detected, select the printer 
from the device list.
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8. Select the driver version that matches your printer model. For example, select 
QuickLabel QL-300s if you are using a QL-300s printer. Then click Next.

9. When you are prompted to create a port, select IP Address (Recommended). Then click 
OK.
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10. The printer driver will be installed. After installation is complete, click Finish.

USB Connection

USB Setup Flow
Note: Confirm that the printer is turned off.

Note: PC administrator privileges are required for the setup.

1. Turn on the printer.

2. Turn on the computer.

3. Install the printer driver.

Installing the Printer Driver (USB)
1. Ensure the QL-300 is powered off and not connected to your PC via the USB cable.

Note: Do not connect the USB cable until prompted later in this procedure.

2. Start the driver installation software. You can obtain the software from 
www.QuickLabel.com/downloads.

3. When the language selection window is displayed, select a language. Then click OK.
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4. Read the Software License Agreement, and then click Accept.

5. Verify the pre-installation check items, and then click Next.
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6. Click Easy Installation (Local).

7. Select the driver version that matches your printer model. For example, select 
QuickLabel QL-300s if you are using a QL-300s printer. Then click Next.
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8. When prompted, connect the QL-300 to your PC with a USB cable. Then power on the 
QL-300. The installation will continue.

9. The printer driver will be installed. After installation is complete, click Finish.

Windows Printer Drivers
There are two printer drivers available for the QL-300. You can use either the Windows PCL 
Printer Driver or the Windows PS Printer Driver. The driver you select will depend on your 
preferences and intended printing environment.

Use the Windows PCL Printer Driver if:

• You will be printing from CQL Pro software.

• Your labels contain dynamic content that will change at print time (serial numbers, dates, 
etc.).
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Use the Windows PS Printer Driver if:

• You will be printing from Adobe Illustrator, Adobe Photoshop, or other desktop publishing 
applications.

• Your labels contain only static artwork that will not change at print time.

• You want more control over the white toner application features on the QL-300s.

Dealing with Setup Problems
If you run into problems while setting up a network connection or USB connection, refer to 
“Troubleshooting” on page 268.

This section describes possible problems that may occur while operating the printer, and 
recommended steps to resolve them.
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Part Names and Functions

Printer Front/Left Side

# Part Description

1 Top Cover Open when replacing the print 
cartridge, belt unit, 2nd transfer 
roller, or waste toner box, or when 
clearing a paper jam.

2 Control Panel Displays the printer status and 
menus, and is used when 
configuring function settings. See 
“Control Panel” on page 66.

3 Power Connector Connect the supplied power cord 
here.

4 Fuser and Exit Unit Remove when replacing the fuser 
and exit unit or when clearing a 
paper jam.
The fuser and exit unit are wear 
items.

5 Fuser and Exit Unit Locking Lever Use when removing or installing 
the fuser and exit unit.

1

3

4 5

2
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Printer Exit

# Part Description

1 Fuser and Exit Unit Handle Pull upwards when removing the fuser 
and exit unit.

2 Exit Feed Cover Open when clearing a paper jam.

3 Release Lever Press downwards when opening the 
exit feed cover.

1

2

3
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Printer Interior 1

# Part Description

1 Print Cartridge Develop the image with toner drawn 
by the LED head, and transfer the 
toner image onto the belt unit.
The remaining life of the print cartridge 
is always displayed while the 
“Supplies Life” is specified for the 
standby screen of the control panel.
The print cartridge is a wear item.

2 Print Cartridge Set Remove when replacing the belt unit, 
2nd transfer roller, or waste toner box, 
or when clearing a paper jam.

3 LED Head Draws the image being printed onto 
the print cartridge.

4 Belt Unit Transfers toner to the paper.
The belt unit is a wear item.

5 Belt Unit Handle Grasp when removing the belt unit.

1

5

5

4

2

3
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Printer Interior 2

# Part Description

1 Waste Toner Box Stores waste toner.
A message appears on the control 
panel when the box is full of waste 
toner.
The waste toner box is a wear item.

2 2nd Transfer Roller Transfers toner to the paper.
The 2nd transfer roller is a wear item.
The 2nd transfer roller is included with 
the belt unit.

3 Paper Guide Remove when a paper jam occurs in 
the paper transport path or when 
cleaning the paper transfer roller.
The Paper Guide is a periodically 
replaced part.

1

2
3



Part Names and Functions

QL-300 User Guide 63
 

Interface Connectors

# Part Description

1 LAN (Network) Interface Connector For connection of a LAN cable. Use 
this connector when connecting the 
printer on a network.

2 USB 2.0 Interface Connector For connection of a USB 2.0 cable. 
Use this connector when using a USB 
cable to connect the printer directly to 
a computer.

1

2
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Unwinder

# Part Description

1 Unwinder Cover Open this when setting paper or 
clearing paper jams.

2 Roll Paper Holder Sets the paper to be printed.

3 Flange Fixes roll paper to the roll paper holder 
so the roll paper set on the roll paper 
holder feeds straight.

4 Flange Locking Lever Use when removing/mounting the 
flange.

5 Roll Paper Holder Knob Use when securing the core of a roll 
paper that has been placed on the roll 
paper holder.

6 Tension Bar Open Lever Keeps roll paper that has been set 
from sagging.

7 Unwinder Cover Open Lever Lower to open the unwinder cover.

1

2

3

457 6
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Unwinder Interior

# Part Description

1 Roll Paper Guide Adjustment Knob Rotate the knob to adjust the roll paper 
guide to the width of the paper to be 
printed.

2 Roll Paper Guide Align the roll paper guide along the 
edge of paper to be printed.

3 F0 Roller Unit The F0 roller unit is a roller for feeding 
roll paper.
The F0 roller unit is a periodically 
replaced part.

4 Cutter Unit Cuts the roll paper to a specified 
length.
The cutter unit is a periodically 
replaced part.

1 2

3

4
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Control Panel

Control Panel Overview
The control panel can be used to check the current status of the printer and to access various 
functions available with the printer.

With this printer, print cartridges etc. can be replaced while monitoring the LCD on the control 
panel. If a paper jam or some other problem occurs on the printer, corrective action can be 
taken while monitoring messages that appear on the LCD.

# Part Description

1 Display screen • Shows the printer's status and 
menus.

• The standby screen shows either of 
two displays: “Supplies Life display” 
or “Unwinder Config display”.

2 POWER button • Turns the main power supply of the 
printer on or off.

• Pressing this button while in the off 
mode turns on the main power 
supply.

3 POWER SAVE button • Enters or exits the Power Save 
Mode.

• This button is lit green in the Power 
Save Mode.

1

2

3

5
6

7 8
11

10

94
13

12
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4 OK button (menu button) Executes the currently selected menu 
item or applies the setting being 
configured.

5 HELP button • Displays the Help Screen.
• This button lights orange when you 

can refer to help messages 
describing the error that has 
occurred and providing information 
about how to clear the error.

6 BACK button Goes back to the previous screen.

7 ATTENTION lamp Indicates the printer's status.
This lamp is unlit when the status is 
normal.
An error causes this lamp to light or 
flash orange.

8 Scroll buttons ▲ and ▼ (menu 
buttons)

• Use these buttons to select menu 
screen items, and to scroll menu 
pages forward or back.

• On a value input screen, these 
buttons are used when inputting 
values.

9 ON LINE button • Switches between online and 
offline.

• This button is lit green while the 
printer is online and unlit when 
offline.

10 Numeric keypad (1 to 0, *, C) • The numeric keypad is used when 
inputting numeric values or pass-
words.

• Pressing the * (Fn) key while the 
standby screen is displayed 
displays the “Function Number 
Input” screen for inputting a number 
that directly accesses menu items.

11 CANCEL button Cancels an ongoing print job or setting 
operation.

12 FEED button Feeds paper.

13 UNLOAD button Unloads paper.

# Part Description
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Using the Control Panel
This section describes the main operations that can be performed using the control panel, and 
provides information about interpreting LCD contents.

• When a menu item represents a next-level menu or a selection of setting options, 
selecting the item and then pressing the OK button displays the applicable screen.

• While a setting is displayed, pressing the OK button applies it. (A check mark appears to 
the left of the value.)

Standby Screen
The standby screen shows either of two displays: “Supplies Life display” or “Unwinder Config 
display”.

Use the procedure below to switch between the two standby screen displays.

1. Press either the scroll button ▲ or ▼ to display the Functions screen.



Control Panel

QL-300 User Guide 69
 

2. Press the scroll button ▼ several times to select Admin Setup, and then press the OK 
button.

3. Use the numeric keypad to input the administrator password.

The factory default password is 999999. Press the OK button after inputting each char-
acter.

4. Press the OK button.

5. Press the scroll button ▼ several times to select Panel Setup, and then press the OK 
button.

6. Press the scroll button ▼ several times to select Idle Display, and then press the OK 
button.
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7. To show the Supplies Life display, select Supplies Life, and then press the OK button.

If you want to display the Unwinder Config display, select Unwinder Config, and then 
press the OK button.

8. Press the ON LINE button to return to the standby screen.

Error Screen
When a problem occurs on the printer, the ATTENTION lamp lights or flashes, and a message 
appears on the LCD.

Depending on the error, information about how to clear the error or an animation also appears 
in addition to the message.

Pressing a control panel button while an error screen is displayed changes the status of the 
printer as described below.

Button Action

POWER SAVE Puts the printer into the Power Save Mode.
Pressing the POWER SAVE button while the printer is in the 
Power Save mode returns to the standby screen.

HELP If the HELP button is lit, pressing it displays help information 
about the displayed error.

OK If the error message indicates a clearable error, pressing the 
OK button returns to the standby screen.

ON LINE If the error message indicates a clearable error, pressing the 
ON LINE button returns to the standby screen.



Control Panel

QL-300 User Guide 71
 

Help Screen
Press the HELP button to display the Help Screen. If the HELP button is lit, pressing it displays 
help information about the displayed error.

While a help screen is displayed, pressing the scroll button ▲ scrolls to the previous page. 
Pressing the scroll button ▼ scrolls to the next page. Long pressing the scroll button ▲ or ▼ 
scrolls the page for approximately 0.5 seconds.

To exit the help screen, press the HELP button again. The help screen can also be closed by 
pressing the BACK button, ON LINE button, or CANCEL button.

Using the Numeric Keypad
The numeric keypad is used when inputting numeric values or alphabetic characters.

Each press of a key cycles through the characters assigned to it as shown below.

CANCEL The errors listed below can be canceled with the CANCEL 
button.
• Press the UNLOAD button and replace paper.
• There is no paper on the unwinder.
• Restart printing from the page below.
• Cut the paper and start printing.
• Insufficient memory. Print data is too large.

Button Action

Key Characters

1 1
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For example, to input “abc” press the following: 2 → 2 → OK → 2 → 2 → 2 → OK → 2 → 2 → 
2 → 2 → OK.

The numeric keypad also has two other keys, whose functions are described below.

Function Number Input Screen
While “Ready to print” is displayed on the standby screen, pressing the Fn key and then 
inputting a number displays the corresponding menu.

1. Press the Fn key.

2 Cycles with each press (2 → a → b → c)

3 Cycles with each press (3 → d → e → f)

4 Cycles with each press (4 → g → h → i)

5 Cycles with each press (5 → j → k → l)

6 Cycles with each press (6 → m → n → o)

7 Cycles with each press (7 → p → q → r → s)

8 Cycles with each press (8 → t → u → v)

9 Cycles with each press (9 → w → x → y → z)

0 0

Key Description

Fn Pressing this key displays a shortcut to the function number. (Enabled 
when standby screen is displayed.) When inputting a value, this key is 
used to cycle through symbols.

CLEAR When inputting a password, pressing this key deletes a single 
character.

Key Characters
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2. On the function number input screen that appears, use the numeric keypad to input a two- 
or three-digit number, and then press the OK button.

3. On the menu that appears, you can check the current setting and change it, if you want.

Function Number List

Function 
Number Function Number Menu Item

90 Paper Size

91 X Dimension *1

92 Y Dimension *1

93 Media Type

94 Media Weight

100 Print Information (Configuration)

102 Print Information (Usage Report)

103 Print Information (Error Log)

200 Power Save Time

202 Auto Power Off Time

210 Error Report

220 Print Position Adjust
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*1: Enabled only if the paper size is set to Custom.

230 Media Transfer Setting Black

231 Media Transfer Setting Color

234 SMR Setting

235 BG Setting

236 Drum Cleaning

237 Hex Dump

238 Transfer Roller Cleaning

300 Adjust Density

301 Adjust Registration

302 Print Color Tuning Pattern

310 Cyan Density

311 Magenta Density

312 Yellow Density

313 Black Density

314 White Density

890 Unwinder Config

891 Media Form

892 Adjust Cut Position

893 Sensor Calibration

894 Check Media Pitch

895 Cut Mode

Function 
Number Function Number Menu Item
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Paper Settings

Usable Media Types
For high-quality printing it is necessary to use paper that satisfies conditions regarding quality, 
thickness, paper finish, etc. Only print on media recommended by QuickLabel.

If using a (paper) medium that is curled or wrinkled before printing, print quality and paper 
traveling performance cannot be assured.
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Paper Types, Size, and Thickness

Roll Paper Specifications

Media Form Description

Continuous Paper Paper wound on a roll

Continuous Paper (Black Mark) Paper wound in a roll with black marks printed on the 
back surface

Die-cut Label (Gap) Paper that is die-cut into a label shape

Die-cut Label (Black Mark) Paper that is die-cut into a label shape with black marks 
printed on the back surface

Continuous Label Paper that is not die-cut into a label shape, with the 
entire surface covered with label paper

Continuous Label (Black Mark) Paper that is not die-cut into a label shape, with the 
entire surface covered with label paper and black marks 
printed on the back surface

Media Type Description

Plain Wood-free Paper

Plain Labels Label paper made of wood-free paper

Glossy Labels Label paper made of glossy paper

Film Labels Label media made of film

Film Film

Roll Paper Size Specification

Roll Outside Diameter No greater than 203.2 mm (8 inches)

Paper Width 25.4 to 130 mm (1 to 5.12 inches)

Paper Thickness 0.07 mm to 0.25 mm (0.003 to 0.0098 inches)
When there is backing paper, total thickness includes 
backing paper.

Roll Core Width Same as roll paper

Roll Core Inner Diameter 76.2 mm
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• Using metal foil paper or conductive paper creates the risk of defective printing due to 
electrical discharge, and device malfunction.

Use of metal foil paper and conductive paper is prohibited.

• Use paper that has black marks printed on its back surface (non-printing surface). Black 
marks printed on the front surface cannot be detected.

• Use paper with black marks printed with carbon ink.

• Thermal paper will become discolored and deformed by heat used for fusing. Do not use 
it.

• Use film that can withstand heat up to 230°C. Use of film that is not heat resistant creates 
the risk of film deformation by heat used for fusing, paper jams, and device malfunction.

• Do not use a liner on which glue is smeared. It will not feed correctly in the equipment. In 
the worst case, it could damage the equipment.

• Cast-coated paper is not recommended. Printing quality cannot be guaranteed when it is 
used.

• If the paper length, label length, or black Mark Interval for a single sheet is less than 4 
inches, blank sheets may be printed to satisfy the paper length that can be fed.

• Use of the types of paper below is not supported.

Paper whose roll surfaces are not cut cleanly

Paper that is connected part way through by tape, etc.

Label paper without backing paper with paste on the front surface

Paper whose labels are easy to peel or are peeling

Paper with paste squeezing out onto the base paper area or affixed to the label surface

Paper that is folded or bent

Paper that has holes in it

Paper that is notched

Paper that has perforations

Paper with different size labels on a single roll

Paper with different paper widths on a single roll

Setting the Paper Weight
Set the printer and printer driver paper weight according to the weight of the paper to be used.

Paper Weight
(Total thickness including backing paper) Setting Value of the Media Weight

76 to 95 μm Light

96 to 140 μm Medium Light

141 to 159 μm Medium

160 to 180 μm Medium Heavy
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Storing Media
Improper paper storage can cause absorption of moisture, discoloration, and warping. Note that 
printing on such paper can adversely affect print quality, feeding, etc. Leave packages of media 
unopened until you are actually ready to use them.

Store media in locations like the ones described below:

• On a flat shelf in a location that is dark and where there is little moisture

• On a flat table

• An environment with a temperature of 73°F ±1.8°F (23°C ±1°C) and humidity of 50%RH 
±2%

Avoid locations like the ones described below:

• Directly on the floor

• In direct sunlight

• Near the inside surface of an external wall

• On a surface that is uneven or curved

• In a location where electrostatic charge is generated

• In a location subjected to very high temperatures or sudden temperature changes

• Next to a photocopying machine, air conditioning equipment, heater, or duct

Note: Proper printing may not be possible on paper that has been stored for a long time.

Note: Leaving roll paper in an environment where it is exposed to high temperatures and high 
humidity for long periods can cause it to become deformed. Do not use deformed roll paper. 
Store roll paper in an environment where the temperature and humidity are appropriate.

Note: We recommend putting partially used label paper back into the vinyl bag it was 
packaged in, to prevent the paper from absorbing moisture.

Registering a Desired Paper Size with the Printer Driver
1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.

181 to 199 μm Heavy

200 to 214 μm Ultra Heavy1

215 to 229 μm Ultra Heavy2

230 to 249 μm Ultra Heavy3

Paper Weight
(Total thickness including backing paper) Setting Value of the Media Weight
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3. Right-click the QL-300 icon, and then select Printing preferences.

If you are using the Windows PCL printer driver, the following window will open.

If you are using the Window PS printer driver, the following window will open.

4. On the Setup tab, click User-defined paper.

5. Input information about the paper you want to register.

a. Use Registered user-defined paper to select New Paper.

b. In the Paper Name box, enter a paper name.

c. Select a Media Form to match the paper.

d. Select a Media Type to match the paper.

e. Select a Media Weight to match the paper thickness.

If you are unsure of the paper thickness, select Medium Light.
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f. Enter paper size information.

Input the label length and gap for media that has gaps and the black mark interval 
for black mark media.

Use a ruler to measure, as accurately as possible, the actual size of the media, and 
then input those values.

If the label length or the black mark interval is less than 4 inches, use the following 
method to measure the media, and then input values to the first decimal place to 
be accurate.

How to Measure the Actual Size of Paper

(1) Measure the length from the leading edge of the first label (or black mark 
leading edge) to the leading edge of the 11th label (or black mark leading edge). 
Use this as L (mm).

(2) Divide the length you measured in (1) by 10 to calculate the length from the 
leading edge of the first label (or black mark leading edge) to the leading edge of 
the 2nd label (or black mark leading edge) to the first decimal place.

(3) Subtract the length of the gap from the length you calculated in (2) to calculate 
the length of one label to the first decimal place.

For media that has gaps, input the value calculated in (3) in Label length and input 
the gap length in Gap.

For media that has black marks, input the value calculated in (2) in Black Mark 
Interval.

Note: The minimum page length is 25.4 mm (1 inch) for the Windows PS printer driver, 
which is different from the Windows PCL printer driver.
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6. Enter other information as required.

a. If you performed sensor adjustment, select the sensor setting that was registered 
to the device from Sensor settings.

For information about adjusting the sensor, refer to “Calibrating the Sensor” on 
page 104.

b. If you want to fine-tune the image position, enter the position shift amount into Print 
position correction.

c. If you want to fine-tune the paper cut position, enter the position shift amount into 
Cut position correction.

7. When all the input is complete, click Add.

Using the Printer Driver to Fine-tune the Print Position
1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.
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3. Right-click the QL-300 icon, and then select Printing preferences.

If you are using the Windows PCL printer driver, the following window will open.

If you are using the Window PS printer driver, the following window will open.

4. On the Setup tab, click User-defined paper.
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5. Use the Registered user-defined paper list to select the paper whose print position you 
want to correct.

If the paper you want to use is not in the list, select New paper and add it. See “Regis-
tering a Desired Paper Size with the Printer Driver” on page 78.

6. In Print position correction, set the values for the print start positions vertically and 
horizontally on the paper.

7. Click Overwrite.

8. Click OK or Close as many times as necessary to exit the “Printing preferences” screen.

9. Open the file to be printed.

10. Specify the paper size, and then print.
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Using the Printer Driver to Fine-tune the Cut Position
1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.

3. Right-click the QL-300 icon, and then select Printing preferences.

If you are using the Windows PCL printer driver, the following window will open.

If you are using the Window PS printer driver, the following window will open.

4. On the Setup tab, click User-defined paper.
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5. Use the Registered user-defined paper list to select the paper whose cut position you 
want to correct.

Note: If the paper you want to use is not in the list, select New paper and add it. See 
“Registering a Desired Paper Size with the Printer Driver” on page 78.

6. Use Cut position correction to specify an adjustment value for distance from the print 
completion position to the cut position.

7. Click Overwrite.

8. Click OK as many times as necessary to exit the “Printing preferences” screen.

9. Open the file to be printed.

10. Specify the paper size, and then print.
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Full-Bleed Label Example
In full-bleed labels, color prints up to the edge of the label. With non-bleed labels, color stops 
at a margin before the edge of the label.

You can print non-bleed labels on gap media. Full-bleed labels, however, must be created 
using die-cut label media with the matrix left intact.

This section provides general setup information and examples for printing full-bleed labels.

Required Information
• Media construction width - Measurement including edge trim, matrix, and label

• Media construction length - Measured from the top of a mark to the top of the next mark

• Printable width - Media construction width minus the PCL driver left and right margins

• Printable length - Media construction length minus the PCL driver top and bottom 
margins

• Non-printable margins set by the PCL driver for Continuous Paper (Black mark)

Top/Left/Right margin: 0.083" (2.12mm)

Bottom margin: 0.126" (3.20mm)

General PCL Driver Setup
• Media Form: Continuous Paper (Black mark)

• Black mark interval (Y): Media construction length

• Paper width (X): Media construction width

• For over bleed on the trailing label edge:

Print position correction: Adjust as needed

General CQL Pro/Label Design Setup
• Printable Label Size:

Width: Printable width

Length: Printable length

• Create display margins to display die-cut location for over bleed:

Top margin: Top of leading mark to Die-cut (.25" (6.35mm)) minus top margin

Bottom margin: Top of trailing mark to Die-cut (.25" (6.35mm)) minus bottom margin (This 
value is approximately zero)

Left margin: (Edge trim plus bleed zone) - left margin

Right margin: (Edge trim plus bleed zone) - right margin

Example PCL Driver Setup
Example Setup For Mark Media with 4" x 6" (101.6mm x 152.4mm) Die-cut Label:

• Media Form: Continuous Paper (Black mark)
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• Black mark interval (Y): 6.375" (161.9mm)

• Paper width (X): 4.625" (117.5mm)

• For over bleed on the trailing label edge:

Y Position: 0.05" (1.3mm) (As Needed)

Example CQL Pro/Label Design Setup
Example Setup For Mark Media with 4" x 6" (101.6mm x 152.4mm) Die-cut Label:

• Printable Label Size:

Width: 4.459" (113.3mm)

Length: 6.166" (156.6mm)

• Create display margins to display die-cut location for over bleed:

Top margin: 0.167" (4.2418mm)

Bottom margin: 0.0" (0.0mm)

Left margin: 0.2295" (5.8293mm)

Right margin: 0.2295" (5.8293mm)

QL-300 Media Settings
Use the following table to select the recommended printer driver settings associated with your 
QL-300 media. These settings provide good print quality and durability. Your results may vary 
depending on label content, toner amounts, and environmental factors. Individual adjustments 
may improve results.

QL-300 Materials Media Type Setting Media Weight Setting

#61 Card Stock Glossy Heavy
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#66 Matte Paper Glossy Ultra Heavy 1

#106 Matte White Vinyl Film Label 1 Heavy

#117 Clear PET Film Label 1 Ultra Heavy 3

#121 Textured Wine Label Plain Label Medium

#122 Matte White Vinyl Film 1 Heavy

#128 Vellum Wine Label Plain Label Medium

#135 Semi Gloss Paper Plain Label Ultra Heavy 3

#154 Semi Gloss PET Glossy Ultra Heavy 2

#158 High Gloss Paper Film 1 Ultra Heavy 1

#168 Matte Polyester Film 1 Ultra Heavy 3

#172 Gloss Polypropylene Film Label 1 Ultra Heavy 1

#198 Satin Polypropylene Film Label 1 Heavy

#199 Clear Gloss Polyester Glossy Label Heavy

#223 Matte Vellum Glossy Label Ultra Heavy 3

#245 High Gloss PET Film Label 1 Ultra Heavy 3

#253 Kraft Paper Plain Label Medium Light

#254 Black Paper Film Label 1 Ultra Heavy 3

#255 Matte Gold Paper Glossy Medium-Heavy

#256 Bright Gloss Silver 
Paper

Glossy Medium-Heavy

#257 Matte Silver Paper Glossy Medium-Heavy

#259 Gloss Silver Metallic 
PET

Film Label 1 Medium

#260 Bright Gloss Gold 
Paper

Glossy Medium-Heavy

#261 Grasspaper Glossy Medium

#264 Hemp Paper Plain Label Medium

QL-300 Materials Media Type Setting Media Weight Setting



Paper Settings

QL-300 User Guide 89
 

#265 Grape Label Plain Label Medium

#273 White Polyolefin Glossy Label Medium-Heavy

#279 Matte clear PET Glossy Label Medium

QL-300 Materials Media Type Setting Media Weight Setting
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Printing

Preparing Paper
This section describes how to load paper onto the holder of the unwinder. For paper sizes and 
types that can be loaded onto the unwinder, see “Paper Types, Size, and Thickness” on page 
76.

1. Remove the paper from the packaging.

2. Take care of the tape that is holding the leading edge of the paper.

If there is no tape holding the leading edge of the paper, you can just load it as is.

a. Remove the tape [1] that is holding the leading edge.

Caution: Remove the tape that is holding the leading edge of the paper before you 
use it. Do not load paper while the tape is still attached and feed it into the 
equipment. There is a risk of damaging the equipment.

b. Cut off the part of the paper [2] on which there is leftover adhesive [3].

Caution: There is a risk of adhesive being left over after removing the tape. If 
paper that still has adhesive on it is fed into the equipment, the adhesive may stick 
to the feed path and damage the equipment.
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3. Check the leading edge of the paper and cut it off straight.

If the leading edge of the paper is cut straight, you can just load it as is.

Be particularly careful when replacing paper and after removing and reloading jammed 
paper.

When loading paper, cut the leading edge of the paper straight before loading it.

Caution: Do not cut at an angle, do not cut black marks, and do not cut labels. 
Depending on the size and shape of the leading edge, there is a risk of skewing the print 
position, not being able to print, or damaging the equipment.

• Standard media and continuous labels (dry edge)

• Standard media (with black marks) and continuous labels (dry edge)

1.2 to 4.0 mm (0.0472 to 0.1575 inches) Length of leading margin when paper is 
loaded
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• Die-cut label paper (no black marks)

1.2 to 6.5 mm (0.0472 to 0.2559 inches) Length of leading liner when paper is 
loaded

• Die-cut label paper (with black marks)

1.2 to 4.0 mm (0.0472 to 0.1575 inches) Length of leading margin when paper is 
loaded

Loading Media
Load the paper onto the Unwinder. For paper sizes and types that can be loaded on the 
Unwinder, see “Paper Types, Size, and Thickness” on page 76.

Note: When setting roll paper, be careful not to drop it. As roll paper is heavy, when you drop 
it, there is a risk of injury.

Note: If you drop roll paper, it may roll on the floor and cause injury to the people around.

Note: To prevent roll paper from dropping, store it horizontally on a desk, etc.

Note: Do not use any roll paper that is not specified by the Roll Paper Specifications.
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If the printer is turned OFF, press the POWER button to turn it on.

1. Open the Flange Locking Lever.

2. Remove the flange.
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3. Rotate the Roll Paper Holder Knob to contract the Roll Paper Holder shaft.

4. Slide roll paper onto the Roll Paper Holder shaft as far as it will go.

Note: Make sure to slide the roll paper as far as it will go. Insufficiently sliding the roll 
paper can adversely affect print position accuracy.

Note: Take care to avoid pinching your fingers or hands when sliding the roll paper.
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5. Rotate the Roll Paper Holder Knob to fix the roll paper core in place.

Note: Rotate the Roll Paper Holder Knob until it clicks.

6. Aligning the Flange with the Roll Paper Holder shaft as shown in the illustration, attach 
the Flange.

7. Slide the Flange as far as it will go in accordance with the roll paper width.

Note: Slide the Flange up to the side of the loaded roll paper.

Note: Take care to avoid pinching your fingers or hands when attaching the Flange.
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8. Close the Flange Locking Lever.

Caution: After loading roll paper, take care not to rest your body weight on the top of the 
Roll Paper Holder shaft. Doing so risks causing injury due to the device falling.
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9. Lower the Unwinder Cover Open Lever to open the Unwinder Cover.

Open the Unwinder Cover manually in the direction indicated by the arrow until it locks.

Note: Open the Unwinder Cover until it locks securely.
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10. Before loading the paper, rotate the Roll Paper Guide Adjustment Knob counterclockwise 
and move the Roll Paper Guide towards you.

11. Pull up the F0 Roller Release Lever.

12. Press the Tension Bar Open Lever upwards until it clicks.
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13. Pass paper below the Tension Bar and F0 Roller, and align the leading edge of the paper 
with the Roll Paper Guide [1] and Paper Guide [2].
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14. Check the paper status from the direction indicated by the arrow.
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15. Rotate the Roll Paper Guide Adjustment Knob to adjust the paper until it is straight.

If you rotate the Roll Paper Guide Adjustment Knob in:

• Direction A - the roll paper moves in the direction C

• Direction B - the roll paper moves in the direction D

16. Lower the F0 Roller Release Lever to fix the roller in place.

17. Press down on the Tension Bar Open Lever until it clicks.
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18. After loading the paper, rotate the Roll Paper Guide Adjustment Knob clockwise and align 
the Roll Paper Guide to the width of the paper.

Note: Set the Paper Guide correctly. If the Paper Guide is not set correctly, the width of 
the paper cannot be detected correctly.

Note: Be careful that the Roll Paper Guide does not press too strongly on the paper. 
Doing so could damage the paper.

Note: Do not allow too much of a gap between the paper and the Roll Paper Guide. 
Doing so could allow the paper to twist and the print position to shift.

• In the following example, the gap is too large.



Printing

QL-300 User Guide 103
 

• In the following example, the Roll Paper Guide is aligned to the width of the paper.

• In the following example, the Paper Guide is too tight.

19. Close the Unwinder Cover.

Caution: When closing the Unwinder Cover, there is a risk of pinching your fingers or 
hands. Press the top of the Unwinder Cover to close it.
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Calibrating the Sensor
Check the position of the sensor each time you load paper. Check the position of the sensor in 
the following cases especially.

• When you load a different type of paper

• When you switch the type of sensor from black mark sensor to gap sensor

• When you switch the type of sensor from gap sensor to black mark sensor

If the sensor position settings do not match, paper feed jams may occur, you cannot adjust the 
black mark sensor or the gap sensor, and the skew in the adjusted values may cause the print 
position to skew.
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Confirming the Unwinder Sensor Position
1. Lower the Unwinder Cover Open Lever to open the Unwinder Cover.

Open the Unwinder Cover manually in the direction indicated by the arrow until it locks.

Note: Open the Unwinder Cover until it locks securely.
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2. Confirm the sensor position.

a. Check the black mark sensor position

Align the paper, and check the actual position of the black mark and the black mark 
sensor position.
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If the position of the black mark and the black mark sensor position do not align, 
rotate the Sensor Position Adjustment Dial to adjust the position (go to step 3).

The black mark sensor position is set 10 mm from the edge of the paper.

If the black mark is about 15 mm from the edge of the paper, you do not need to 
adjust it.

If the black mark is 15 mm or less from the edge of the paper, adjust the position 
of the Δ so it is in the center of the black mark.
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b. Check the gap sensor position

Align the paper, and check the actual position of the label and the gap sensor posi-
tion.

If the position of the label and the gap sensor position do not align in relation to the 
regular usage position, rotate the Sensor Position Adjustment Dial to adjust the 
position (go to step 3).

The gap sensor position is set 16.5 mm from the edge of the paper.

If there is 10 mm or less on the right and left edges of the liner, then adjustments 
are not necessary.

If there is 10 mm or more on the right and left edges of the liner, then adjust the 
gap sensor using the above positions as a rough estimate.

If the corners of the label are rounded, then consider the position of the radius of 
the corner.

Refer to the following example of adjusting the position.
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3. Rotate the Sensor Position Adjustment Dial to adjust the sensor position.

• If you rotate the Sensor Position Adjustment Dial in direction A, the sensor position 
moves in the direction C.

• If you rotate the Sensor Position Adjustment Dial in direction B, the sensor position 
moves in the direction D.

Confirming the Printer Sensor Position
1. Grasp the top cover open lever and open the top cover.
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2. Remove the print cartridge set.

3. Place the removed print cartridge set on a flat surface covered with newspaper or 
something similar, and cover it with paper so it is not exposed to direct light.



Printing

QL-300 User Guide 111
 

4. Turn the two belt locking keys counterclockwise to release the lock.
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5. Hold the belt unit handles (blue) on the left and right, and remove the belt unit at an angle.

Caution: Be careful not to spill waste toner while removing the belt unit.

Caution: Be careful to not pinch your hands or fingers between the handle and the 
machine while removing the belt unit.

Caution: When removing the belt unit, do not tilt it further than is needed to remove it.
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6. Place the belt unit with the right side down on a flat surface covered with paper.

Caution: Place the belt unit on a flat surface, as shown in the diagram above. Do not 
stand it on its side.

Caution: Do not touch the belt surface or damage the belt.
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7. Confirm the sensor position.

a. Check the black mark sensor position

Align the paper, and check the actual position of the black mark and the black mark 
sensor position.

If the position of the black mark and the black mark sensor position do not align, 
rotate the Sensor Position Adjustment Dial to adjust the position (go to step 8).

The black mark sensor position is set, at the factory, to 58.5 mm from the right edge 
of the label liner.

Adjust the position of the arrow so it is in the center of the black mark of the media 
you are using.
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b. Check the gap sensor position

Align the paper, and check the actual position of the label and the gap sensor posi-
tion.

If the position of the label and the gap sensor position do not align, rotate the 
Sensor Position Adjustment Dial to adjust the position (go to step 8).

The gap sensor position is set, at the factory, to 65 mm from the right edge of the 
label liner.

Adjust the position of the arrow so it is in the center of the labels of the media you 
are using.

8. Rotate the Sensor Position Adjustment Dial to adjust the sensor position.

• If you rotate the Sensor Position Adjustment Dial in direction A, the sensor position 
moves in the direction C.

• If you rotate the Sensor Position Adjustment Dial in direction B, the sensor position 
moves in the direction D.
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9. Tilt the belt unit and align the arrow labels (red) on the belt unit and printer to position it, 
and then open the belt unit handles (blue) on the left and right.

Caution: Be careful to not pinch your hands or fingers between the handle and the 
machine while installing the belt unit.
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10. Turn the two belt unit locking keys clockwise to lock it.

11. Put the print cartridge set back into the printer.

Caution: There is a risk of pinching your fingers or hands when repositioning the print 
cartridge set. Hold the handle parts of the basket for this operation.

12. Close the top cover.

Caution: When closing the top cover, there is a risk of pinching your fingers or hands in 
the top cover or the top cover’s support. Press on the top of the top cover to close it.

Caution: There is a risk of pinching your fingers or hands if you hold the LED head while 
closing the top cover. Press on the top of the top cover to close it.

Sensor Calibration
1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.
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3. Right-click the QL-300 icon, and then select Printing preferences.

If you are using the Windows PCL printer driver, the following window will open.

If you are using the Window PS printer driver, the following window will open.

4. Input information about the paper you want to register. To adjust settings that are already 
registered, select the names of the paper from the list in Registered user-defined 
paper.
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5. Click Sensor Adjustment.

Sensor Adjustment appears if the following conditions are met.

• The Media Form is one of the following: Continuous Paper (Black Mark), Die-cut 
Label (Gap), Die-cut Label (Black Mark), Continuous Label (Black Mark)

• The Ports of the printer driver is USB or standard TCP/IP port

Before performing Sensor Adjustment, make sure that the printer is “online”.

6. Click Next.

• Before performing the next steps of this procedure, make sure that paper is loaded.

• If there are no paper size settings configured on the control panel, it may cause a 
paper size mismatch on the device. Pressing the OK button on the control panel 
overwrites the device paper size setting with the paper size setting in the printer 
driver.
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7. Select a registration location for the adjustment, and then enter a registration name.

You can enter up to eight alphanumeric English characters for the registration name.

8. Click Next. This starts the sensor adjustment and displays a wait message.
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9. When the completion screen appears, click Complete.

The results of adjusting the sensor are registered on the printer. In Sensor settings in 
User-defined paper in the printer driver, you can specify the number registered in the 
printer for the adjustment results and whether to apply it when printing. By standardizing 
the registration numbers of the sensor adjustment results, you can get the same print 
results by specifying the same number in Sensor settings in the printer driver for any 
printer. This is useful when printing on the same media on multiple printers.

10. To register new settings, click Add or click Overwrite to select paper that is already 
registered.

11. Click OK as many times as necessary to exit the “Printing preferences” screen.

12. Open the file to be printed.

13. Specify a registered paper size, and then print.

If You Cannot Set the Sensors from the Printer Driver
If you cannot set the sensors from the printer driver, then set them from the control panel.

Black mark sensor
1. Confirm the sensor position

2. Configure the sensor type

Media form = Continuous Paper (Black Mark), Die-cut Label (Black Mark), or Continuous 
Label (Black Mark)

3. Configure the paper size

Paper Size = Custom

X Dimension = Input the “label width”

For die-cut labels (black marks):

• Paper length = Input the “label length”

• Gap Length = Input the “gap length”

Otherwise:

• Black mark interval = Input the “length between black marks”
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4. Execute sensor calibration

Sensor calibration → Execute

Gap sensor
1. Confirm the sensor position

2. Configure the sensor type

Media form = Die-cut Label (Gap)

3. Configure the paper size

Paper Size = Custom

X Dimension = Input the “label width”

Y Dimension = Input the “label length”

Gap Length = Input the “gap length”

4. Execute sensor calibration

Sensor calibration → Execute

Calibrating the Black Mark Sensor
You can adjust the black marks on roll paper using the black mark sensor.

Here, we will show the method when Continuous Label (Black Mark) are used.

1. Press the Fn key.

The numerical values input screen will be displayed.

2. Press 8, 9, 1 (function numbers), and then press the OK button.
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3. Select 6. Continuous Label (Black Mark), and then press the OK button.

4. Press the ON LINE button to return to the standby screen.

5. Press the Fn key, and then press the following buttons: 9, 0, OK.

6. On the Paper Size menu, select Custom, press the OK button, and then press the ON 
LINE button. The display will return to the standby screen.

7. Press the Fn key, and then press the following buttons: 9, 1, OK.
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8. Use the numeric keypad to enter the label width, press the OK button, and then press the 
ON LINE button. The display will return to the standby screen.

9. Press the Fn key, and then press the following buttons: 8, 9, 0, OK.

10. Select Black Mark Interval from Unwinder Config, and then press the OK button.

11. Use the numeric keypad to enter the Black Mark Interval, press the OK button, and then 
press the ON LINE button.

The display will return to the standby screen.
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12. Press the Fn key, and then press the following buttons: 8, 9, 3, OK.

13. Select the setting number of the sensor to be configured, and then press the OK button.

14. Select Execute Calibration, and then press the OK button.

15. Enter the sensor calibration name, and then press the OK button.

You can leave the name blank, if you want.

16. If an execution confirmation screen appears, select Yes.
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17. This executes sensor calibration.

18. After sensor calibration is complete, press the OK button.

Calibrating the Gap Sensor
You can adjust the distance between die cut labels using the gap sensor.

1. Press the Fn key.

The numerical values input screen will be displayed.

2. Press 8, 9, 1 (function numbers), and then press the OK button.
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3. Select 3. Die-cut Label (Gap), and then press the OK button.

4. Press the ON LINE button to return to the standby screen.

5. Press the Fn key, and then press the following buttons: 9, 0, OK.

6. On the Paper Size menu, select Custom, press the OK button, and then press the ON 
LINE button. The display will return to the standby screen.

7. Press the Fn key, and then press the following buttons: 9, 1, OK.
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8. Use the numeric keypad to enter the label width, press the OK button, and then press the 
ON LINE button. The display will return to the standby screen.

9. Press the Fn key, and then press the following buttons: 9, 2, OK.

10. Use the numeric keypad to enter the label length, press the OK button, and then press 
the ON LINE button. The display will return to the standby screen.

11. Press 8, 9, 0 (function numbers), and then press the OK button.

12. Select Gap Length from Unwinder Config, and then press the OK button.
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13. Use the numeric keypad to enter the gap length, press the OK button, and then press the 
ON LINE button. The display will return to the standby screen.

14. Press the Fn key, and then press the following buttons: 8, 9, 3, OK.

15. Select the setting number of the sensor to be configured, and then press the OK button.

16. Select Execute Calibration, and then press the OK button.

17. Enter the sensor calibration name, and then press the OK button.

You can leave the name blank, if you want.
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18. If an execution confirmation screen appears, select Yes.

19. This executes sensor calibration.

20. After sensor calibration is complete, press the OK button.

Detecting the Interval between Pages

Detecting the Interval between Pages with the Printer Driver
You can use the following procedure, from the printer driver, to register the paper gap and black 
mark interval on the device. Registering these settings improves your printing results. However, 
it does waste approximately 10 sheets of paper.

1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.

3. Right-click the QL-300 icon, and then select Printing preferences.

4. On the Setup tab, click User-defined paper.
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5. After confirming that the paper name you entered in the “Paper Name” box is shown 
under Registered user-defined paper, click Close.

6. For Paper settings, select the paper settings you registered, and then click Paper 
interval detection.

Paper interval detection is displayed if the following conditions are met.

The Media Form is one of the following:

• Continuous Paper (Black Mark)

• Die-cut Label (Gap)

• Die-cut Label (Black Mark)

• Continuous Label (Black Mark)

If Paper interval detection does not appear, return to step 4 of this procedure.
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7. Confirm the displayed paper information, and then click Measure.

This starts checking the media pitch and closes the dialog box.

Note: If you change to another type of paper or restart the printer, you should configure 
this setting again.

8. Click OK as many times as necessary to exit the Printing preferences screen.

9. Open the file to be printed.

10. Specify a registered paper size, and then print.

Detecting the Interval between Pages with the Control Panel
Detect the paper gap and black mark interval from the control panel.

1. For black mark media, execute steps 1 to 11 in “Calibrating the Black Mark Sensor” on 
page 123.

For gap media, execute steps 1 to 13 in “Calibrating the Gap Sensor” on page 127.

2. Press the Fn key.

3. Press 8, 9, 4 (function numbers) and then press the OK button.
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4. Select Execute, and then press the OK button to start paper interval detection and close 
the dialog box.

Printing
After loading the paper, use the computer to open the file you want to print. Next, use the printer 
driver to select the Paper Size and Paper Weight, and then print.

Note: When printing on label paper for the first time, execute Sensor Adjustment before 
printing.

Printing from the Windows Printer Driver
Here, we will show how to print an open WordPad file as an example.

1. Select Page Setup in the File menu.

2. Select the paper size and print orientation, and then click OK.

3. On the File menu, click Print > Print.
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4. Click Preferences.

If you are using the Windows PCL printer driver, the following window will open.

If you are using the Window PS printer driver, the following window will open.

5. On the Setup tab, configure Paper settings.

Configure the Cut Mode setting on the Setup tab as required.

6. When the settings are complete, click OK in the “Setup” screen.

7. Click Print in the “Print” screen to print.
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Canceling a Print Job
Use the procedure below to cancel a print job from the printer’s control panel.

1. On the control panel, press the CANCEL button.

2. If a verification message appears, select Yes, and then press the OK button.
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Print Function Settings

Printer Driver Functions Table
This section explains the convenient functions when printing from a PC.

Explanation of Functions

Windows PCL Printer Driver Functions
Setup Tab

Item Description

Example Shows what printing results will be based on 
current settings. This example is just an 
approximation and does not indicate the 
exact actual number of print pages and cut 
positions.

Paper settings Specifies, from among registered paper 
settings, which one should be applied for 
printing.

Orientation Specifies the print orientation.

Copies Specifies the quantity to be printed.

Cut Mode Specifies the timing to cut roll paper when 
cutting and printing on it.
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User-defined paper

Quality Specifies the resolution during printing.

Screen Specifies the halftoning available with the 
device.

User-defined paper Click when using the driver to register paper 
settings to be used for printing.

Paper interval detection Before printing to black mark or die-cut 
labels, click to execute learning on the 
device to improve the print position before 
starting.
Note that executing this function will cause 
some paper to be used.

About Displays the printer driver version 
information.

Default Restores default settings.

Item Description

Paper Name Enter the name of the paper settings you 
want to register.

Registered user-defined paper Shows a list of paper settings that have 
been registered

Item Description
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Size Specifies either millimeters or inches as the 
unit for input values.

Print position correction Adjusts the print start position on the paper 
edge.

Cut position correction Adjusts the cut position when cutting and 
printing roll paper

Media Form Specifies the paper setting type to be 
registered.
Size input items change in accordance with 
this setting.

Media Type Specifies the paper type.

Media Weight Specifies the paper thickness.

Sensor settings Specifies the settings, from among those 
registered on the device, to be used for 
printing.

Sensor Adjustment Click to calibrate the gap of black mark or 
die-cut labels, and register the results as 
device sensor settings.
This button is not displayed for media forms 
that do not require calibration.

Printer information acquisition Obtains, from devices, the names of 
settings registered as sensor settings and 
the names of user types registered as paper 
types, and reflects them in the sensor 
settings and paper type list on the printer 
driver.

Item Description
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Color Tab

Item Description

Color Mode Selects either color printing or monochrome 
printing.When color is selected, clicking 
Detail displays the “Detail” dialog box, 
which can be used to configure detailed 
color printing settings.

Spot Color Specifies how white toner should be used 
for printing.
This item available only on the QL-300s.

Toner Saving Specifies the print density when 
economizing on toner.
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Overlays Tab

Extend Tab

Item Description

Overlays Specifies whether or not a form should be 
overlaid on the document to be printed, or 
whether the document should be registered 
as a new form in the device.

Item Description

Watermarks Sets when implementing stamp printing.
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Windows PS Printer Driver Functions
Advanced Tab

Fonts Configures TrueType and printer font 
settings.

Item Description

ICM Method Specifies the ICM process.

ICM Intent Specifies the intent of the ICM. Converts 
printer colors to be appropriate for the 
specified intent.

TrueType Font Specifies whether to use the device fonts, if 
available, or to download fonts included in 
the print data as software fonts.

PostScript Options Specifies the various settings for creating 
PostScript data.

Item Description
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Setup Tab

Item Description

Example Shows what printing results will be based on 
current settings. This example is just an 
approximation and does not indicate the 
exact actual number of print pages and cut 
positions.

Paper settings Specifies, from among registered paper 
settings, which one should be applied for 
printing.

Orientation Specifies the print orientation.

Copies Specifies the quantity to be printed.

Cut Mode Specifies the timing to cut roll paper when 
cutting and printing on it.

Quality Specifies the resolution during printing.

Screen Specifies the halftoning available with the 
device.

User-defined paper Click when using the driver to register paper 
settings to be used for printing.
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User-defined paper

Paper interval detection Before printing to black mark or die-cut 
labels, click to execute learning on the 
device to improve the print position before 
starting.
Note that executing this function will cause 
some paper to be used.

About Displays the printer driver version 
information.

Default Restores default settings.

Item Description

Paper Name Enter the name of the paper settings you 
want to register.

Registered user-defined paper Shows a list of paper settings that have 
been registered

Size Specifies either millimeters or inches as the 
unit for input values.

Print position correction Adjusts the print start position on the paper 
edge.

Cut position correction Adjusts the cut position when cutting and 
printing roll paper

Item Description
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Media Form Specifies the paper setting type to be 
registered.
Size input items change in accordance with 
this setting.

Media Type Specifies the paper type.

Media Weight Specifies the paper thickness.

Sensor settings Specifies the settings, from among those 
registered on the device, to be used for 
printing.

Sensor Adjustment Click to calibrate the gap of black mark or 
die-cut labels, and register the results as 
device sensor settings.
This button is not displayed for media forms 
that do not require calibration.

Printer information acquisition Obtains, from devices, the names of 
settings registered as sensor settings and 
the names of user types registered as paper 
types, and reflects them in the sensor 
settings and paper type list on the printer 
driver.

Item Description
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Color Tab

Item Description

Color Mode Selects either color printing or monochrome 
printing.
When you select Color, and then select 
Simple Adjustment or Graphic Pro, 
clicking Detail displays the Simple 
Adjustment Details dialog box, which can 
be used to configure detailed color printing 
settings.

Spot Color Specifies how white toner should be used 
for printing.
This item available only on the QL-300s.

Toner Saving Specifies the print density when 
economizing on toner.
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Overlays Tab

Extend Tab

Item Description

Overlays Specifies whether or not a form should be 
overlaid on the document to be printed, or 
whether the document should be registered 
as a new form in the device.

Item Description

Watermarks Sets when implementing stamp printing.
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Control Panel Menu Functions Table

Device Setup Screen

Configuration

Drawing position adjustment Specify if you want to adjust the position of 
image data before printing.

Item Description

Item Description

Configuration View device information (total number of sheets, remaining wear item 
quantity, system information, etc.)

Print Information Print the settings, usage report, error log, color profile list, and user 
media lists for this machine.

Menus Used to configure system settings, print position adjustment, color, and 
other settings.

Admin Setup Administrator sets the network settings, changes passwords, etc.

Print Statistics Check the print use status of the user.

Calibration Used to adjust the color densities and shades, color misalignment, etc.

Boot Menu Set whether or not to restart the printer when a malfunction occurs in 
the HDD or file system, etc.

Item Description

Feeder Count Unwinder nnnnnn Displays the total print quantity for the 
unwinder. (This is the number of 
sheets converted into the A6 size 
paper from the length of paper fed 
from the unwinder.)
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Supplies Life Cyan Print Cartridge Remaining nnn% Shows the remaining service life (%) 
of each color's print cartridge.
White is displayed with QL-300s only.Magenta Print 

Cartridge
Remaining nnn%

Yellow Print 
Cartridge

Remaining nnn%

Black Print Cartridge Remaining nnn%

White Print Cartridge Remaining nnn%

Waste Toner Box Remaining nnn% Shows the remaining service life (%) 
of the waste toner box.

Belt Remaining nnn% Shows the remaining service life (%) 
of the belt unit.

Fuser Remaining nnn% Shows the remaining service life (%) 
of the fuser unit.

Item Description
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Network Printer Name **********
**********
***********

Shows the printer name used by the 
DNS and Network PnP.

Short Printer Name *******
********

Displays the short printer name.

IPv4 Address xxx.xxx.xxx.xxx Shows the IP address. When TCP/IP 
is enabled, shows the setup of the 
following control panel setting Admin 
Setup > Network Setup > IPv4 
Address.

Subnet Mask xxx.xxx.xxx.xxx Displays the subnet mask. When 
TCP/IP is enabled, shows the setup of 
the following control panel setting 
Admin Setup > Network Setup > 
Subnet Mask.

Gateway Address xxx.xxx.xxx.xxx Displays the gateway address. When 
TCP/IP is enabled, shows the setup of 
the following control panel setting 
Admin Setup > Network Setup > 
Gateway Address.

MAC Address xx:xx:xx:
xx:xx:xx

Shows the MAC address.

Network FW Version xx.xx Shows the network firmware version.

Web Remote Version xx.xx Shows the web page version.

IPv6 Address (Local) xxxx:xxxx:xxxx:xxxx:
xxxx:xxxx:xxxx:xxxx

Shows the (local) IPv6 address. This 
menu is not displayed when TCP/IP is 
disabled or when the IP version is 
IPv4.

IPv6 Address 
(Global)

xxxx:xxxx:xxxx:xxxx:
xxxx:xxxx:xxxx:xxxx

Shows the (global) IPv6 address. This 
menu is not displayed when TCP/IP is 
disabled or when the IP version is 
IPv4.

Item Description
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Print Information

System Serial Number xxxxxxxxxx
xxxxxxxxxx
xxxxxx

Displays the serial number.

Asset Number xxxxxxxxxx
xxxxxxxxxx
xxxxxxxxxxxx

Displays the asset number of the 
printer manager.

Lot Number xxxxxxxxxxxx
xxxxxxxxxxxx
xx

Displays the lot number.

Firmware Version xxx.xx_x_x Shows the version number of 
FirmSuite.

CU Version xx.xx Displays the control unit firmware 
version.

PU Version xx.xx.xx Displays the printer unit firmware 
version.

RAM xxMB Shows the total availability of all 
mounted RAM.

Flash Memory xxMB[Fxx] Displays the total availability of all 
flash memory and flash system 
versions installed.

HDD xx.xxGB [Fxx] Displays the HDD size and file system 
version installed.

Date and Time mm/dd/yyyy
or
dd/mm/yyyy

Displays the current date and time.

Item Description

Item Description

Configuration Execute Prints the device setup details.

Demo Page DEMO1 Execute Prints the demo pages.

File List Execute Prints the file list.

Usage Report Execute Prints the total print results.
Not displayed if Disable is set for the 
control panel Print Statistics > Usage 
Report item.



Print Function Settings

QL-300 User Guide 152
 

Menus

Unwinder Config

Error Log Execute Prints the error log.

Color Profile List Execute Prints the color profile list.

User Media List Execute Prints the user media list.
Displayed when the user media is 
registered.

Test Print-1 Execute Prints the patterns for analyzing the 
print quality.

Test Print-2 Execute Prints the patterns for analyzing the 
CMYK print quality.

Test Print-3 Execute Prints the patterns for analyzing the 
status of the print cartridges.

Test Print-4 Execute Prints the patterns for analyzing print 
quality of the spot colors.
Displayed with QL-300s only.

Cleaning Page Execute Prints the toner-free white sheet to 
remove dirt from the surface of the 
fuser belt in the fuser unit.

Item Description

Item Value Description

Media Form Continuous Paper
Continuous Paper (Black 
Mark)
Die-cut Label (Gap)
Die-cut Label (Black Mark)
Continuous Label
Continuous Label (Black 
Mark)

Specifies the shape of the 
roll paper.
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Liner Width Config Liner 
Width 
Mode

Auto
Custom

Specifies the mode for 
setting the width of the 
label’s liner.
Auto: The width of the liner 
is set given that the label is 
in the center of the liner.
Custom: The width of the 
liner is input and the left 
gap is calculated given that 
the left and right gaps are 
different.

Liner 
Width

29.4 millimeter
(1.16 inch)
|
105.6 millimeter
(4.16 inch)
109.0 millimeter
(4.29 inch)
|
130.0 millimeter
(5.12 inch)

Inputs the width of the liner.
Appears when the Liner 
Width Mode is “Custom”.
The initial values vary 
depending on your 
operating environment.

Right Gap 2.0 millimeter
(0.08 inch)
|
25.4 millimeter
(1.00 inch)

Specifies the distance from 
the right edge of the label to 
the right edge of the liner.

Paper Size A6
4x6 inch
Custom

Sets the size of the paper 
for the unwinder.
The initial values vary 
depending on your 
operating environment.

X Dimension 25.4 millimeter
(1.00 inch)
|
101.6 millimeter
(4.00 inch)
105.0 millimeter
(4.13 inch)
|
126.0 millimeter
(4.96 inch)*

Sets the width of the 
custom paper sizes for the 
unwinder.
Sets the dimension 
perpendicular to the paper 
feed direction.
* 130.0 mm (5.12 inch) if 
the Media Form is 
Continuous Paper or 
Continuous Paper (Black 
Mark)
The initial values vary 
depending on your 
operating environment.

Item Value Description
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Y Dimension 12.7 millimeter
(0.50 inch)
|
101.6 millimeter
(4.00 inch)
|
148.0 millimeter
(5.83 inch)
152.4 millimeter
(6.00 inch)
|
1320.8 millimeter
(52.00 inch)

Sets the length of the 
custom paper sizes for the 
unwinder.
Sets the same direction as 
for the dimension in the 
paper feed direction.
If the setting is 101.6 mm 
(4.00 inch) or lower, then 
the set page length is 
handled as a 
whole-number multiple of 
the actual length of the 
page such that it exceeds 
101.6 mm (4.00 inch).
The initial values vary 
depending on your 
operating environment.

Black Mark Interval 15.9 millimeter
(0.63 inch)
|
101.6 millimeter (4.00 inch)
|
151.2 millimeter
(5.95 inch)
155.6 millimeter
(6.13 inch)
|
1324.0 millimeter
(52.13 inch)

Sets the interval of the 
marks on custom paper for 
the unwinder.
Sets the same direction as 
for the dimension in the 
paper feed direction.
If the setting is 104.8 mm 
(4.13 inch) or lower, then 
the set page length is 
handled as a 
whole-number multiple of 
the actual length of the 
page such that it exceeds 
101.6 mm (4.00 inch).
The initial values vary 
depending on your 
operating environment.

Gap Length 3.0 millimeter
(0.12 inch)
|
10.0 millimeter
(0.39 inch)

Sets the interval for labels.
Sets the same direction as 
for the dimension in the 
paper feed direction.

Item Value Description
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Adjust Cut Position -0.5 millimeter
(-0.02 inch)

0.0 millimeter
(0.00 inch)

+0.5 millimeter
(+0.02 inch)

Specifies the compensation 
value for the distance from 
the print completion 
position to the cut position 
(beginning of next label). 
(Specifies margin on 
following edge).
If you specify a negative 
value, cutting is done at a 
short position.

Media Type Plain
Plain Labels
Glossy Labels
Film Labels1
Film Labels2
Film1
Film2
USERTYPE1
USERTYPE2
USERTYPE3
USERTYPE4
USERTYPE5
USERTYPE6
USERTYPE7
USERTYPE8
USERTYPE9
USERTYPE10
USERTYPE11
USERTYPE12
USERTYPE13
USERTYPE14
USERTYPE15
USERTYPE16
USERTYPE17
USERTYPE18
USERTYPE19
USERTYPE20

Sets the type of the paper 
for the unwinder.
USERTYPE 1 to 20 are 
displayed when they are 
registered.

Media Weight Light
Medium Light
Medium
Medium Heavy
Heavy
Ultra Heavy1
Ultra Heavy2
Ultra Heavy3

Sets the thickness of the 
paper for the unwinder.

Item Value Description
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Sensor Setting Set1 :
Set2 :
Set3 :
Set4 :
Set5 :
Set6 :
Set7 :
Set8 :
Set9 :
Set10 :

Sets the sensitivity of the 
gap sensor or black mark 
sensor.
Only the adjusted sensor 
setting is displayed.
Appears when the Media 
Form is something other 
than Continuous Paper or 
Continuous Label.

Sensor 
Calibratio
n

Set1 :
Set2 :
Set3 :
Set4 :
Set5 :
Set6 :
Set7 :
Set8 :
Set9 :
Set10 :

Execute Calibration Execute Executes calibration of the 
gap sensor or black mark 
sensor.

Sensor 
Calibratio
n

Set1 :
Set2 :
Set3 :
Set4 :
Set5 :
Set6 :
Set7 :
Set8 :
Set9 :
Set10 :

Adjust 
Slice 
Level

Reflective 
Sensor in 
Unwinder

0 - 1023 Fine tunes the sensitivity of 
the reflective sensor in the 
unwinder that was 
measured during Sensor 
Calibration.
The default value fluctuates 
according to the results of 
the calibration.
Appears when the black 
mark sensor is used.

Sensor 
Calibratio
n

Set1 :
Set2 :
Set3 :
Set4 :
Set5 :
Set6 :
Set7 :
Set8 :
Set9 :
Set10 :

Adjust 
Slice 
Level

Reflective 
Sensor in 
Printer

0 - 1023 Fine tunes the sensitivity of 
the reflective sensor in the 
device that was measured 
during Sensor Calibration.
The default value fluctuates 
according to the results of 
the calibration.
Appears when the black 
mark sensor is used.

Item Value Description
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Sensor 
Calibratio
n

Set1 :
Set2 :
Set3 :
Set4 :
Set5 :
Set6 :
Set7 :
Set8 :
Set9 :
Set10 :

Adjust 
Slice 
Level

Transmiss
ion 
Sensor in 
Unwinder

0 - 1023 Fine tunes the sensitivity of 
the transmission sensor in 
the unwinder that was 
measured during Sensor 
Calibration.
The default value fluctuates 
according to the results of 
the calibration.
Appears when the gap 
sensor is used.

Sensor 
Calibratio
n

Set1 :
Set2 :
Set3 :
Set4 :
Set5 :
Set6 :
Set7 :
Set8 :
Set9 :
Set10 :

Adjust 
Slice 
Level

Transmiss
ion 
Sensor in 
Printer

0 - 1023 Fine tunes the sensitivity of 
the transmission sensor in 
the device that was 
measured during Sensor 
Calibration.
The default value fluctuates 
according to the results of 
the calibration.
Appears when the gap 
sensor is used.

Sensor 
Calibratio
n

Set1 :
Set2 :
Set3 :
Set4 :
Set5 :
Set6 :
Set7 :
Set8 :
Set9 :
Set10 :

Change Name Execute You can change the name 
of the specified setting 
numbers.
You can use up to eight 
characters of single-byte 
upper case English and 
numbers.

Sensor 
Calibratio
n

Set1 :
Set2 :
Set3 :
Set4 :
Set5 :
Set6 :
Set7 :
Set8 :
Set9 :
Set10 :

Reset Setting Execute Initializes the content of the 
specified setting numbers.

Check Media Pitch Execute Measures the intervals on 
the paper.
Appears when the Media 
Form is something other 
than Continuous Paper or 
Continuous Label.

Item Value Description
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Bold indicates factory-set values.

Cutter Setup

Bold indicates factory-set values.

System Adjust

Item Value Description

Cut Mode Job
Collation
Specified Interval

Specifies the cutting 
operation.
Job: Cuts at the end of a 
job.
Collation: Cuts at the end of 
the job and at the end of 
the job collation.
Specified Interval: Cuts in 
units of the specified 
number of pages. Cuts at 
the end of the collation/job.

Cut Interval 1
|
9999

Sets how many pages are 
cut each time.
Appears when the Cut 
Mode is “Specified 
Interval”.

Item Value Description

Power Save Time 1 minute
2 minutes
3 minutes
4 minutes
5 minutes
10 minutes
15 minutes
30 minutes
60 minutes

Sets the time until the 
printer enters power save 
mode.

Auto Power Off Time 1 hour
2 hours
3 hours
4 hours
8 hours
12 hours
18 hours
24 hours

Sets the time until the 
printer enters OFF mode 
from stand-by status.

Clearable Warning ONLINE
Job

Sets the timing until 
clearable warning display 
turns OFF.
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Bold indicates factory-set values.

Timeout InJob Off
5 seconds
10 seconds
20 seconds
30 seconds
40 seconds
50 seconds
60 seconds
90 seconds
120 seconds
150 seconds
180 seconds
210 seconds
240 seconds
270 seconds
300 seconds

Sets the time from loss of 
the receipt of data until 
force-printing.
With PS, the job is 
canceled without printing.

Timeout Local 0 seconds
5 seconds
|
90 seconds
|
290 seconds
295 seconds
300 seconds

Sets the time for each port 
to be kept opened after 
printing. (Excludes 
network)

Timeout Network 0 seconds
5 seconds
|
90 seconds
|
290 seconds
295 seconds
300 seconds

Sets the time for the 
network port to be kept 
opened after printing.

Error Report On
Off

Specifies whether to print 
error reports when an 
internal PCL or PS error 
occurs.

Hex Dump Execute Prints received data in 
hexadecimal dump.
Turn off the power to stop 
printing the hex dump.

Item Value Description
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Print Adjust

Item Value Description

Print Position Adjust X Adjust 0.00 millimeters
+0.1 millimeters
|
+2.00 millimeters
-2.00 millimeters
|
-0.1 millimeters

Adjusts the overall image 
print position 
perpendicularly 
(horizontally) in the 
direction of paper feed (0.1 
mm intervals).

Y Adjust 0.00 millimeters
+0.1 millimeters
|
+2.00 millimeters
-2.00 millimeters
|
-0.1 millimeters

Adjusts the overall image 
print position in the 
direction of paper feed 
(vertically) (0.1 mm 
intervals).

Paper Edge Detect Mode Mode1
Mode2
Off

Set the action of the 
controls for the leading 
edge of the media to avoid 
image skew and detection 
position skew of the leading 
edge of labels.
Mode1: For long leading 
edges, this setting 
automatically cuts/outputs 
and then starts printing. For 
short leading edges, 
printing just starts. 
(Applicable for the 
gap/black mark setting)
Mode2: For short or long 
leading edges, this setting 
automatically cuts/outputs 
and then starts printing for 
both situations. (Applicable 
for the gap/black mark 
setting if the leading edge 
is long. If the leading edge 
is short, then only the gap 
setting is applicable.)
Off: With this mode, the 
user straightens the leading 
edge so paper is not 
wasted. (Applicable for the 
gap/black mark setting)
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Roll Paper End Detect Mode Auto
Stop
Forced Cut

Sets the control for ejecting 
the trailing edge of the 
paper to auto, stop feeding, 
or forced cut.
Auto: With this mode, the 
trailing edge is processed 
appropriately according to 
the media.
Stop: With this mode, feed 
is forced to stop when the 
trailing edge of the paper is 
detected, regardless of the 
length or type of media.
Forced Cut: With this 
mode, the system is forced 
to cut and eject the paper 
when the trailing edge of 
the paper is detected, 
regardless of the length or 
type of media.

Media Transfer Setting Black 0
+1
+2
+3
-3
-2
-1

Performs fine adjustment if 
black is faded or tiny white 
spots appear when printing 
with the black (K) print 
cartridge only (when 
printing with the YMCW 
print cartridges are raised).
Lower the setting value if 
there are only fewer white 
spots, or raise the setting 
value if the high-density 
portion is thinner.

Media Transfer Setting Color 0
+1
+2
+3
-3
-2
-1

Performs fine adjustment if 
colors are faded or tiny 
white spots appear when 
printing with two or more 
print cartridges or just the 
white (W) print cartridge.
Lower the setting value if 
there are only fewer white 
spots, or raise the setting 
value if the high-density 
portion is thinner.

Item Value Description
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SMR Setting Cyan 0
|
+3
-6
|
-1

Compensates for uneven 
print density due to 
temperature and humidity, 
and printing quantity, using 
indicated color. Raise the 
setting value if it is blurred. 
Lower the setting value if 
the density darkens 
partially.
• Continued use with the 

setting value raised has 
a risk of printing stains.

• Continued use with the 
setting value lowered 
has a risk of blurring.

White is displayed with 
QL-300s only.

Magenta

Yellow

Black

White

BG Setting Cyan 0
+1
+2
+3
-3
-2
-1

Compensates for print 
results variation due to 
differences in the 
temperature and humidity, 
using indicated color. 
Lower the setting value if 
the underlay is dark.
• Continued use with the 

setting value lowered 
has a risk of printing 
stains.

White is displayed with 
QL-300s only.

Magenta

Yellow

Black

White

Drum Cleaning On
Off

Sets whether to implement 
drum cleaning before 
printing. The image quality 
may be improved.

Transfer Roller Cleaning Execute Implements cleaning of the 
2nd transfer roller unit.

Transfer Setting Cyan Transfer Setting 0
+1
+2
+3
-3
-2
-1

Lower the setting value if 
lateral-stripe white dots and 
dark streaks appear for 
cyan, green and blue toner.
Raise the setting value if 
the high-density portion of 
cyan, green and blue is 
thinner.

Item Value Description
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Bold indicates factory-set values.

Transfer Setting Magenta Transfer 
Setting

0
+1
+2
+3
-3
-2
-1

Lower the setting value if 
lateral-stripe white dots and 
dark streaks appear for 
magenta and/or red toner.
Raise the setting value if 
the high-density portion of 
magenta and/or red is 
thinner.

Transfer Setting Yellow Transfer Setting 0
+1
+2
+3
-3
-2
-1

Lower the setting value if 
lateral-stripe white dots and 
dark streaks appear for 
yellow toner.
Raise the setting value if 
the high-density portion of 
yellow is thinner.

Transfer Setting Black Transfer Setting 0
+1
+2
+3
-3
-2
-1

Lower the setting value if 
lateral-stripe white dots and 
dark streaks appear for 
black toner.
Raise the setting value if 
the high-density portion of 
black is thinner.

Transfer Setting White Transfer Setting 0
+1
+2
+3
-3
-2
-1

Lower the setting value if 
lateral-stripe white dots and 
dark streaks appear for 
white toner.
Raise the setting value if 
the high-density portion of 
white is thinner.
White is displayed with 
QL-300s only.

DV Roller Cleaning 1 On
Off

Adjust the toner disposal 
threshold.
On: Image quality priority
Off: Toner life priority

DV Roller Cleaning 2 Mode 1
Mode 2
Off

May be effective against 
lateral striping caused by 
variations in ambient 
temperature and/or 
humidity. Try mode 2 if 
desired results are not 
produced by mode 1.

Item Value Description
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Admin Setup
To enter this menu, it is necessary to enter the password. The factory default setting of the 
administrator password is 999999.

Network Setup

Item Value Description

TCP/IP Enable
Disable

Enables/disables TCP/IP 
protocols.

NetBIOS over TCP Enable
Disable

Enables/disables NetBIOS 
over TCP/IP.
Appears when Enable is 
set on the control panel for 
TCP/IP.

IP Address Set Auto
Manual

Specifies whether to 
request the IP address from 
the DHCP server.
Appears when Enable is 
set on the control panel for 
TCP/IP.

IPv4 Address xxx.xxx.xxx.xxx Sets the IP address.
Appears when Enable is 
set on the control panel for 
TCP/IP.
Appears when Manual is 
set on the control panel for 
IP Address Set.

Subnet Mask xxx.xxx.xxx.xxx Sets the subnet mask.
Appears when Enable is 
set on the control panel for 
TCP/IP.
Appears when Manual is 
set on the control panel for 
IP Address Set.

Gateway Address xxx.xxx.xxx.xxx Sets the gateway address.
Appears when Enable is 
set on the control panel for 
TCP/IP.
Appears when Manual is 
set on the control panel for 
IP Address Set.
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Web Enable
Disable

Enables/disables access 
using web browsers.
Appears when Enable is 
set on the control panel for 
TCP/IP.

Telnet Enable
Disable

Enables/disables access 
using Telnet.
Appears when Enable is 
set on the control panel for 
TCP/IP.

FTP Enable
Disable

Enables/disables access 
using FTP.
Appears when Enable is 
set on the control panel for 
TCP/IP.

IPSec Enable
Disable

Enables/disables access 
using IPsec.
Appears when Enable is 
set on the control panel for 
TCP/IP.

SNMP Enable
Disable

Enables/disables access 
using SNMP.
Appears when Enable is 
set on the control panel for 
TCP/IP.

Network Scale Normal
Small

Normal: Printer operates 
effectively even if 
connected to a hub with 
spanning tree functions. 
However, printer startup 
time becomes longer when 
two or three computers are 
connected to a small-scale 
LAN.
Small: Covers small scale 
LANs with 2 or 3 PCs to 
large scale LANs are 
covered, but if connected to 
a hub with spanning tree 
functions, operations may 
not be effective.

Gigabit Network Enable
Disable

Sets whether to support a 
Gigabit network.

Item Value Description
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Bold indicates factory-set values.

USB Setup

Bold indicates factory-set values.

Print Setup

Hub Link Setting Auto Negotiate
100Base-TX Full
100Base-TX Half
10Base-T Full
10Base-T Half

Sets the connection mode 
to the hub.

Network Factory Defaults Execute Restores the settings, such 
as network, mail server, 
LDAP server, and secure 
protocol server, etc., to their 
default values.

Item Value Description

Item Value Description

USB Enable
Disable

Enables/disables access 
using a USB interface.

Speed 480Mbps
12Mbps

Sets the maximum baud 
rate using a USB interface.

Soft Reset Enable
Disable

Enables/disables the 
software reset command.

Serial Number Enable
Disable

Enables/disables the USB 
serial number.
The USB serial number is 
used to identify USB 
devices connected to a PC.

Offline Receive Enable
Disable

Sets whether to receive 
data even if offline or a 
recoverable error occurs.

Item Value Description

Personality Auto
PCL
PostScript

Select the print language. 
Print language switching is 
automatic when set to Auto.
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Copies 1
|
9999

Sets the copy quantity.
This setting is ignored in 
case of local print.
This setting is disabled 
unless the Job Copy 
setting is 1.

Job Copy 1
|
999

Sets the print quantity.
This setting is ignored in 
case of local print.
The settings in the printer 
driver always overwrite 
these settings.
* This setting is enabled 
only if Collate is checked 
and 1 is specified as the 
number of copies in the 
PCL printer driver.

Edge to Edge On
Off

Sets the print margin.

Resolution 600dpi
1200dpi

Sets the resolution.

Toner Save Toner Save Level Off
Low
Middle
High

Set the toner save quantity.
Specifies Off when toner 
save mode is disabled.

Color All
Except 100%
Black

All: All colors, including 
100% black, comprise all 
the target colors for toner 
saving.
Except 100% Black: All 
colors, excluding 100% 
black, comprise all the 
target colors for toner 
saving.

Item Value Description
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Bold indicates factory-set values.

PS Setup

Bold indicates factory-set values.

Check Unnecessary Print Cartridge On
Off

Set whether to generate an 
error or continue printing 
when a print cartridge is 
detected to be down even 
though it is not being used 
as a specified color for the 
print data.
On: An error is displayed 
and the print job is 
cancelled, to give priority to 
the service life of the print 
cartridge.
Off: A warning screen is 
displayed, but printing 
continues because priority 
is given to productivity.

Default Orientation Portrait
Landscape

Sets the print orientation.

Trapping Off
Narrow
Narrow / Choke White
Wide
Wide / Choke White
Choke White

Sets trapping.
Narrow/Choke White, 
Wide/Choke White, and 
Choke White are displayed 
for the QL-300s only.

Item Value Description

Item Value Description

Network Protocol ASCII
RAW

Specifies the PS 
communication protocol 
mode for data from the 
network.

USB Protocol ASCII
RAW

Specifies the PS 
communication protocol 
mode for data from USB.
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PCL Setup

Item Value Description

Font Source Resident
Resident2
Downloaded

Sets the location of the 
fonts to be used.

Font Number I0
C1
S1

Sets the numbers of the 
fonts to be used.

Font Pitch 0.44 CPI
|
10.00 CPI
|
99.99 CPI

Sets the font width.
Increases and reduces in 
0.01 CPI units.
Displayed when the font 
selected using Font 
Number is an outline font 
with fixed spacing.

Font Height 4.00 points
|
12.00 points
|
999.75 points

Sets the font height.
Increases and reduces in 
0.25 point units.
Displayed when the font 
selected using Font 
Number is an outline font 
with variable spacing.

Symbol Set PC-8
PC-8 Dan/Nor
PC-8 Grk
PC-8 TK
PC-775
|
PC Ext D/N
PC Ext US
PC Set1
PC Set2 D/N
PC Set2 US

Select the symbol set.

CR Function CR
CR+LF

Specifies the operation 
when a CR code is 
received.

LF Function LF
LF+CR

Specifies the operation 
when an LF code is 
received.

Print Margin Normal
1/5 inch
1/6 inch
1/8 inch
1/12.5 inch

Sets the area of the paper 
where printing is not 
possible.
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Bold indicates factory-set values.

Color Setup

Bold indicates factory-set values.

Panel Setup

True Black On
Off

Specifies whether to use 
mixed CMYK or black toner 
only for printing black of 
image data.

Pen Width Adjust On
Off

Compensates so that thin 
lines are visible.

Item Value Description

Item Value Description

Ink Simulation Off
SWOP
ISO Coated
Japan

Sets the ink simulation. 
This setting is enabled only 
for PS language jobs.

UCR Low
Normal
High

You can select the black 
plate (black) amount during 
color printing.
Setting more black plate 
economizes on the toner of 
the other three colors.

CMY 100% Density Enable
Disable

Enables/disables 100% 
output for CMY 100% 
shade values.

CMYK Conversion On
Off

You can select the method 
of total toner quantity 
control for CMYK data. 
Select Off to disable GCR 
(Gray Component 
Replacement). 
Furthermore, this menu 
setting is disabled if using 
the ink simulation function.

Item Value Description

Idle Display Supplies Life
Unwinder Config

Sets the information 
displayed in the standby 
screen.
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Bold indicates factory-set values.

Time Setup

Panel Brightness During Operation 5
|
31

Adjusts the brightness 
(backlight luminosity) of the 
control panel LCD.
The set brightness is 
applied during control panel 
operations.

Panel Brightness While Power Save 0
|
1
|
31

Adjusts the brightness 
(backlight luminosity) of the 
control panel LCD.
The set brightness is 
applied after the panel 
backlight timer time has 
elapsed from the last 
operation.

Panel Backlight Timer 10
|
30
|
300

Adjusts the time (in 
seconds) from the last 
operation until Panel 
Brightness While Power 
Save is applied.

Item Value Description

Item Value Description

Date Format yyyy/mm/dd
mm/dd/yyyy
dd/mm/yyyy

Sets the date display mode.
The initial values vary 
depending on your 
operating environment.

Time Zone -12:00
|
+0:00
|
+13:00

Sets the time difference 
from GMT in 15-minute 
units. If the time zone 
setting is changed, the time 
differences before and after 
the change are reflected in 
the current time.

Daylight Saving On
Off

Sets whether to display 
daylight saving time.
On: Sets the current time 1 
hour forward.
Off: Sets the current time 1 
hour back.
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Bold indicates factory-set values.

Power Setup

Bold indicates factory-set values.

Others Setup

Time Setting 2000/01/01 00 :00
|
2091/12/31 23 :59

Sets the time.

Item Value Description

Item Value Description

Power Save Enable
Disable

Enables/disables power 
save mode.

Auto Power Off Enable
Auto Config
Disable

Sets auto power off mode.

Item Value Description

RAM Setup Receive Buffer Size Auto
0.5 MB
1 MB
2 MB
4 MB
8 MB
16 MB
32 MB

Sets the incoming buffer 
size that is assured by the 
local interface.

Resource Save Auto
Off
0.5 MB
1 MB
2 MB
4 MB
8 MB
16 MB
32 MB

Sets the resource saving 
area size.
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Storage Common 
Setup

Check File System Execute Implements management 
data (FAT information) 
recovery, and resolves 
mismatches between the 
actual (free) space in the 
file system and the free 
space displayed.

Check All Sectors Execute Recovers defective sector 
information on the HDD 
and file system 
non-conformances.

Enable Initialization No
Yes

Specifies whether or not to 
authorize setup changes 
associated with HDD and 
flash memory initialization.

Language Setup Select Language Chinese
English
French
German
Italian
Japanese
Russian
Spanish

Specifies the control panel 
display language.

Language Initialize Execute Deletes the message files 
that have been 
downloaded.
Also, the Select Language 
setting returns to the 
factory default setting.

Item Value Description
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Job Cancel Setup Cancel Key Behavior Short
Long
Off

Sets the operations when 
the device CANCEL button 
is pressed.
Short: Hold down no longer 
than two seconds to cancel 
the print job.
Long: Hold down for 2 to 5 
seconds to cancel a print 
job.
Off: Disables the CANCEL 
button.

Inquiry Display On
Off

Sets whether to display the 
inquiry screen when a job is 
canceled.

Focus Position Yes
No

Sets whether to apply Yes 
or No focus for selection in 
the job cancellation inquiry 
screen.

Display Timeout 60
|
180
|
300

Sets the display timeout 
value for the inquiry screen 
when a job is canceled.

Item Value Description
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Bold indicates factory-set values.

Settings

Media Operation Setup Inquiry Display On
Off

Specifies the operation 
when the FEED button or 
the UNLOAD button is 
pressed.
On: In the cases below, a 
confirmation screen is 
displayed before the 
operation is executed.
• FEED: When the paper 

changes from a stand-by 
state to a through paper 
state

• UNLOAD/CUT: When 
cut is executed

Off: Operation is performed 
without displaying a 
confirmation message.

Rewinder Distance 600 millimeter (24 inch)
900 millimeter (36 inch)
1200 millimeter (48 inch)

Specifies the amount to be 
fed when the FEED button 
is pressed in the stand-by 
state, using the output slot 
as the reference point.

Feed Distance 150 millimeter (6 inch)
300 millimeter (12 inch)
450 millimeter (18 inch)

Specifies the amount to be 
fed when the FEED button 
is pressed in the through 
paper state, using the 
current position as the 
reference point.

Item Value Description

Item Value Description

Reset Settings Execute Restores the user menu 
settings to the factory 
settings.

Save Settings Execute Saves the current menu 
settings.

Restore Settings Execute Changes the saved menu 
settings.
Displayed when Save 
Settings is executed on the 
control panel.
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Bold indicates factory-set values.

Change Password

Bold indicates factory-set values.

Print Statistics
To enter this menu, it is necessary to enter the password. The factory default setting of the 
administrator password is 0000.

Item Value Description

New Password ************ Sets a new password to be 
entered in the Admin 
menu and Boot Menu.

Verify Password ************ Sets a new password to be 
entered in the Admin menu 
and Boot Menu for which 
New Password has been 
set.

Item Value Description

Usage Report Enable
Disable

Enables/disables the 
Usage Report function.

Supplies Report Enable
Disable

Sets whether or not to 
display the number of wear 
item replacements.
Not displayed if Disable is 
set for the control panel 
Print Statistics > Usage 
Report item.

Reset Main Counter Execute Resets the main counter 
aggregate value.
Not displayed if Disable is 
set for the control panel 
Print Statistics > Usage 
Report item.

Reset Supplies Counter*2 Execute Resets the number of wear 
item replacements.
Not displayed if Disable is 
set for the control panel 
Supplies Report item.
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Bold indicates factory-set values.

Calibration

Change Password*1 New Password **** Sets the new password to 
be entered in Print 
Statistics.
Not displayed if Disable is 
set for the control panel 
Print Statistics > Usage 
Report item.

Verify Password **** Sets a new password to be 
entered in the Print 
Statistics for which New 
Password has been set.
Not displayed if Disable is 
set for the control panel 
Print Statistics > Usage 
Report item.

Item Value Description

Item Value Description

Auto Density Mode On
Off

Sets whether to 
automatically compensate 
density and shade.

Adjust Density Execute Implements density 
compensation. Implement 
when the device is in 
stand-by status.

Adjust Registration Execute Implements auto color 
misalignment 
compensation operations. 
Implement when the device 
is in stand-by status.

Color Density Cyan Density -3
|
0
|
+3

Adjusts the cyan density.
This setting is enabled from 
printing after the density 
compensation has been 
implemented.

Color Density Magenta Density -3
|
0
|
+3

Adjusts magenta density.
This setting is enabled from 
printing after the density 
compensation has been 
implemented.
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Color Density Yellow Density -3
|
0
|
+3

Adjusts yellow density.
This setting is enabled from 
printing after the density 
compensation has been 
implemented.

Color Density Black Density -3
|
0
|
+3

Adjusts black density.
This setting is enabled from 
printing after the density 
compensation has been 
implemented.

Color Density White Density -3
|
0
|
+3

Adjusts white density.
This setting is enabled from 
printing after the density 
compensation has been 
implemented.
Displayed with QL-300s 
only.

Print Color Tuning Pattern Execute Prints patterns to match the 
shading characteristics.

Base Color Tuning Highlight A-1
A-2
B-1
B-2
|
O-1
O-2

Matches the color balance 
for the parts displayed as 
most clear in the highlight 
area of the printed color 
tuning pattern.
The matching results are 
reflected in the highlight 
matching values for cyan, 
magenta, and yellow 
matching.

Base Color Tuning Mid-Tone A-1
A-2
B-1
B-2
|
O-1
O-2

Matches the color balance 
for the parts displayed as 
most clear in the mid-tone 
area of the printed color 
tuning pattern.
The matching results are 
reflected in the mid-tone 
matching values for cyan, 
magenta, and yellow 
matching.

Item Value Description
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Base Color Tuning Dark A-1
A-2
B-1
B-2
|
O-1
O-2

Matches the color balance 
for the parts displayed as 
most clear in the dark area 
of the printed color tuning 
pattern.
The matching results are 
reflected in the dark 
matching values for cyan, 
magenta, and yellow 
matching.

Fine Color Tuning Cyan 
Tuning

Highlight -4
|
0
|
+4

Matches the highlights 
(light areas) of the cyan 
shade characteristics.

Mid-Tone -4
|
0
|
+4

Matches the intermediate 
areas of the cyan shading 
characteristics.

Dark -4
|
0
|
+4

Matches the dark (dark 
areas) of the cyan shade 
characteristics.

Fine Color Tuning Magenta 
Tuning

Highlight -4
|
0
|
+4

Matches the highlights 
(light areas) of the magenta 
shading characteristics.

Mid-Tone -4
|
0
|
+4

Matches the intermediate 
areas of the magenta 
shading characteristics.

Dark -4
|
0
|
+4

Matches the dark (dark 
areas) of the magenta 
shading characteristics.

Item Value Description
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Fine Color Tuning Yellow 
Tuning

Highlight -4
|
0
|
+4

Matches the highlights 
(light areas) of the yellow 
shading characteristics.

Mid-Tone -4
|
0
|
+4

Matches the intermediate 
areas of the yellow shading 
characteristics.

Dark -4
|
0
|
+4

Matches the dark (dark 
areas) of the yellow 
shading characteristics.

Fine Color Tuning Black 
Tuning

Highlight -3
|
0
|
+3

Matches the highlights 
(light areas) of the black 
shading characteristics.

Mid-Tone -3
|
0
|
+3

Matches the intermediate 
areas of the black shading 
characteristics.

Dark -3
|
0
|
+3

Matches the dark (dark 
areas) of the black shading 
characteristics.

Reset Color Tuning Execute Resets CMYK color 
matching.

Item Value Description
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Bold indicates factory-set values.

Boot Menu
This menu is displayed in English only.

Boot Menu
To enter this menu, press and hold the OK button while turning ON the power supply. Confirm 
that Boot Menu is selected and then press the OK button.

White Tuning*1 Highlight -3
|
0
|
+3

Matches the highlights 
(light areas) of the white 
shading characteristics.
Displayed with QL-300s 
only.

Mid-Tone -3
|
0
|
+3

Matches the intermediate 
areas of the white shading 
characteristics.
Displayed with QL-300s 
only.

Dark -3
|
0
|
+3

Matches the dark (dark 
areas) of the white shading 
characteristics.
Displayed with QL-300s 
only.

Density Adjustment Media Standard Media
Narrow/Thick Media

Specifies the operation 
speed during a density 
adjustment operation.
Standard Media: Density 
adjustment operation 
performed at normal speed.
Narrow/Thick Media: 
Density adjustment 
operation performed at low 
speed.

Item Value Description
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To enter this menu, it is necessary to enter the password. The factory default setting of the 
administrator password is 999999.

Bold indicates factory-set values.

Troubleshooting
To enter this menu, press and hold the OK button while turning ON the power supply. Select 
Troubleshooting and then press the OK button.

Saving Toner When Printing

Saving Toner When Printing (Toner Save Mode)
You can print by economizing the toner consumption amount by reducing the page print 
density. Separately enable or disable the toner economy mode for 100% black.

Item Value Description

Storage Common 
Setup

Check File System Execute Executes management 
data (FAT information) 
recovery, and resolves 
mismatches between the 
actual (free) space in the 
file system and the 
displayed free space.

Check All Sectors Execute Recovers defective sector 
information on the HDD 
and file system 
non-conformances.

Menu Lockout On
Off

Specifies whether or not to 
display menus on the 
control panel.

Panel Lockout Mode1
Mode2
Off

Sets whether to disable the 
operations buttons on the 
control panel.

Item Value Description

Sensor Calibration Reset Execute This resets all sensor 
calibration results to initial 
values.
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You can suppress the quantity of toner used by selecting one of the following five patterns as 
necessary to reduce toner density.

• Printer setting: Follows the printer’s setup.

• Off: Prints using regular density without economizing the toner.

• Save Level Low: Prints using medium light toner.

• Save Level Middle: Prints using light toner.

• Save Level High: Prints using considerably light toner.

Toner Saving is enabled only if the print quality is specified as Normal or Draft.

The settings on the printer can be changed from Admin Setup > Print Setup > Toner Save. 
However, the printer driver settings are given priority.

Note: Toner save mode is not compatible with Spot Color printing.

Windows PCL Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).

4. On the Color tab, use Toner Saving to select a toner save quantity.

5. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).
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4. On the Color tab, use Toner Saving to select a toner save quantity.

5. Print.

Printing Using the Specified Print Cartridge Only (Lift Up)
The lifespan of an unused print cartridge can be prolonged by separating it from the belt unit.

Setting combinations are shown in the table below.

Example: Printing using the CMYK Print Cartridge only

In this example, the White* (W) Print Cartridge is lifted up.

Print Color Print Cartridge to be Lifted Up

Black (K) only Cyan, magenta, yellow, white*

White* (W) only Black, cyan, magenta, yellow

Black + white* Cyan, magenta, yellow

Black, cyan, magenta, yellow White*
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*: Supported by QL-300s only.

1. Grasp the top cover open lever and open the top cover.

2. Check the position of the unused print cartridge via the label letters and color.

3. Turn the lift up lever on the print cartridge that is not being used clockwise to raise the 
print cartridge.
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4. Close the top cover.

Caution: When closing the top cover, there is a risk of pinching your fingers or hands in 
the top cover or the top cover’s support. Press on the top of the top cover to close it.

Caution: There is a risk of pinching your fingers or hands if you hold the LED head while 
closing the top cover. Press on the top of the top cover to close it.

Fine Quality Printing

Changing Print Quality (Resolution)
Set Quality by aligning to the environment in which it is used.

Selecting Fine/Detail (1200x1200 dpi) prints at the highest quality available with the printer.

Windows PCL Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).
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4. On the Setup tab, change the Quality setting.

5. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).

4. On the Setup tab, change the Quality setting.

5. Print.
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Making Photograph Printing More Vivid (Photo Enhance)
You can print more natural and vivid images, such as photos, etc.

Note: This function can be used with Windows PCL printer drivers only.

Windows PCL Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).

4. On the Setup tab, select Photo Enhance in the Quality section, and then click OK.

5. Print.

Printing Sharper Photos (Image Smoothing)
You can reduce “jaggies” and “banding” (uneven gradation).

Note: This function can be used with Windows PS printer drivers only.

Windows PS Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).
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4. On the Setup tab, select Image Smoothing in the Quality section, and then click OK.

5. Print.

Adjusting Fine Lines
You can prevent misaligned lines being printed when ultra-fine lines are specified from the 
application. This function is normally ON.

Depending on the application, bar code and other intervals will narrow. In this case, turn OFF 
the function.

Windows PCL Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).
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4. On the Extend tab, click Advanced.

5. Select Adjust ultra fine lines. Next, select Off for Settings, and then click OK.

6. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).
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4. On the Extend tab, click Advanced.

5. Select the Adjust ultra fine lines check box, and then click OK.

6. Print.

Using Printer Fonts
You can print by replacing TrueType fonts with printer built-in fonts.

• The font replacement function stores the document fonts, but font designs cannot be 
reproduced. If it is necessary to print font designs accurately, disable the font replace-
ment function.

• In some applications, the font replacement function may not work properly.

Note: This function can be used with Windows PCL printer drivers only.

Windows PCL Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).
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4. Click the Extend tab, and then select Fonts.

5. On the “Font” screen, select the Font Substitution check box.

For this printer, this check box is selected as the default setting.

6. Use the Font Substitution Table to specify which printer fonts should replace the 
TrueType fonts.

7. Print.

Using Computer Fonts
You can output TrueType fonts as they appear on the screen.

Note: Print time may be longer.

Windows PCL Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).
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4. On the Extend tab, click Fonts.

5. On the “Font” screen, clear the Font Substitution check box.

• Download as Outline Font - The font image is created by the printer.

• Download as Bitmap Font - The font information is created by the printer driver.

6. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).

4. On the Advanced tab, click TrueType Font, and then select Download as Softfont.

5. Print.

Adjusting the Print Position on the Paper
You can correct the print start position vertically and horizontally on the paper by the printer 
settings.

Please refer to the following procedure.
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Using the Roll Paper

1. Press the Fn key.

The numerical values input screen will be displayed.

2. Press 2, 2, 0 (function numbers), and then press the OK button.

3. Press the scroll button ▲ or ▼ to select the item you want to adjust.

Paper feed 

direction
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4. Press the OK button.

5. Press the scroll button ▲ or ▼ to select the amount of the adjustment, and then press 
the OK button. Confirm there is a check mark to the left of the selected value.

• Y represents the paper feed direction and X represents the orthogonal position relative 
to the paper feed direction.

• Set positive [+] numbers to widen the blank space in the X direction, and also set positive 
[+] numbers to widen the blank space in the Y direction.

• Readjustment might be necessary depending on the usage conditions (temperature, 
humidity, media type).

• By eliminating the differences between printers and using the same settings on all the 
printers with this procedure, you can use one computer when you want to get the same 
print results on multiple printers. See “Using the Printer Driver to Fine-tune the Print Posi-
tion” on page 81.

Adjusting the Print Start Position
This section explains how to better align the position at which printing starts for die-cut label 
paper (with black mark), continuous label (with black mark), and die-cut label paper.

This adjustment is unnecessary if your print jobs do not require accurate positioning of where 
printing starts.

1. Adjust the position that printing starts on the first page.

a. After setting the size of the media, calibrate the sensor and execute Paper interval 
detection.

b. In the driver’s print settings, set To specify the number of pages per cut in Cut 
Mode and set 1 in Cut by collation.

Note: You may not be able to set 1 in Cut by collation if the paper on which you 
are printing is shorter than 101.6 mm. If this is the case, set the smallest value that 
you can select.

c. Print five pieces of the media on which you are actually printing.



Print Function Settings

QL-300 User Guide 196
 

d. Measure the distance at A or B, as shown in the diagram, for all five sheets and 
then calculate the average of these values.

e. Calculate the difference in the position you want to print and the average value 
from the previous step.
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f. Adjust the position using Y Adjust in Menus > Print Adjust > Print Position 
Adjust.

When using a black mark sensor - At the point that the black mark intersects the 
position of the black mark sensor on the printer, measure the distance at A from 
the leading edge of the black mark to the printed matter on five sheets.

When using a gap sensor - At the point that the label intersects the position of the 
gap sensor on the printer, measure the distance at B from the leading edge of the 
label to the printed matter on five sheets.

The plus and minus directions for print adjustment are illustrated below.

Black mark sensor 
on the printer

Label 
paper

A

Liner

Printed 
matter �

Cutting off part of 
the label makes 
measuring easier.

Gap sensor on the 
printer

B

|
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2. If you are actually printing more than two sheets consecutively, then next, do the following 
adjustment.

(Improve the accuracy of the function for learning the position that printing starts)

a. In the driver’s print settings, set To specify the number of pages per cut in Cut 
Mode and set 20 in Cut by collation.

b. Print 20 pieces as a test print.

These printouts are test prints for adjusting positions, so throw them away when 
you are done.

3. The adjustments are complete when printing is done in the position you want.

Reset the cutter settings, and then start printing.

Other Print Functions

Specifying the Page Order
Extracts by page order when printing documents with multiple pages.

There are two methods.

• Printing documents in page order.

• Printing documents in reverse page order.

Windows PCL Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).

Direction that media is fed

If you set Y Ad-
just in the minus 
direction, the im-
age moves up

If you set Y Ad-
just in the plus 
direction, the im-
age moves down
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4. On the Setup tab, select the Print in reverse order check box in the Copies area.

5. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).

4. On the Setup tab, select the Print in reverse order check box in the Copies area.

5. Print.
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Overlaying Stamps for Printing (Watermarks)
The details to be printed from the application can be independently printed overlaying Samples, 
Confidential, etc.

Windows PCL Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).

4. On the Extend tab, click Watermarks.

Samples
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5. Click New.

6. On the Watermarks screen, enter text into Text, and configure Size and other settings.

7. Click the OK button.

8. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).
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4. On the Extend tab, click Watermarks.

5. Click New.

6. On the Watermarks screen, enter text into Text, and configure Size and other settings.
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7. Click the OK button.

8. Print.

Collating Printed Output (Sorted Printing)
You can store print jobs in the device memory and collate the printing.

• Printing by specifying batches (x2 sets)

• Printing without specifying batches (x2 sets)

Note: This feature is not usable with some applications.

Windows PCL Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).

4. On the Setup tab, enter a value for Copies, and then select the Collate check box.

1
2

3

1
2

3

1
2

3

1
2

3
3

2
3

1
1

2
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5. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).

4. On the Setup tab, enter a value for Copies, and then select the Collate check box.

5. Print.

Printing a Mirror Image
Print using mirror print when you want to print image to appear normal when the page is viewed 
from the back.

Windows PCL Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).
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4. On the Setup tab, select the Mirror Print check box in the Orientation section, and then 
click OK.

5. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).

4. On the Setup tab, select the Mirror Print check box in the Orientation section, and then 
click OK.

5. Print.



Print Function Settings

QL-300 User Guide 206
 

Printing Registered Forms (Print Overlay)
You can register forms, logos, etc., as forms to the device, and overlay for printing.

To print an overlay, you need to create a form and register it in advance. It is possible to specify 
a maximum of four forms in one group. Forms are overlaid and printed in the order they are 
registered. That is to say, the last form you register is printed on top.

Windows PCL Printer Driver
1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.

3. Right-click the QL-300 icon, and then select Printing Preferences.

4. On the Overlays tab, select Overlay Print.

5. To register a form to the printer, select Register print document as a new form and 
click Apply > OK. From the application, print the image you want to register as a form, 
and when the New Form screen appears input the various information and click OK.

6. To apply an overlay, select Overlay Print. Select the forms you want to use for overlay 
printing and click Apply > OK. Print from the application.

Windows PS Printer Driver
1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.

3. Right-click the QL-300 icon, and then select Printing Preferences.



Print Function Settings

QL-300 User Guide 207
 

4. On the Overlays tab, select Overlay Print.

5. To register a form to the printer, select Register print document as a new form and 
click Apply > OK. From the application, print the image you want to register as a form, 
and when the New Form screen appears input the various information and click OK.

6. To apply an overlay, select Overlay Print. Select the forms you want to use for overlay 
printing and click Apply > OK. Print from the application.

Outputting to a File Without Printing
You can write and save to a file without printing the print data.

Windows PCL Printer Driver
1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.

3. Right-click the QL-300 icon, and then select Printer Properties.

4. Select the Ports tab.
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5. In the ports list, select FILE:, and then click OK.

6. Print.

7. Enter the file name, and then click OK.

Windows PS Printer Driver
1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.

3. Right-click the QL-300 icon, and then select Printer Properties.

4. Select the Ports tab.

5. In the ports list, select FILE:, and then click OK.

6. Print.
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7. Enter the file name, and then click OK.

Changing the Check Unnecessary Print Cartridge Setting
You can have an error displayed and cancel the print job to prioritize the service life of a print 
cartridge that is detected to be down even though it is not being used as a specified color for 
the print data.

1. Press the scroll button ▼ several times to select Admin Setup, and then press the OK 
button.

2. Use the numeric keypad to input the administrator password.

The factory default password is 999999. Press the OK button after inputting each char-
acter.

3. Select Print Setup, and then press the OK button.

4. Select Check Unnecessary Print Cartridge, and then press the OK button.
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5. If you want an error to be generated when a print cartridge is detected to be down even 
though it is not being used as a specified color for the print data, select On. Select Off if 
you want printing to continue. Then, press the OK button.

6. Press the ON LINE button to return to the standby screen.

Saving Printer Driver Setups
You can save the details set using the printer drivers.

If you save the changes to the settings for multiple locations, then the next and following times 
you change the settings, all you have to do is specify the driver settings so that those settings 
in the multiple locations are automatically changed to the settings that you saved.

Save a Setup
1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.
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3. Right-click the QL-300 icon, and then select Printing preferences.

If you are using the Windows PCL printer driver, the following window will open.

If you are using the Window PS printer driver, the following window will open.

4. Change the settings to create the setup you want to save.

5. On the Setup tab, click Save.

6. Enter the setting name into Save Favorites as, and then click OK.
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7. Click OK to close the Print Setup dialog box.

Recall a Saved Setup
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).

4. On the Setup tab, configure Favorites.

5. Print.

Delete a Saved Setup
1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.

3. Right-click the QL-300 icon, and then select Printing Preferences.

4. On the Setup tab, click Management.

5. Click Delete.

6. Select the setup you want to delete, and then click Delete.

7. Click Yes.

Importing/Exporting a Printer Driver Print Setup
You can convert printer driver print setup information to a file, and then export/import the file. 
The file extension for exporting/importing is “.xmn”.

Export a Setup
1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.

3. Right-click the QL-300 icon, and then select Printing Preferences.

4. On the Setup tab, click Management.
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5. Click Export.

6. In the List of favorite settings on the “Export” screen, select the checkbox next to the 
setup you want to export, and then click Export.

7. Enter a file name, specify where to save it, and then click Save.

Import a Setup
1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.

3. Right-click the QL-300 icon, and then select Printing Preferences.

4. On the Setup tab, click Management.

5. Click Import.
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6. On the “Import” screen, click Open the file.

7. Specify the file you want to import, and then click Open.

8. Check the names of the settings in the List of favorite settings, and then click Import.

9. When the message “Imported successfully.” appears, click OK.

Changing Default Printer Driver Settings
It is convenient to set frequently used settings as the default settings.

Windows PCL Printer Driver
1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.

3. Right-click the QL-300 icon, and then select Printing Preferences.

4. Change the various settings, and then click OK.

Deleting or Updating a Printer Driver

Deleting a Printer Driver
PC administrator privileges are required.

Restart the computer, and then delete the driver.

1. Click Start and select Control Panel in Windows.

2. Click View devices and printers.

3. Right-click the QL-300 icon, and then select Remove device.

4. If a verification message is displayed, click Yes.

Note: If a message appears while the device is in use, restart the PC, and then perform 
steps 1 and 2 of this procedure again.
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5. Select one of the icons in Devices and Printers, and click Print server properties in the 
top bar.

6. Select the Drivers tab.

7. Click Change Driver Settings.

8. Select the driver to be deleted, and click Remove.

9. If a message asking whether to delete the drivers only, or the drivers and packages from 
the system, select to delete drivers and packages, and click OK.

10. If a verification message is displayed, click Yes.

11. If the Remove Driver Package dialog box is displayed, click Delete > OK.

Note: If you cannot cancel, restart the PC, and then perform steps 4 to 10 of this 
procedure again.

12. Click OK in the Print server properties dialog box.

13. Restart the PC.

Updating a Printer Driver
PC administrator privileges are required.

1. Obtain the printer driver from QuickLabel.

2. Double-click the file you downloaded.

3. Select the desired language, and then click OK.

Note: When the “User Account Control” window is displayed, click Yes.

4. Read the “Software License Agreement”, and click Accept.
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5. Follow the instructions that appear on the screen to finish driver installation.

• Attempting to install an old version driver will cause an update screen to appear. 
Follow the instructions that appear on the screen.

• Updating a driver may require restarting of the computer.

6. When the Program Compatibility Assistant dialog appears, click This program installed 
correctly.
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Adjusting the Color

Adjusting Color with the Control Panel

Correcting Color Drift Manually
The printer compensates color drift automatically according to the conditions of use. If the color 
drift is noticeable, you can also implement compensation manually.

1. Press the Fn key.

The numerical values input screen will be displayed.

2. Press 3, 0, 1 (function numbers) and press the OK button.

3. Check that Execute has been selected, and press the OK button.

4. The display will return to the standby screen.

Configuring Settings for Auto Adjustment of Density and Gradation
The printer compensates density automatically according to the conditions of use. To 
compensate automatically, turn On the density compensation matching setting.
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In the default factory settings, density compensation matching is implemented automatically.

1. Press the scroll button ▲ or ▼.

2. Select Calibration, and press the OK button.

3. Select Auto Density Mode, and then press the OK button.

4. Select On, and then press the OK button. Confirm there is a check mark to the left of On.

5. Press the ON LINE button to return to the standby screen.
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Adjusting Density Manually
The printer can implement compensation periodically using auto density compensation mode, 
but if the print density is noticeable, it can also be compensated manually.

Density adjustment values are set by specifying Cyan Density, Magenta Density, Yellow 
Density, Black Density, and White Density* values with the control panel.

*: This item available only on the QL-300

1. Press the Fn key.

The numerical values input screen will be displayed.

2. Press 3, 0, 0 (function numbers) and press the OK button.

3. Check that Execute has been selected, and press the OK button.

4. Execute density adjustment.

5. The display will return to the standby screen after density adjustment is complete.
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Fine Tuning Density Adjustments
You can finely adjust the densities of colors that are used as the references for density 
compensation.

Adjust each color separately for the parts where the density is noticeable from the print results.

This section describes the procedure for adjusting the reference density for cyan. Use the same 
adjustment procedure also for other colors that you wish to adjust.

Increasing cyan after checking the print results
1. Press the Fn key.

The numerical values input screen will be displayed.

2. Press 3, 1, 0 (function numbers) and press the OK button.

For other colors, use the operations below.

• To tune magenta, press the Fn key, and then press the following buttons: 3, 1, 1, 
OK.

• To tune yellow, press the Fn key, and then press the following buttons: 3, 1, 2, OK.

• To tune black, press the Fn key, and then press the following buttons: 3, 1, 3, OK.

• To tune white, press the Fn key, and then press the following buttons: 3, 1, 4, OK. 
This option is only available on the QL-300s.
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3. Press the scroll button ▲ or ▼ to specify a value that is larger than the current value, and 
then press the OK button.

Confirm there is a check mark to the left of the selected value.

Select +1 to +3 to make density darker, or -1 to -3 to make it lighter.

4. Press the ON LINE button to return to the standby screen.

5. Press the Fn key, and then press 3, 0, 0, OK.

6. Check that Execute has been selected, and press the OK button.

7. The display will return to the standby screen.

8. Print.

If you are not satisfied with the density, repeat steps 1 to 6 of this procedure.
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Adjusting Color Balance (Density)
The printer can implement compensation periodically using auto density compensation mode. 
However, you can implement this adjustment when you want to adjust the gray balance of the 
halftones, which is not sufficiently adjusted by the auto density compensation.

• The densities of the colors are mutually dependent on each other, so you will need to 
repeat adjustment several times until the desired color balance is achieved.

• The results of the basic Base Color Tuning are reflected in the settings in Fine Color 
Tuning. Consequently, if the Fine Color Tuning are adjusted manually, these settings 
will be reset, so be careful. However, the Black Tuning settings are not reset.

1. Print a color tuning pattern.

a. Press the Fn key.

The numerical values input screen will be displayed.

b. Press 3, 0, 2 (function numbers) and press the OK button.

c. Check that Execute has been selected, and press the OK button.

d. The color tuning pattern will be printed.
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2. Use the print results for the color tuning pattern to check the current color balance.

Check the area to be referenced using “Base Color Tuning”. Check the “Highlight”, 
“Mid-Tone”, and “Dark” areas of the color tuning pattern and note the number (A-1 and 2 
to O-1 and 2) of the block whose pattern of mixed CMY part (upper left) is most similar to 
its single color K part (lower right).

Note: If the pattern that seems most similar to the adjacent CMY mixed colors part and 
single color K part in the “Highlight”, “Mid-Tone”, or “Dark” areas matches the “Current” 
on the left of the color tuning pattern, the color balance is normal and does not require 
adjustment.

3. Use the print results for the color tuning pattern to adjust the color balance.

a. Press the scroll button ▲ or ▼.

b. Select Calibration, and press the OK button.
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c. Select Base Color Tuning, and press the OK button.

d. Specify the number of the desired square in the “Highlight” area of the pattern, and 
then press the OK button.

e. Specify the number of the desired square in the “Mid-Tone” area of the pattern, and 
then press the OK button.

f. Specify the number of the desired square in the “Dark” area of the pattern, and then 
press the OK button.
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g. The pattern number specified in each area will be displayed.

If the pattern number is correct, select Yes, and press the OK button.

To respecify the pattern number select No to return to the “Calibration” screen.

h. Select Return, and press the OK button to return to the standby screen.

If the desired color balance is not obtained even after Base Color Tuning, adjust 
the CMY color balance watermarks manually using the procedure under Adjusting 
the color balance. For color balance fine tuning, see “Fine-tuning Color Balance” 
on page 225.

If the overall tone is still too bright or too dark even after implementing Base Color 
Tuning, adjust the black tone manually using Fine Color Tuning, and then imple-
ment Basic color Tuning again. To brighten the overall tone, adjust the black tone 
in Fine Color Tuning in the - direction, and to darken the overall tone, adjust the 
black tone in Fine Color Tuning in the + direction.

4. Check the color balance adjustment results.

a. Print the color tuning pattern.

b. Use the print results for the color tuning pattern to check the adjusted results.

If the pattern that seems most similar to the adjacent CMY mixed colors part and 
single color K part in the “Highlight”, “Mid-Tone”, or “Dark” areas matches the 
“Current” on the left of the color tuning pattern, the color balance adjustment is 
complete.

Repeat steps 1 through 3 of this procedure in accordance with the results of your pattern 
check.

Fine-tuning Color Balance
The printer can implement compensation periodically using auto density compensation mode. 
However, you can implement this adjustment when you want to finely adjust the gray balance 
of the halftones, which is not sufficiently adjusted by the auto density compensation.
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• The densities of the colors are mutually dependent on each other, so you will need to 
repeat adjustment several times until the desired color balance is achieved.

1. Print a color tuning pattern.

a. Press the Fn key.

The numerical values input screen will be displayed.

b. Press 3, 0, 2 (function numbers) and press the OK button.

c. Check that Execute has been selected, and press the OK button.

d. The color tuning pattern will be printed.
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2. Use the print results for the color tuning pattern to check the current color balance.

Check the area to be referenced using “Fine Color Tuning”.

The color tuning pattern blocks are arranged in four rows of 11 columns. The four rows 
are printed with the following colors, from top to bottom: Cyan, Magenta, Yellow and 
Black.

The 11 columns represent color tone, and vertical broken lines are labeled as Highlight, 
Mid-Tone, and Dark.

3. Use the print results for the color tuning pattern to adjust the color balance watermarks.

If you are adjusting the color balance, use the control panel to specify the shade (High-
light, Dark, and Mid-Tone) of each color.

This section explains the procedure for slightly darkening the cyan highlights. Adjust the 
watermarks for colors other than cyan in the same way.

a. Press the scroll button ▲ or ▼.

b. Select Calibration, and press the OK button.
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c. Select Fine Color Tuning, and press the OK button.

d. Select Cyan Tuning, and press the OK button.

e. Select Highlight, and press the OK button.

f. Specify a larger value than the current set value, and press the OK button. Confirm 
there is a check mark to the left of the specified value.

Select +0.1 to +4.0 to make density slightly darker, or -0.1 to -4.0 to make it slightly 
lighter. Note, however, that the black adjustment ranges are +0.1 to +3.0 and -0.1 
to -3.0.

g. Press the ON LINE button to return to the standby screen.

4. Check the color balance adjustment results.

a. Print the color tuning pattern.

b. Use the print results for the color tuning pattern to check the adjusted results.

Repeat steps 1 through 3 of this procedure in accordance with the results of your pattern 
check.
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Adjusting Color with a Printer Driver

About Color Matching
It is important to manage the work processes from data creation to output based on methods 
with color consistency. For example, scanners, digital cameras, and monitors, and other 
devices express the blending ratio to which the light of red, blue, and green (three colors) have 
been added to black as values over the RGB color space (additive mixture of colors).

Meanwhile, printers express the blending ratio of the four toner colors cyan, magenta, yellow, 
and black relative to white (white light), with the three reflected colors red, blue, and green 
excluded as values in the CMYK color space (subtractive mixture of colors).

The RGB color space and CMYK color space are color spaces dependent on the machine 
used, and so when converting color spaces, the colors will be different from the reproduced 
colors unless individual machine characteristics are taken into consideration.

To maintain color consistency from data creation to output, it is necessary to consider the color 
differences by device when converting colors. This process is called “color matching”. The 
program that implements the color matching is called the “color management system” (CMS).

The printer can use either printer driver color matching or application color matching.

Note: Even if you are using color matching, the printed colors may appear dark compared to 
the colors on the monitor. This is because the range of colors that can be reproduced by the 
device is narrower than the range of colors that can be reproduced by the monitor, so even if 
color matching is used, the vivid colors on the monitor cannot be reproduced.

Color Matching (Automatic)
The procedure below performs recommended color matching for general documents. 
Generally use the settings shown here.

Windows PCL Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).
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4. In “Color” on the Color tab, select Automatic, and then click OK.

5. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).

4. In “Color” on the Color tab, select Automatic, and then click OK.

5. Print.
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Simple Color Matching (Simple Adjustment)
Color matching is used on a printer for reproduction of the RGB colors required to print from 
word processor, spreadsheet, presentation, and other similar software.

Color matching is implemented using a special accelerator (ASIC) that is built into the printer. 
When converting RGB color space print data to the printer CMYK color space, color matching 
processing is applied.

• In the case of a Windows PCL printer driver, color matching is not applied even if Auto-
matic or Simple Adjustment is selected for the CMYK color space print data. In this 
case, select “Graphic Pro”.

Setup Items
RGB Color Setting - Specifies the method for expressing the colors processed using color 
matching.

• Monitor - Auto

During color matching, represents color by the most ideal method suited to the document 
to be printed, emphasizing compatibility with the monitor (color temperature 6500 K). 
Normally use this setting.

• Monitor - Perceptual

During color matching, represents the color by the method emphasizing the gradation 
suiting the natural image of the photograph and compatibility with the monitor (color 
temperature 6500K).

• Monitor - Vivid

During color matching, represents the color by the method emphasizing the vividness 
suiting the images and text, and compatibility with the monitor (color temperature 6500K).

• Monitor - light

During color matching, represents the color by the method emphasizing the gradation 
suiting the natural image of the photograph and compatibility with the monitor (color 
temperature 9300K).

• Adobe RGB

Specify if you are using an input device with AdobeRGB color characteristics.

• sRGB

The sRGB colors within the printer's color gamut are printed without any modification. 
Only colors that fall outside the printer's color gamut are matched with the outer shell. 
Suitable for matching specific colors.

Black Finish - Sets the black finish when printing in color. Normally use Auto as is.

Windows PCL Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).
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4. On the Color tab, click Color, select Automatic or Simple Adjustment, and then click 
OK.

5. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).

4. On the Color tab, click Color, select Automatic or Simple Adjustment, and then click 
OK.

5. Print.
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Color Matching (Graphic Pro)
Graphic Pro is the optimal choice for use with DTP software. It lets you specify simulation 
printing for any CMYK output device.

Windows PCL Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).

4. On the Color tab, click Color, then select Graphic Pro, and then click OK.

5. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).
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4. On the Color tab, click Color, then select Graphic Pro, and then click OK.

5. Print.

Color Matching (No Color Matching)
Prints using the specified colors as is, without implementing color matching using the printer 
drivers or device.

Select if implementing color matching using an application.

Windows PCL Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).
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4. On the Color tab, click Color, then select No Color Matching, and then click OK.

5. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).

4. On the Color tab, click Color, then select No Color Matching, and then click OK.

5. Print.
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Changing the Black Finish
The finish for the black parts will be changed when printing in color. This can be used when the 
printer driver's color mode setting is Simple Adjustment or Graphic Pro.

Setup Items
Black Finish

• Auto

Creates black using the optimum methods according to the document to be printed. This 
setting can be selected only when the color mode is set to Simple Adjustment. This 
setting cannot be configured on the Graphic Pro.

• Composite Black (CMYK)

Synthesizes black using cyan, magenta, yellow, and black toner. The black is close to 
brown. Ideal for photos.

• True Black (K)

Prints black using black toner only. Ideal for diagrams and documents. When printing 
photos, the dark parts are blackish.

Pure Black Text/Graphics (Graphic Pro Only) - If black defined using the RGB color space for 
text and graphics (R=0, G=0, B=0) or black defined using the CMYK color space (C=0, M=0, 
Y=0, K=100%) is specified, this setting specifies whether printing should use black (K) toner 
only.

• ON

Prints the text and graphics specified as black using black (K) toner only.

• OFF

Text and graphics specified as black are synthesized using either black (K) toner only or 
CMYK depending on the profile specified by color matching.

Windows PCL Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).

4. On the Color tab, select Simple Adjustment or Graphic Pro.
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5. In the Black Finish section, select the black finishing method. In the Graphic Pro mode, 
also select ON or OFF for Pure Black Text/Graphics, and then click OK.

6. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).

4. On the Color tab, select Simple Adjustment or Graphic Pro, and then click Detail.

5. In the Black Finish section, select the black finishing method. In the Graphic Pro mode, 
also select ON or OFF for Pure Black Text/Graphics, and then click OK.

6. Print.

Monochrome (Black and White) Printing
The color data is printed using grayscale (shades of black and white) without touching the print 
data.

Note: If implementing color printing after printing by specifying “Monochrome”, a delay may 
occur depending on the temperature adjustment of the fuser unit.
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• Even if the cyan (blue), magenta (red), or yellow print cartridge life has been reached, 
monochrome printing using only black can be done by specifying “Monochrome”.

• Refer to “Printing Using the Specified Print Cartridge Only (Lift Up)” on page 184 
regarding printing with black only.

Windows PCL Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).

4. On the Color tab, select Monochrome. Adjust lightness and darkness as required.

5. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).
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4. On the Color tab, select Monochrome. Adjust lightness and darkness as required.

5. Print.

Suppressing White Lines Between Text and the Background (Black 
Overprint)

If you are imaging 100% black text on a colored background, you can print (overprint) by 
overlaying the text and background parts. Set if there are gaps such as white lines, etc., in the 
borders between the text and background.

• Not usable with some applications.

• Black overprint cannot be used if the text is not 100% black, the text has been rendered 
as graphics by extracting the outlines, or if the text is an image.

• If the background color is dark (toner layer thickness exceeds 240%), toner may not be 
fixed completely. For example, if printing 100% black text on backgrounds of 50% cyan, 
50% magenta, and 50% yellow, the toner layer thickness is 50+50+50+100=250%, which 
exceeds 240%.

Windows PCL Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).

4. On the Extend tab, click Advanced.
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5. Select Overprint Black. Next, for Settings, select On, and then click OK.

6. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).

4. On the Color tab, click Advanced.

5. Select the Black overprint check box, and then click OK.

6. Print.

Correcting for Print Misalignment (Trapping)
Use if there are white or colored lines between two overlapping objects due to print 
misalignment.

Windows PCL Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).

4. On the Extend tab, click Advanced.
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5. Select Trapping. Next, select the misalignment correction method with Settings, and 
then click OK.

Selections that include Choke White are only shown for the QL-300s.

6. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).

4. On the Extend tab, click Advanced.

5. Select the misalignment correction method in Trapping, and then click OK.

Selections that include Choke White are only shown for the QL-300s.

6. Print.

Simulating Print Results
The printer adjusts CMYK color data to simulate the characteristics of ink, such as that used in 
offset printing.

The ICC profiles registered as standard are described below.

RGB Profiles
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• sRGB

• AdobeRGB

CMYK Input Profiles

• SWOP

• ISO Coated

• Japan Color

• JMPA

Note: Enabled when Color Mode is set to either Simple Adjustment or Graphic Pro.

Windows PCL Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).

4. On the Color tab, click Detail, and then select Graphic Pro.

5. Select Printer Simulation, and then use the list under Simulation Target Profile to 
select the ink characteristics you want to simulate.

6. Click OK.

7. Print.

Windows PS Printer Driver
1. Open the file to be printed.

2. On the File menu, select Print.

3. Click Preferences (or Properties).

4. On the Color tab, select Graphic Pro, and then click Detail.
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5. Select Printer Simulation, and then use the list under Simulation Target Profile to 
select the ink characteristics you want to simulate.

6. Click OK.

7. Print.
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Spot Color Printing Setup
(QL-300s Only)

Printer Driver Spot Color Function List
This section explains the Spot Color toner functions in the printer drivers.
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Windows PCL Printer Driver
Click the Color tab to display the screen for setting the spot color toner.

Item Description

Usage Method Do not use Prints without using white 
toner.

Full page Uses white toner for the 
entire page being printed.

Data portion (Excluding 
white)

Uses white toner for all data 
parts that do not include 
white parts.

Data portion (Including 
white)

Uses white toner for all data 
parts that include white 
parts.

Printing only spot color toner Prints with white toner only.

Watermarks/Overlays Prints the selected 
watermark and overlay with 
white toner.

Spot color toner quantity 
adjustment

0 to 100 Adjusts the amount of white 
toner used while printing.
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Windows PS Printer Driver
Click the Color tab to display the screen for setting the spot color toner.

Item Description

Spot Color Do not use Prints without using white 
toner.

Full page Uses white toner for the 
entire page being printed.

Data portion (Excluding 
white)

Uses white toner for all data 
parts that do not include 
white parts.

Data portion (Including 
white)

Uses white toner for all data 
parts that include white 
parts.

Printing only spot color toner Prints with white toner only.

Application specification Allows you to specify white 
toner from the application.

Spot color toner quantity 
adjustment

0 to 100 Adjusts the amount of white 
toner used while printing.

Don’t layer white toner for 
100% black

Select whether to do 
overlaying on white toner 
when printing text or lines at 
100% black.
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Printing on Color Media

Usable Color Media
Use color media that satisfies the following conditions.

• Pigment or ink used to color the media heat-resistant to 230ºC

• E-photo printer media with the same characteristics as plain media

Printing Using White Toner Only
Printing text and illustrations using only white toner on color paper.

Before printing, check that the white print cartridge has been installed in the device, and that 
white toner has been selected using the printer drivers.

Note: If you specify “Print Only with Spot Color” and lift up all the other colors of cartridges, you 
can print with only spot colors, even if one of the black, cyan, magenta, or yellow print cartridges 
has reached the end of its service life.

Windows PCL Printer Driver
1. Open the file to be printed.

2. Select Page Setup in the File menu.

3. Select the paper size and print orientation, and then click OK.

4. Select Print in the File menu.

5. Click Preferences (or Properties).

6. Use Media Type to select the paper type.

7. Use Media Weight to select an appropriate value.

8. Click the Color tab.
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9. For Usage Methods, select Printing only spot color toner, and then click OK.

10. Click Print in the “Print” screen to print.

Windows PS Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).

4. Click the Color tab.

5. For Spot Color, select Printing only spot color toner, and then click OK.

6. Click Print in the “Print” screen to print.

Printing White Below a Color (Spot Color Overprint)
When printing on color paper, print a base with white toner, and then print in color on top of that.

Windows PCL Printer Driver
1. Open the file to be printed.

2. Select Page Setup in the File menu.

3. Select the paper size and print orientation, and then click OK.

4. Select Print in the File menu.

5. Click Preferences (or Properties).

6. Use Paper settings to select the paper type.

7. Click the Color tab.

8. For the Spot Color setting, select one of the following: Full page, Data portion 
(Excluding white), Data portion (Including white), or Watermarks/Overlays.
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9. Click OK.

10. Click Print in the “Print” screen to print.

Windows PS Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).

4. Click the Color tab.

5. For the Spot Color setting, select one of the following: Full page, Data portion 
(Excluding white), Data portion (Including white).

6. Click OK.

7. Click Print in the “Print” screen to print.

Adjusting the White Image from the Application
By adjusting the file from the application, the registration misalignment may not be noticeable. 
If the misalignment is not fixed after adjusting the position and size, adjust the white image with 
the application. Adobe Illustrator will be used as an example for the adjustment method.

1. Open the data with white misalignment.

2. Create a new layer. Name the layer “SpotColor”, and create this at the top.

3. Open the swatch window, and click the “New Swatch” button.

Enter SpotColor_White as its name, and select Spot Color for the color type.

Note: Please enter the name as given above. White toner will not be recognized if you 
make a mistake in the entries.

4. Copy the object to be filled with spot color white to the “SpotColor” layer.

5. Select the copied object, and set the fill to “SpotColor_White:100%” and the border to 
“SpotColor_White:0%”. For outlines, select Object > Path > Path Outline, and set the 
fill and border after it been changed to Object.

6. Open the attribute window, and select Overprint Fill and Overprint Stroke.

7. Select File > Print. Select the QL-300 printer.

8. Go to Advanced > Overprints, and select Simulate.

9. Click Setup.

10. Click Preferences.

11. On the Color tab, select Application specification in Spot Color.

12. Print.
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Printing by Using Applications to Specify Spot Color Toner 
(PS Printer Drivers Only)

Using Adobe Illustrator
This explanation uses Adobe Illustrator CC as an example.

Adding Swatches
If using Spot Color (white), specify the swatches added for the objects to be Spot Color printed.

1. Open the swatch panel, and select new swatch.

2. Enter SpotColor_White in Swatch Name.

3. Select Spot Color in Color Type.

Printing
If printing Spot Color, make the settings using the application print dialog box.

1. Click Advanced from the menu on the left of the print dialog box.

2. Select Simulate in Overprints.

3. Click Print.

Windows PS Printer Driver
1. Select Windows PS printer drivers, and click Preferences.

2. On the Color tab, select Application specification in Spot Color, and then click OK.

3. Print.

Using Adobe Photoshop
This explanation uses Adobe Photoshop CC as an example.

Adding Spot Color Channels
If using Spot Color (white), specify the Spot Color channels added for the objects to be Spot 
Color printed.

1. Open the channel panel, and select a new Spot Color channel.

2. Enter SpotColor_White in Name.

Saving in PDF Format
Spot Color printing directly from Adobe Photoshop is not possible, so initially save the file in 
PDF format.
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Printing
1. Open the file that has been saved in PDF format using Adobe Acrobat or Adobe Acrobat 

Reader.

2. Select File > Print to open the print dialog box.

3. Click Advanced.

4. Select Color from the menu on the left of the Preferences dialog box, and select 
Simulate overprint. (If using Adobe Acrobat Reader, click Advanced, and then select 
Simulate overprint.)

5. Click OK to return to the print dialog box.

Windows PS Printer Driver
1. Select Windows PS printer drivers, and click Preferences.

2. On the Color tab, select Application specification in Spot Color.

3. Print.

Fine-Tuning White Shading
Finely adjust the shade for each white highlight, dark, mid-tone gradation using the printer 
control panel.

Here, we will show the procedure for slightly darkening white highlights.

1. Press the scroll button ▲ or ▼.

2. Select Calibration, and press the OK button.
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3. Select White Tuning, and then press the OK button.

4. Select Highlight, and press the OK button.

5. Specify a value that is larger than the current set value, and then press the OK button. 
Confirm there is a check mark to the left of the specified value.

A larger value represents darkening, while a smaller value represents lightening.

6. Press the ON LINE button to return to the standby screen.
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Network Settings

Initializing Network Settings
Implementing this operation will initialize all network settings.

1. Press the scroll button ▼ several times to select Admin Setup, and then press the OK 
button.

2. Use the numeric keypad to input the administrator password.

The factory default password is 999999. Press the OK button after inputting each char-
acter.

3. Select Network Setup, and then press the OK button.

4. Select Network Factory Defaults, and then press the OK button.
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5. When Execute appears, press the OK button.

6. Initialization is executed, and the display returns to the standby screen.

Using DHCP
IP addresses can be acquired from a DHCP server.

PC administrator privileges are required for the setup.

Caution: Incorrectly allocating the IP address may cause major malfunctions such as crashing 
of the network. Thoroughly consult the network administrator before making the settings.

To use the device in a DHCP environment, select Auto as the IP address setting method.

Also note that Auto is the IP address setting method under factory default settings, so 
performing this procedure is normally not necessary.

1. Press the scroll button ▼ several times to select Admin Setup, and then press the OK 
button.

2. Use the numeric keypad to input the administrator password.

The factory default password is 999999. Press the OK button after inputting each char-
acter.



Network Settings

QL-300 User Guide 255
 

3. Select Network Setup, and then press the OK button.

4. Select IP Address Set, and then press the OK button.

5. Select Auto, and then press the OK button.

6. Press the ON LINE button to return to the standby screen.

Using BOOTP
To use the printer in a BOOTP environment, select BOOTP as the IP address setting method.

1. Access the printer web page and log in as an administrator.

See “Web Utility” on page 414.

2. Select Admin Setup.

3. Select Network Setup > TCP/IP > Change Settings > Get IP address automatically 
(BOOTP).
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4. Click Submit.

IPv6
This printer is compatible with IPv6, and the IPv6 address is acquired automatically. IPv6 
addresses cannot be set manually.

The device is compatible with the following protocols.

Printing:

• LPR

• IPP

• RAW (Port9100)

• FTP

Setup:

• HTTP

• SNMPv1/v3

• Telnet

Checking the IPv6 Address
IPv6 addresses are allocated automatically.

1. Access the printer web page and select Device information.

Note: Refer to “Web Utility” on page 414 regarding the printer web page.

2. Select Network > TCP/IP.

If all the global addresses are displayed as “0”, it is possible an error has occurred in the 
router being used.

Press the scroll buttons to select Print Information > Configuration to check the IPv6 
address using the configuration report. For reports and information about how to print 
them, see “Printing Configuration Information” on page 257.
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Viewing Machine Information

Printing Configuration Information

Printable Report List

• Paper is cut at a fixed length when printing a report, so do not use die-cut label paper.

List Name Description

Configuration Prints the table of all menu category items 
and the current settings. Further, the 
advanced printer settings are also printed in 
the page header.

Demo Page Prints the demo print data stored in the 
printer.

File List Prints the file list.

Usage Report Prints the total print results.

Error Log Prints the errors detected and saved by the 
printer.

Color Profile List Prints the color profile list.

Color Adjustment Pattern Prints the patterns to match the shading 
characteristics.

User Media List Prints the user media list.

Test Print-1 Prints the patterns for analyzing the print 
quality.

Test Print-2 Prints the patterns for analyzing CYMK print 
quality.

Test Print-3 Prints the patterns for analyzing the status 
of the print cartridges.

Test Print-4 Prints the patterns for analyzing print quality 
of the spot colors.
Displayed with QL-300 only.

Cleaning Page Prints the toner-free white sheet to remove 
dirt from the surface of the fuser belt in the 
fuser unit.
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• To attain the full benefit of the report printing function, load paper that is 130 mm wide.

• Printing is canceled if a print cartridge for a color that is required for report printing is not 
lifted down.

Printing Printer Setup Lists

Configuration
Print the device information.

Print to see the remaining quantity of wear items and other set values such as IP addresses 
and MAC addresses, and to check whether the printer is operating correctly, etc.

1. Press the Fn key.

The numerical values input screen will be displayed.

2. Press 1, 0, 0 (function numbers), and then press the OK button.
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3. Confirm that Execute is selected, and then press the OK button.

Printing result sample:
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Printing Printer Information Lists

Demo Page
Prints demonstration pages.

1. Press the scroll button ▼ several times, and when Print Information appears, press the 
OK button.

2. Select Demo Page, and then press the OK button.

3. When DEMO1 appears, select one of the items to be printed, and then press the OK 
button.

4. Confirm that Execute is selected, and then press the OK button.
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Error Log
Prints the history of the errors that have occurred in the device.

1. Press the Fn key.

The numerical values input screen will be displayed.

2. Press 1, 0, 3 (function numbers), and then press the OK button.

3. Confirm that Execute is selected, and then press the OK button.

Usage Report
Prints the total print results.

Note: Not displayed if Usage Report of Print Statistics is set to Disable.

1. Press the Fn key.

The numerical values input screen will be displayed.
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2. Press 1, 0, 2 (function numbers), and then press the OK button.

3. Confirm that Execute is selected, and then press the OK button.

4. Use the numeric keypad or the scroll buttons to specify the number of copies, and then 
press the OK button.

Printing Print Lists

Color Profile List
Prints the table of the ICC profiles registered on the printer.

1. Press the scroll button ▼ several times, and when Print Information appears, press the 
OK button.
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2. Select Color Profile List, and then press the OK button.

3. Confirm that Execute is selected, and then press the OK button.

User Media List
Prints the table of the user media registered to the device.

Note: Displayed when the user media is registered.

1. Press the scroll button ▼ several times, and when Print Information appears, press the 
OK button.

2. Select User Media List, and then press the OK button.
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3. Confirm that Execute is selected, and then press the OK button.

Test Print
Prints the print quality lists.

• Test Print-1 - Prints the patterns for analyzing the print quality.

• Test Print-2 - Prints the patterns for analyzing CMYK print quality.

• Test Print-3 - Prints the patterns for analyzing the status of the print cartridges.

• Test Print-4 Prints the patterns for analyzing print quality of the spot colors (white). 
Displayed with QL-300s only.

1. Press the scroll button ▼ several times, and when Print Information appears, press the 
OK button.

2. Select Test Print-1, Test Print-2, Test Print-3, or Test Print-4, and then press the OK 
button.
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3. When Execute appears, press the OK button.

Changing the Administrator Password
Change the administrator password. The factory default setting is 999999.

1. Press the scroll button ▼ several times to select Admin Setup, and then press the OK 
button.

2. Enter the administrator password, and then press the OK button.

3. Select Change Password, and then press the OK button.
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4. Enter the new password, and then press the OK button.

Specify a password that is at least six characters long.

5. Re-enter the new password, and then press the OK button.

6. Press the ON LINE button to return to the standby screen.

Checking the Print Count
You can check the quantity of paper printed from the unwinder to date.

1. Press the scroll button ▼ several times to select Configuration, and then press the OK 
button.
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2. Select Feeder Count, and then press the OK button.

3. Select the feeder you want to check.

4. Press the OK button.

5. Press the ON LINE button to return to the standby screen.
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Troubleshooting

Troubleshooting Solutions Procedure
This chapter describes the procedure for solving problems that occur while using the printer.

If you are unable to solve the problem with this procedure, contact Technical Support.

Troubleshooting when an error message is displayed
1. If a paper jam error appears, refer to “Paper Jams” on page 268.

2. If a message about the replacement schedule or service life of wear items appears, refer 
to “Messages about Replacing Wear Items” on page 299.

3. If other errors appear, refer to “Messages about Other Issues” on page 301.

4. If you cannot solve the problem, record the message displayed on the control panel. 
Contact Technical Support.

Troubleshooting when an error message is not displayed
1. If trouble occurs, refer to the following pages for solutions.

• “Unable to Print” on page 308

• “Printer Driver Malfunctions” on page 313

• “Print Quality Is Poor” on page 315

• “Paper Feed Is Poor” on page 327

2. If you cannot solve the problem, contact Technical Support.

Paper Jams
This section describes the procedure when paper is jammed inside the printer, when part of a 
piece of paper that is being removed is left inside the printer, or when paper is left inside the 
printer because an error occurred and caused printing to stop.

Condition of paper

• Unload - Indicates that the paper is not set on the F0 roller on the unwinder.

  F0
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• Stand-by - Indicates that paper is set on F0 roller on the unwinder.

• Through paper - Indicates that paper is passing through the printer from the unwinder.

Checking Messages (if a paper jam occurs)
When paper is jammed inside the printer, or when paper is remaining inside the printer even 
after removing it, a message notifying paper jam will appear on the display screen of the control 
panel, and the ATTENTION lamp will blink. Or, when an error occurs causing printing to stop 
and leaves paper inside the printer, an error notification message appears on the display 
screen on the control panel, and the ATTENTION lamp blinks.

When “Please see HELP for details” is shown in the message, pressing the HELP button in the 
control panel will show the troubleshooting procedure, and you can easily solve the process 
according to the guidance. See “Operating the Help Screen” on page 271.

1. Display screen

2. HELP button

3. ATTENTION lamp

  F0

  F0

1

2

3
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The following table shows the messages. Check the message, and remove the jammed paper 
according to the procedure described in the reference.

Category
Message displayed on the 

display screen
Error code displayed after 
pressing the HELP button

Paper jam
(When paper is jammed inside the 
printer)

Open Unwinder Cover
Paper Jam
Please see HELP for details

391

Open Top Cover
Paper Jam
Please see HELP for details

380
381

Check Fuser and Exit Unit
Paper Jam
Please see HELP for details

382

Remove Paper
Printing Page Lost
Please see HELP for details

389

Check Fuser Unit
Paper Feed Jam
Please see HELP for details

386

Message does not disappear
(When the message does not 
disappear even after removing the 
jammed paper)

Open Unwinder Cover
Paper Remain
Please see HELP for details

631

Open Top Cover
Paper Remain
Please see HELP for details

637
638

Check Fuser and Exit Unit
Paper Remain
Please see HELP for details

639
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Note: Error code 389 may appear when there is no paper left inside. If it appears when there 
is no paper jam, open and close the top cover to clear it. If error code 389 appears many times, 
or if it does not clear, contact Technical Support.

Operating the Help Screen
Pressing the HELP button in the control panel will display the solution method. You can easily 
remove the paper according to the guidance.

Example: When paper is jammed inside the printer

When paper is left inside the printer 
because an error occurred and the 
printer stopped

Paper Detection Error
%SENSOR_ERROR%
Please see HELP for details

7381

Open Unwinder Cover
Roll Paper End
Please see HELP for details

7311

Change Paper in Unwinder
Roll Paper End
Please see HELP for details

7310

Check Installed Paper
Mark Detection Error
Please see HELP for details

7306

Paper Feed Error
Please see HELP for details

7319
7372

Check Paper
Roll Paper Slack Winding Error
Please see HELP for details

7314

Check Paper
Roll Paper Set Sensor Error
Please see HELP for details

7315

Category
Message displayed on the 

display screen
Error code displayed after 
pressing the HELP button
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The following message will appear on the display screen, and the ATTENTION lamp will blink.

1. Press the HELP button.

The error code will appear and the condition of paper jam will be displayed.

2. Press the scroll button ▼.

The next page will appear, and solution procedure for paper jam will be displayed.

Press the scroll button ▲ to return to the previous page.
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3. Scroll the pages of the Help screen with the scroll buttons, and remove the paper 
according to the solution procedure for the paper jam displayed on the screen.

Removing the jammed paper will return the display to the Standby screen and the 
remaining printing will start.

Removing Jammed Paper
Use the following instructions to remove jammed paper. This procedure can be used to resolve 
error codes 380, 381, 382, 386, 389, 391, 631, 637, 638, 639, 7381, 7310, 7306, 7319, 7372, 
7311, 7314, and 7315.

1. Use scissors to cut the jammed paper.

For labels, cut in the space between labels. If the paper is feeding, cut it on the output 
side too.
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2. Lower the unwinder cover open lever to open the unwinder cover.

Note: Securely open the unwinder cover so it does not close while cleaning.
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3. Turn the roll paper holder in the direction of the arrow to wind up the roll paper.

4. Raise the cutter unit lock levers at both ends of the cutter unit.
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5. Raise the F0 roller release lever.

If any paper is left in the printer, do not forcefully remove it.

6. Grasp the top cover open lever and open the top cover.
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7. Remove the print cartridge set.

8. Place the removed print cartridge set on a flat surface covered with newspaper or 
something similar, and cover it with paper so it is not exposed to direct light.
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9. Turn the two belt locking keys counterclockwise to release the lock.
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10. Hold the belt unit handles (blue) on the left and right, and remove the belt unit at an angle.

Caution: Be careful not to spill waste toner while removing the belt unit.

Caution: Be careful to not pinch your hands or fingers between the handle and the 
machine while removing the belt unit.

Caution: When removing the belt unit, do not tilt it further than is needed to remove it.
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11. Place the belt unit with the right side down on a flat surface covered with paper.

Caution: Place the belt unit on a flat surface, as shown in the diagram above. Do not 
stand it on its side.

Caution: Do not touch the belt surface or damage the belt.
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12. Pull up the paper guide release lever.

13. While the paper guide release lever is lifted, slide the paper guide in the direction of the 
arrow to remove it.
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14. If any paper is jammed, pull it out in the direction of the arrow.

There may be some unfused toner on the paper.

Caution: Be careful, the fuser unit is very hot immediately after printing.

15. If paper is being output from the printer, use scissors to cut it between two labels.



Troubleshooting

QL-300 User Guide 283
 

16. While pulling the fuser and exit unit locking lever towards you, pull out the fuser and exit 
unit.
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17. While supporting the fuser and exit unit with one hand, lift up the fuser unit handle.
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18. Hold the fuser and exit unit with both hands and remove it to a level spot.

Caution: Be careful, the fuser unit is very hot immediately after printing.

19. Slowly pull the paper straight out so it does not overlap.



Troubleshooting

QL-300 User Guide 286
 

20. Lower the release lever of the fuser and exit unit, open the exit feed cover and put the 
fuser unit handle below the exit feed cover.
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21. Slowly pull out the paper that is left in the fuser and exit unit in the direction of the arrow.

22. Close the exit feed cover.

23. Lift the fuser and exit unit with both hands and put it into the printer.
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24. Push down the fuser unit handle, and firmly push it inside.
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25. Lift up the fuser and exit unit locking lever.
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26. Raise the blue lever in the unwinder, and then remove the cutter unit.

Be careful that the cutter unit does not hit the sensor cover (upper) when removing it.
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27. Check for any paper or paper dust that has accumulated in the cutter unit, and remove 
any that has accumulated.

28. Remove any paper that is left in the paper feed path in the unwinder.
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29. Raise the blue lever and install the cutter unit.
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30. Align the positions of the paper guide’s edge (1) and the guide notch on the printer.
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31. Firmly push the paper guide all the way in the direction of the arrow, and then push on 
the A position to lock it.
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32. Tilt the belt unit and align the arrow labels (red) on the belt unit and printer to position it, 
and then open the belt unit handles (blue) on the left and right.

Caution: Be careful to not pinch your hands or fingers between the handle and the 
machine while installing the belt unit.
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33. Turn the two belt unit locking keys clockwise to lock it.

34. Put the print cartridge set back into the printer.

Caution: There is a risk of pinching your fingers or hands when repositioning the print 
cartridge set. Hold the handle parts of the basket for this operation.

35. Close the top cover.

Caution: When closing the top cover, there is a risk of pinching your fingers or hands in 
the top cover or the top cover’s support. Press on the top of the top cover to close it.

Caution: There is a risk of pinching your fingers or hands if you hold the LED head while 
closing the top cover. Press on the top of the top cover to close it.
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36. Lower the F0 roller release lever.

37. Lower the cutter unit lock levers at both ends of the cutter unit.
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38. Close the unwinder cover.

Caution: There is a risk of pinching your fingers or hands while closing the unwinder 
cover. Press on the top of the unwinder cover to close it.

Frequent Paper Jams
Check the following when paper jam occurs very frequently.

• Are the paper feeding components dirty? See “Cleaning the Inside of the Printer” on page 
379.

• Is the roll paper guide set correctly?

• Are you using paper that is compatible with the printer?

• Are there any fragments of paper remaining inside the printer?

• Is there glue on it?

• Are the sensor positions abnormal? See “Calibrating the Sensor” on page 104.

Messages about Paper
When paper type/size set in the unwinder differs from the printer driver specification, 
messages, such as “Change paper”, will appear, and the ATTENTION lamp will blink.

Messages related to paper and error codes, cause of errors and their resolutions, and status of 
the ATTENTION lamp is described below.
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Besides, when “Please see HELP for details” is shown in the message, pressing the HELP 
button in the control panel will show the solution procedure, and you can easily solve the 
process according to the guidance. See “Operating the Help Screen” on page 271.

Messages about Replacing Wear Items
When the scheduled replacement of wear items approaches, or when the replacement 
becomes necessary, messages, such as “ABC Near End of Life” and “Install New ABC / ABC 
Life”, will appear, and the ATTENTION lamp will start blinking.

Messages related to replacement of wear items and error codes, cause of errors and their 
resolutions, and status of the ATTENTION lamp are described below.

Besides, when “Please see HELP for details” is shown in the message, pressing the HELP 
button in the control panel will show the solution procedure, and you can easily solve the 
process according to the guidance. See “Operating the Help Screen” on page 271.

Category
Message displayed on the 

display screen Error code
ATTENTION 

lamp
Causes and 

Troubleshooting

Change paper Change paper in Unwinder
Press UNLOAD or OK 
Button
Please see HELP for details

461 Blinking The paper settings for the 
unwinder are different from 
the print driver 
specifications.
To cancel printing, press the 
CANCEL button. If multiple 
errors occur, you may not be 
able to cancel printing.
Press the HELP button, and 
solve according to the 
guidance shown on the Help 
screen.

Empty Install paper in Unwinder
Please see HELP for details

491 Blinking Paper has run out.
Load paper that is the size 
displayed.
To cancel printing, press the 
CANCEL button. If multiple 
errors occur, you may not be 
able to cancel printing.
Press the HELP button, and 
solve according to the 
guidance shown on the Help 
screen.

Open Unwinder Cover
Roll Paper End
Please see HELP for details

7311 Blinking Paper has run out.
Open the unwinder cover, 
and remove the cut paper 
end.
Press the HELP button, and 
solve according to the 
guidance shown on the Help 
screen.



Troubleshooting

QL-300 User Guide 300
 

Meanings of the symbols used in the error messages are as follows.

• [COLOR]: Either yellow, magenta, cyan, black, or white* appears.

*: White appears only for the QL-300s

Category
Message displayed on the 

display screen Error code
ATTENTION 

lamp
Causes and 

Troubleshooting

Print cartridges Install New [COLOR] Print 
Cartridge
Print Cartridge Life
Please see HELP for details

4100, 
4101, 
4102, 
4103, 
4104, 
4140, 
4141, 
4142, 
4143, 
4144, 
5600, 
5601, 
5602, 
5603, 
5604, 
6800, 
6801, 
6802, 
6803, 6804

Blinking The lifespan of the print 
cartridge has been reached.
Press the HELP button, and 
solve according to the 
guidance shown on the Help 
screen.
See “Replacing Print 
Cartridges” on page 334.

Belt Unit Install New Belt Unit
Belt Unit Life
Please see HELP for details

355 Blinking The lifespan of the belt unit 
and 2nd transfer roller has 
been reached.
Press the HELP button, and 
solve according to the 
guidance shown on the Help 
screen.
See “Replacing the Belt Unit 
and 2nd Transfer Roller” on 
page 338.

Fuser and exit 
unit

Install New Fuser and Exit 
Unit
Fuser and Exit Unit Life
Please see HELP for details

354 Blinking The lifespan of the fuser and 
exit unit has been reached.
Press the HELP button, and 
solve according to the 
guidance shown on the Help 
screen.
See “Replacing the Fuser 
and Exit Unit” on page 359.
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Messages about Other Issues
Other messages and error codes, cause of errors and their resolutions, and status of the 
ATTENTION lamp are described below.

Besides, when “Please see HELP for details” is shown in the message, pressing the HELP 
button in the control panel will show the solution procedure, and you can easily solve the 
process according to the guidance. See “Operating the Help Screen” on page 271.

• Meanings of the symbols used in the error messages are as follows.

– [COLOR]: Either yellow, magenta, cyan, black, or white* appears.

*: White appears only for the QL-300s

– [MENUCOLOR] : Y,M,C,K (QL-300) / Y,M,C,K,W (QL-300s)

– [COVER]: Either top cover or unwinder cover is displayed.

– [ERRCODE]/ [CODE]: Detailed numbers of the error are displayed.

Waste Toner 
Box

Install New Waste Toner Box
Waste Toner Full
Please see HELP for details

357 Blinking Waste toner is full.
If you re-set and use a 
waste toner box that is 
already used, there is a risk 
of the waste toner 
overflowing, so please 
replace it with a new waste 
toner box.
Press the HELP button, and 
solve according to the 
guidance shown on the Help 
screen.
See “Replacing Waste Toner 
Boxes” on page 348.

Category
Message displayed on the 

display screen Error code
ATTENTION 

lamp
Causes and 

Troubleshooting

Message displayed on 
the display screen Error code ATTENTION lamp

Causes and 
Troubleshooting

Close Cover
[COVER]

310, 589 Blinking The cover shown in the 
message is open.
Close the cover.

Power Off/On
[ERRCODE]:Error

- Blinking A fatal error has 
occurred.
Restart the printer.
If 188 appears in 
[ERRCODE], check the 
condition of the 
unwinder’s installation.

Service Call
[ERRCODE]:Error

-
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Print Cartridge Not 
Installed
[COLOR]
Please see HELP for 
details

6940, 6941, 6942, 6943, 
6944

Blinking The print cartridge is not 
installed properly.
Press the HELP button, 
and solve according to 
the guidance shown on 
the Help screen.

Check Print Cartridge
[COLOR]
Please see HELP for 
details

3400, 3401, 3402, 3403, 
3404

Blinking Print cartridge has not 
been set correctly.
Install the print cartridge 
correctly.

Invalid Print Cartridge 
Order
Set to [MENUCOLOR]

7382 Blinking The print cartridge is not 
installed in the correct 
position.
Reset in the order that is 
displayed in the display 
screen.

Unnecessary Print 
Cartridge Error
The job was cancelled. 
Check the position of the 
print cartridge lift up lever.
To turn off the display, 
press the OK button
Please see HELP for 
details

7390, 7391, 7392, 7393, 
7394, 7395, 7396

Blinking The Lift Up Lever of the 
print cartridge is not in the 
correct position.
Printing was stopped and 
the print data was 
deleted.
Press the HELP button, 
and solve according to 
the guidance shown on 
the Help screen.

The job was canceled 
due to a spot color order 
mismatch
To turn off the display, 
press the OK button
Please see HELP for 
details

7385 Blinking Printing was stopped and 
the data was deleted 
because the spot color 
settings were different 
from those specified in 
the printer driver.
Press the OK button to 
delete the display on the 
display screen.
Press the HELP button, 
and solve according to 
the guidance shown on 
the Help screen.

Message displayed on 
the display screen Error code ATTENTION lamp

Causes and 
Troubleshooting
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The job was canceled 
due to a paper width 
mismatch
To turn off the display, 
press the OK button
Please see HELP
for details

7386 Blinking Printing was stopped and 
the data was deleted 
because the paper width 
settings were different 
from those specified in 
the printer driver.
Press the OK button to 
delete the display on the 
display screen.
Press the HELP button, 
and solve according to 
the guidance shown on 
the Help screen.

Press the OK Button for 
Restoration Memory 
Overflow

420 Blinking Cannot print. Printing 
data has exceeded the 
memory capacity of the 
printer.
Select a lower Quality of 
the printer driver and print 
once again.
Press the OK button to 
delete the display on the 
display screen.

Resume Print from
Page xxx/xxx
Press the OK Button
Please see HELP for 
details

502 Blinking Printing can be resumed.
Press the OK button to 
print the rest of the 
pages.
To cancel printing, press 
the CANCEL button.

Non Genuine Print 
Cartridge[COLOR]
Please see HELP for 
details

6840, 6841, 6842, 6843, 
6844

Blinking Print cartridge is not 
intended for use with this 
printer model.
Use a print cartridge 
intended for use in this 
model.

Incompatible Print 
Cartridge [COLOR]
Please see HELP for 
details

6900, 6901, 6902, 6903, 
6904, 7000, 7001, 7002, 
7003, 7004, 7040, 7041, 
7042, 7043, 7044, 6840, 
6841, 6842, 6843, 6844, 
7100, 7101, 7102, 7103, 
7104, 7200, 7201, 7202, 
7203, 7204

Blinking Print cartridge is not 
intended for use with this 
printer model.
Use a print cartridge 
intended for use in this 
model.

Message displayed on 
the display screen Error code ATTENTION lamp

Causes and 
Troubleshooting
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Non Genuine Fuser and 
Exit Unit
Please see HELP for 
details

6981 Blinking Fuser and exit unit is not 
intended for use with this 
printer model.
Use a fuser and exit unit 
intended for use in this 
model.

Incompatible Fuser and 
Exit Unit
Please see HELP for 
details

6982, 6983, 6984, 6985, 
6986, 6987

Blinking Fuser and exit unit is not 
intended for use with this 
printer model.
Use a fuser and exit unit 
intended for use in this 
model.

Non Genuine Belt Unit
Please see HELP for 
details

6881 Blinking Belt unit is not intended 
for use with this printer 
model.
Use a belt unit intended 
for use in this printer 
model.

Incompatible Belt Unit
Please see HELP for 
details

6882, 6883, 6884, 6885, 
6886

Blinking Belt unit is not intended 
for use with this printer 
model.
Use a belt unit intended 
for use in this printer 
model.

Receiving Data Timeout
Press the OK Button for 
Restoration
Please see HELP for 
details

519 Blinking A data receipt timeout 
occurred.
Increase the length of 
timeout print setting.

Check Data
Message Data Write
Error [CODE]

- - Failed to write the 
message data to be 
updated.
Check data.

Fuser and Exit Unit Not 
Installed
Please see HELP for 
details

699 Blinking The fuser and exit unit is 
not installed properly.
Press the HELP button, 
and solve according to 
the guidance shown on 
the Help screen.

Check Fuser and Exit 
Unit
Please see HELP for 
details

348, 320 Blinking The fuser and exit unit is 
not installed correctly.
Install the fuser and exit 
unit correctly.

Message displayed on 
the display screen Error code ATTENTION lamp

Causes and 
Troubleshooting
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Install Fuser and Exit Unit
Please see HELP for 
details

333 Blinking The fuser and exit unit is 
disconnected.
Press the HELP button, 
and solve according to 
the guidance shown on 
the Help screen.

A spot color printing error 
has occurred. Data will be 
erased.
Check the paper and 
paper settings, and try to 
print again.
To turn off the display, 
press the OK button.
Please see HELP for 
details

459 Blinking Because of a print 
request for paper 
unavailable to spot color 
printing, the printing has 
been stopped, and the 
data was deleted.
Check the paper and 
paper settings, and print 
again.
Press the OK button to 
delete the display on the 
display screen.

The data will be deleted 
due to a spot color order 
mismatch error.
Check the print cartridge 
position and spot color 
settings, and try to print 
again. To turn off the 
display, press the OK 
button
Please see HELP for 
details

7380 Blinking The position of the white 
print cartridge is different 
from that specified in the 
printer driver.
Printing has been 
stopped, and the data 
was deleted.
Check the order of the 
print cartridge and the 
Spot Color setting, then 
print once again.
Press the OK button to 
delete the display on the 
display screen.

Check Waste Toner Box
Please see HELP for 
details

331 Blinking The waste toner box is 
not set correctly.
Install the waste toner 
box correctly.

Firmware Update Error 
Please retry
If network doesn’t work, 
please try firmware 
update over USB

302 - Firmware update failed.
Follow the instructions in 
the message.

Feeder Unit Not Installed
Shut down and Install 
Feeder Unit

7305 Blinking The unwinder is not 
installed.
Turn off the power, and 
then install the unwinder.

Message displayed on 
the display screen Error code ATTENTION lamp

Causes and 
Troubleshooting



Troubleshooting

QL-300 User Guide 306
 

Belt Unit Not Installed
Please see HELP for 
details

689 Blinking The belt unit is not 
installed properly.
Press the HELP button, 
and solve according to 
the guidance shown on 
the Help screen.

Check Belt Unit
Please see HELP for 
details

330 Blinking The belt unit is not 
installed correctly.
Install the belt unit 
correctly.

Unnecessary Print 
Cartridge Error
Check the position of 
print cartridge lift up lever
Please see HELP for 
details

7398, 7399 Blinking The lift up lever of the 
print cartridge is not in the 
correct position.
Press the HELP button, 
and solve according to 
the guidance shown on 
the Help screen.

Install Paper Guide
Re-set the Paper Guide
Please see HELP for 
details

7384 Blinking The paper guide is not 
set correctly.
Press the HELP button, 
and solve according to 
the guidance shown on 
the Help screen.

Open Cover
Paper was pulled out

7312 Blinking Paper was forcefully 
extracted while being fed.
Open the cover and if 
there are scraps of paper, 
remove them, and then 
close the cover.

Check Installed Paper 
Edge
Paper Edge Long Error
Press the OK Button
Please see HELP for 
details

7308 Blinking The mark on the leading 
edge of the paper cannot 
be detected correctly.
Replace the paper, and 
then press the OK button.
Press the HELP button, 
and solve according to 
the guidance shown on 
the Help screen.

Message displayed on 
the display screen Error code ATTENTION lamp

Causes and 
Troubleshooting
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Paper Width Error
Press the OK Button
Please see HELP for 
details

7383 Blinking The paper currently being 
used is different from the 
paper settings in the 
printer driver.
Replace the paper, and 
then press the OK button.
Press the HELP button, 
and solve according to 
the guidance shown on 
the Help screen.

Check Installed Paper
Paper Edge Error
Press the OK Button
Please see HELP for 
details

7307 Blinking The mark on the leading 
edge of the paper cannot 
be detected correctly.
Replace the paper, and 
then press the OK button.
Press the HELP button, 
and solve according to 
the guidance shown on 
the Help screen.
The feed roller (F0) is 
worn and requires 
replacement. When this 
roller is in good condition 
and the roller is locked, 
media cannot be pulled 
out of the printer by hand.

Paper Detection Error
[SENSOR_ERROR]
Press the OK Button
[SENSOR_ERROR]: 
Detailed information of 
the error will be 
displayed.

7381 Blinking The paper sensor cannot 
correctly detect paper.
Paper setting is incorrect 
or the sensors are not 
set/adjusted. Or, the 
sensor is dirty.
There is paper left in the 
printer; remove it.
The feed roller (F0) is 
worn and requires 
replacement. When this 
roller is in good condition 
and the roller is locked, 
media cannot be pulled 
out of the printer by hand.

Wait a Moment
Rebooting %CODE%
It may take some time to 
complete this process.

- Lit The controller unit is 
rebooting.

Message displayed on 
the display screen Error code ATTENTION lamp

Causes and 
Troubleshooting
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Printing Problems
This section describes the possible issues that may occur while operating the printer, and their 
solutions.

Note: If the problem is not solved using the following methods, contact Technical Support.

Note: For problems arising from the applications, contact the application development 
company.

Unable to Print

Basic Reasons

Shutting down
Please wait. Printer will 
turn off automatically
It may take some time to 
complete this process.

- Off The printer is shutting 
down.

Message displayed on 
the display screen Error code ATTENTION lamp

Causes and 
Troubleshooting

Cause Solution Procedure

Power supply of the printer is switched off. Switch on the power supply.
See “Turning on the Power” on page 34.

Power supply was switched off due to the auto power 
off function.

Switch on the power supply.
When you do not want to use the auto power off 
function, disable it with Admin Setup > Power Setup 
> Auto Power Off in the control panel.

LAN Cable/USB Cable is disconnected. Check that cables are correctly connected to the 
printer and the computer.
See “Connecting Cables” on page 40.

Cables are defective. Replace with new cables.

Printer is offline. Press the ON LINE button on the control panel.

Error message has appeared on the display screen of 
the control panel.

Refer to the following information or press the HELP 
button on the control panel.
• “Messages about Paper” on page 298
• “Messages about Replacing Wear Items” on page 

299
• “Messages about Other Issues” on page 301

Interface settings are disabled. From Admin Setup > Network Setup on the control 
panel, enable the interface you are using.
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Network Connection Problems

USB Connection Problems

There is a problem with the print function. From Printer Information > Configuration > 
Execute on the control panel, check whether you can 
print the printer information or not.

This printer is not set as default printer. Set it to default printer.

Output port of printer driver is incorrect. Select the output port where LAN cable/USB cable is 
connected.

Printing from other interface is in progress. Wait until the printing is complete.

Cause Solution Procedure

Cause Solution Procedure

Cross cable is used. Arrange straight cable and hub, and connect correctly. 
See “Network Connection” on page 43.

Compatibility problem with hub. Select Admin Setup > Network Setup > Hub Link 
Setting from the control panel, and change the 
settings.

There is a problem with hub. Try inserting the network cable into another port or an 
empty port on the same hub. If the problem is still not 
solved, use a different hub.

Network cable is defective. Reconnect with a new or a different network cable, 
and check again.

Incorrect IP address. • Check that IP address settings of the printer, and IP 
address of the printer set in the computer are 
matching.

• Check that IP address is not the same as other 
devices.

• Check that correct address is set in IP address, 
Subnet mask, and Gateway address.

Duplicate IP address. Set an IP address for the printer that does not 
duplicate any other IP address.

Cause Solution Procedure

Cable does not meet the standards. Use USB cable of USB 2.0 specifications.

USB hub is used. Directly connect the printer to the computer.
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Printer Troubles

Printer driver is not installed correctly. Please re-install the printer driver. See “Driver 
Installation Process Overview” on page 39.

Printer is offline. Right click the QL-300 icon in the Devices and Printers 
folder, and then select See what’s printing. Select the 
Printer menu in the dialog displayed, and uncheck Use 
Printer Offline.

Switch, buffer, extension cable, and USB hub are 
used.

Directly connect the printer to the computer.

Another printer driver operated through USB 
connection is installed.

From the computer, remove other printer drivers.

Cause Solution Procedure

Symptom Cause Troubleshooting

Nothing is displayed in the display 
screen panel even after switching 
on the power supply.

Power supply cord is disconnected. Switch off the power supply, and 
firmly insert the power supply cord.
See “Connecting a Power Cord” on 
page 34.

Power outage. Check if electricity is flowing in the 
power socket.

Does not function. Power supply cord is not inserted 
firmly.

Firmly insert the power supply 
cord.
See “Connecting a Power Cord” on 
page 34.

Power supply is not switched on. Switch on the power supply.
See “Turning on the Power” on 
page 34.

LED lamp of the POWER button is 
blinking at high speed at about 0.3 
second interval.

The printer has broken down. Immediately pull the power plug out 
of the socket, and contact 
Technical Support.



Troubleshooting

QL-300 User Guide 311
 

Printing process does not start. Error is displayed. Check the error code, and follow 
the instructions displayed on the 
display screen.
• See “Messages about Paper” on 

page 298.
• See “Messages about Replacing 

Wear Items” on page 299.
• See “Messages about Other 

Issues” on page 301.

LAN Cable/USB Cable is not 
connected.

Firmly insert LAN Cable/USB 
Cable.

LAN Cable/USB Cable is defective. Use another LAN Cable/USB 
Cable.

LAN Cable/USB Cable does not 
meet the standards.

• Use a cable of USB 2.0 specifi-
cations.

• Use a cable of LAN Cable 1000 
BASE-T Specifications.

There may be a problem with the 
print function.

From Print Information > 
Configuration > Execute on the 
control panel, check whether you 
can print the printer information or 
not.

Interface is disabled. From Admin Setup > Network 
Setup on the control panel, enable 
the interface you are using.

Printer is not selected. Set the printer as the “Default 
Printer”.

Output port of printer driver is 
incorrect.

Specify the output port where LAN 
cable/USB cable is to be 
connected.

The tension bar is not locked. Lower the tension bar until it clicks. 
After that, open and close the 
unwinder cover.

Print data is not sent. LAN Cable/USB Cable is 
damaged.

Connect a new cable.

Computer had timed out. Increase the length of timeout.

Abnormal sound. Device is tilted. Install on a stable and a flat 
surface.

Symptom Cause Troubleshooting
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Resonant sound. While temperature inside the 
device has increased, printing is 
done on a narrow paper or a thick 
paper.

Device has not broken down. Use 
the device as it is.

A sound is heard from the cutter 
unit when cutting the paper.

Glue of the labels accumulated on 
the cutter blades inside the cutter 
unit or paper dust may make the 
blade rubbed and make a sound.

Clean the cutter unit.
See “Cleaning the Cutter Unit” on 
page 401.

Printing does not start immediately. Device is warming up to return 
from the power saving mode.

Please wait.
When you do not want to use 
Power Save mode, on the control 
panel, select Admin Setup > 
Power Setup > Power Save to 
disable the mode.

Cleaning of print cartridge may be 
in progress.

Please wait.

Temperature adjustment of the 
fuser unit is under progress.

Please wait.

Processing of data from other 
interface is in progress.

Wait until the printing is complete.

All the print data is being 
processed before printing starts.

Please wait.

Printing stops while printing. Adjusting colors or correcting 
density during continuous printing.

Please wait.

Not enough memory. Inadequate memory of the printer 
due to large printing data.

Lower the print quality in the printer 
driver, and then print.
See “Fine Quality Printing” on page 
186.

Slow printing. Printing process is also done at the 
computer side.

User a computer with fast 
processing speed.

Complicated print data. Select simple print data.

Symptom Cause Troubleshooting
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Trouble with Sensor Calibration

Printer Driver Malfunctions

USB Connection Problems

Symptom Cause Troubleshooting

Failure to calibrate sensor The sensor is out of position. Check the position of the sensor.
See “Confirming the Printer Sensor 
Position” on page 109.

The surface of the sensor cover is 
dirty.

Clean the surface of the sensor 
cover.
• See “Cleaning the Surfaces of 

the Unwinder” on page 368.
• See “Cleaning the Surfaces of 

the Printer” on page 378.

Last of the paper was detected 
while calibrating the sensor.

Replace the paper with a new roll 
of paper.

The information for the paper being 
used is not registered on the 
printer.

Correctly register, on the printer, 
the information for the paper being 
used.

Symptom Solution Procedure

Icon of the printer is not created in the Devices and 
Printers folder.

Printer driver is not installed correctly.
See “Driver Installation Process Overview” on page 
39.

Error message such as “Printer driver installation 
failed” appears.

Use plug and play. Follow the procedure given below.
1 Check that the power supply to the printer and 

computer are turned off.
2 Connect the USB cable.
3 Turn on the power supply of the printer.
4 Turn on the power supply of the computer.
5 Open the Devices and Printers screen from Control 

Panel, and then click Add a printer.
6 Execute the setup according to the on-screen 

instructions.
Specify the following location to directly specify the 
printer driver. \Drivers\PCLXL
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Trouble when Setting up Printing

Symptom Solution Procedure

A few seconds of waiting time occurs if you switch 
from another printer to the QL-300, using the printer 
settings in an application.

These symptoms occur when there are many types of 
paper registered in the printer driver. If you want to 
reduce this waiting time, delete the paper settings that 
you do not need from the printer driver.
See “Registering a Desired Paper Size with the Printer 
Driver” on page 78.

Printing is being done in specified batches, even 
though they have not been specified.

For some applications, batch copies may be specified 
automatically if a number of copies have been 
specified in the print settings on the application.
To solve this, manually turn off the batch settings that 
were turned on automatically in the application.
See “Collating Printed Output (Sorted Printing)” on 
page 203.

The setting for printing multiple copies does not 
appear on the control panel of the printer, even though 
the setting for multiple copies is specified in printer 
settings in the printer driver or the application.

When you specify to print multiple copies in the printer 
driver or application, some applications generate print 
data for all of the copies to be printed.
When this type of data is being printed, the printer 
cannot recognize that you have specified multiple 
copies to be printed, so the indicator for printing 
multiple copies does not appear on the control panel. 
You can use the printer as it is, because all the copies 
that you specified will be printed.

The final printout is not cut, even though Cut by 
collation or To specify the number of pages per cut 
is specified in the Cut Mode settings in the printer 
driver, although the setting for collate is specified in 
the printer settings in the printer driver or the 
application.

When you specify to collate printouts in the printer 
driver or application, some applications reorder the 
pages in collated order, and then generate print data 
for all of the copies to be printed.
When this type of data is being printed, the printer 
cannot recognize that the printout is being collated, so 
the indicator for collated printing does not appear on 
the control panel. In addition, the final printout is not 
cut, even though Cut by collation or To specify the 
number of pages per cut is specified in the Cut Mode 
settings in the printer driver.
Even if the application is suitable, when you want to 
cut collated printouts, specify the pages in To specify 
the number of pages per cut so they match the 
pages being collated.
Furthermore, if you can only specify a number of 
pages that is a multiple of that in To specify the 
number of pages per cut because the paper is short, 
you need to edit the print data, such as by adding 
blank pages, so it has a number of pages that can 
coincide with the number specified in To specify the 
number of pages per cut.
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Problems Concerning Restrictions of Windows OS

Print Quality Is Poor

Items Symptom Causes and Troubleshooting

Printer driver The User Account Control dialog 
appears.

When starting installer or utility, the 
User Account Control dialog may 
appear. Click Yes or Go, and run 
installer or utility as administrator. 
Clicking No or Cancel will not start 
installer or utility.

Images are being printed in an 
incorrect layout when doing “Print 
Test Page”.

Occurred because Windows OS is 
creating print information that is 
larger than the paper settings that 
are set in the printer driver.
Operation is not abnormal.

Symptom Cause Troubleshooting

White stripe in perpendicular 
direction.

Paper feed direction

LED head is unclean. Wipe LED head with a soft tissue 
paper.
See “Cleaning LED Heads” on 
page 397.

Low toner. Replace the print cartridge.
See “Replacing Print Cartridges” 
on page 334.

Deposit of foreign substances. Replace the print cartridge.
See “Replacing Print Cartridges” 
on page 334.

Window film on print cartridge is 
dirty.

Wipe window film with a soft tissue 
paper.
See “Cleaning LED Heads” on 
page 397.

Print cartridge has not been set 
correctly.

Please set the print cartridge 
correctly.
See “Cleaning LED Heads” on 
page 397.
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Printing is blurred in perpendicular 
direction.

Paper feed direction

LED head is unclean. Wipe LED head with a soft tissue 
paper.
See “Cleaning LED Heads” on 
page 397.

Low toner. On the control panel, set +1 to +3 
in SMR Setting. If the problem is 
not rectified after that, replace the 
print cartridge.
There is a risk of the printouts 
being dirty if you continue using the 
+1 to +3 setting in SMR Setting.
See “Replacing Print Cartridges” 
on page 334.

The toner is clumping. Shake the print cartridge up and 
down, and left and right.
See “Replacing Print Cartridges” 
on page 334.

Paper not suitable. Check the roll paper specifications, 
and then use paper that is 
described on the roll paper 
specifications.

The temperature and humidity 
controls are not suitable.

On the control panel, set +1 to +3 
in SMR Setting.
There is a risk of the printouts 
being dirty if you continue using the 
+1 to +3 setting in SMR Setting.

Symptom Cause Troubleshooting
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Printing is light. Print cartridge has not been set 
correctly.

Re-install the print cartridge.
See “Replacing Print Cartridges” 
on page 334.

Low toner. Replace the print cartridge.
See “Replacing Print Cartridges” 
on page 334.

Paper is moist. Use paper that has been stored at 
appropriate temperature and 
humidity.

Paper not suitable. Check the roll paper specifications, 
and then use paper that is 
described on the roll paper 
specifications.

Paper not suitable.
Type and thickness setting of paper 
is inappropriate.

Correct Media Weight in the 
control panel to the appropriate 
value. Or, change Media Weight to 
a thicker value than the present 
value.

Recycled paper is used. Correct Media Weight in the 
control panel to the appropriate 
value. Or, change Media Weight to 
a thicker value than the present 
value.

Symptom Cause Troubleshooting
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Printing is blurred in some parts. 
White dots appear when printing 
solid colors.

The paper is too damp or too dry. Use paper that has been stored at 
appropriate temperature and 
humidity.

Transfer Setting is not properly 
set.

If white dots appear in cyan 
transfer, lower the setting value by 
selecting Print Adjust > Transfer 
Setting > Cyan Transfer Setting 
on the control panel.
If white dots appear in other colors’ 
transfer, change the transfer 
setting value of the corresponding 
color.

Media Transfer Setting Black or 
Media Transfer Setting Color is 
not properly set.

On the control panel, change the 
value in Print Adjust > Media 
Transfer Setting Black or Media 
Transfer Setting Color.

There are scratches, dents or 
foreign matter (including glue from 
labels) on the belt unit.

Replace the belt unit.
Implement protection against 
foreign matter and do daily 
maintenance (cleaning).
See “Replacing the Belt Unit and 
2nd Transfer Roller” on page 338.

Stripes in perpendicular direction.

Paper feed direction

There are dents on the print 
cartridge.

Replace the print cartridge.
See “Replacing Print Cartridges” 
on page 334.

Low toner. Replace the print cartridge.
See “Replacing Print Cartridges” 
on page 334.

The transfer path or the fuser and 
exit unit are dirty because bits of 
paper or glue are on them.

Clean the transfer path and the 
fuser and exit unit.
See “Cleaning the Inside of the 
Printer” on page 379.

Symptom Cause Troubleshooting
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The front or rear edge of the paper 
is dirty.

Paper feed direction

The 2nd transfer roller is dirty. Run Print Adjust > Transfer 
Roller Cleaning on the control 
panel.
If it is not rectified even after that, 
replace the 2nd transfer roller.
Replacement of the 2nd transfer 
roller is done together with the belt 
unit, which is a wear item.
See “Replacing the Belt Unit and 
2nd Transfer Roller” on page 338.

The area around the 2nd transfer 
roller or the paper transfer path is 
dirty.

Wipe the area around the roller on 
the 2nd transfer roller and the 
paper transfer path with a soft 
tissue paper.
See “Cleaning the Inside of the 
Printer” on page 379.

Image disturbance occurs to the 
printed portion.

The speed of the fuser unit is 
incorrect.

Feed 400 mm of media or longer 
one time.

Symptom Cause Troubleshooting
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Stripes or dots appear periodically 
in horizontal direction.

Paper feed direction

In the case of a cycle length of 
about 94 mm, the print cartridge 
may be scratched or dirty.

Wipe it lightly with a soft tissue 
paper.
If there are dents, replace the print 
cartridge.
See “Replacing Print Cartridges” 
on page 334.

Set Smooth in Screen for the print 
quality settings in the printer driver.

In the case of cycle length of about 
31 mm, there is dirt inside the print 
cartridge.

Replace the print cartridge.
See “Replacing Print Cartridges” 
on page 334.

In the case of cycle length of about 
140 mm, there are scratches on 
the fuser and exit unit.

Replace the fuser and exit unit.
See “Replacing the Fuser and Exit 
Unit” on page 359.

Print cartridge is exposed to light. Return the print cartridge inside the 
printer, and do not use the printer 
for a few hours. If it does not rectify 
even after that, replace the print 
cartridge.
See “Replacing Print Cartridges” 
on page 334.

In the case of cycle length of about 
63 mm, the feed roller is dirty.

Clean the feed roller.
See “Cleaning the Inside of the 
Printer” on page 379.

In the case of cycle length of about 
75 mm, 2nd transfer roller may be 
dirty.

Run Print Adjust > Transfer 
Roller Cleaning on the control 
panel.
If it is not rectified even after that, 
replace the 2nd transfer roller.
Replacement of the 2nd transfer 
roller is done together with the belt 
unit, which is a wear item.
See “Replacing the Belt Unit and 
2nd Transfer Roller” on page 338.

Dirt has deposited on the paper 
transfer path.

Print a few pages as a test Or, 
clean the transfer path.
See “Cleaning the Inside of the 
Printer” on page 379.

Symptom Cause Troubleshooting
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Portion of white background is 
lightly stained.

Paper has static electricity. Use paper that has been stored at 
appropriate temperature and 
humidity.

Thick paper is used. Use thinner paper.

Low toner. Replace the print cartridge.
See “Replacing Print Cartridges” 
on page 334.

Border of characters is blurred. LED head is unclean. Wipe LED head with a soft tissue 
paper.
See “Cleaning LED Heads” on 
page 397.

Paper not suitable. Check the roll paper specifications, 
and then use paper that is 
described on the roll paper 
specifications.

Paper is moist. Replace with new paper.

Rubbing paper removes the toner. Type and thickness setting of paper 
is inappropriate.

Correct Media Weight in the 
control panel to the appropriate 
value. Or, change Media Weight to 
a thicker value than the present 
value.

Recycled paper is used. Correct Media Weight in the 
control panel to the appropriate 
value. Or, change Media Weight to 
a thicker value than the present 
value.

Specks appear on glossy papers. Type and thickness setting of paper 
is inappropriate.

Correct Media Weight in the 
control panel to the appropriate 
value. Or, change Media Weight to 
a thicker value than the present 
value.

Symptom Cause Troubleshooting
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Bold lines appear in horizontal 
direction.

Paper feed direction

Type and thickness setting of paper 
is inappropriate.

If a line is printed from the second 
page with black & white print, set 
the Media Weight to an 
appropriate value from the control 
panel. Or, change Media Weight to 
a thicker value than the present 
value.

Occurs when the following edge of 
the paper leaves the F4 roller, if it is 
77 mm from the following end of 
the paper.

Bold lines or thin lines may occur 
on media similar to cast coated 
paper (stiff media or media on 
yellow separators). Use 
recommended paper.

Occurs due to the different levels of 
the gap between labels, if it occurs 
periodically at labels.

Bold lines or thin lines may occur 
on media similar to cast coated 
paper (stiff media or media on 
yellow separators). Use 
recommended paper.

Occurs when paper has been 
loaded for a long time, at the F0 
roller, if it is about 40 mm from the 
leading edge of the paper.
Glossy media is more sensitive to 
this artifact. This artifact can occur 
in less than one hour.

When media is pinched in F0 roller, 
streaks appear, stiff media 
becomes curled, and images may 
be affected. After printing, remove 
the paper. Also, always remove the 
paper if you will not use the 
equipment for a long time.

Lateral-stripe white dots appear at 
the solid printing portion.

Transfer Setting is not properly 
set.

If white dots appear in cyan 
transfer, lower the setting value by 
selecting Print Adjust > Transfer 
Setting > Cyan Transfer Setting 
on the control panel.
If white dots appear in other colors' 
transfer, lower the transfer setting 
value of the corresponding color.

Media Transfer Setting Black or 
Media Transfer Setting Color is 
not properly set.

On the control panel, decrease the 
value set in Print Adjust > Media 
Transfer Setting Black or Media 
Transfer Setting Color.

Border of the solid printing portion 
is lightly stained.

Paper is too dry. Use paper that has been stored at 
appropriate temperature and 
humidity.

Media Transfer Setting Black or 
Media Transfer Setting Color is 
not properly set.

On the control panel, increase the 
value set in Print Adjust > Media 
Transfer Setting Black or Media 
Transfer Setting Color.

Symptom Cause Troubleshooting
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The back of the paper is dirty. The 2nd transfer roller is dirty. Confirm that the size of the image 
and the length of the paper match.
Clean the 2nd transfer roller.
See “Cleaning the Inside of the 
Printer” on page 379.

Does not print with color shades as 
you thought.

Low toner. Replace the print cartridge.
See “Replacing Print Cartridges” 
on page 334.

Setting of Black Finish is not 
matching with the application.

In the Black Finish of printer 
driver, select True Black (K) or 
Composite Black (CMYK).

Change color matching options. Change to color matching option of 
the printer driver.

No color balance. Select Calibration on the control 
panel, and then run Adjust 
Density.

Misalignment of color. Open the top cover at once, and 
the close it again.
Select Calibration on the control 
panel, and then run Adjust 
Registration.

Black spots or white spots appear. Paper not suitable. Check the roll paper specifications, 
and then use paper that is 
described on the roll paper 
specifications.

In the case of a cycle length of 
about 94 mm, the print cartridge 
may be scratched or dirty.

Gently wipe the dirt stuck to the 
brown tube in the print cartridge 
with a soft tissue paper.
If there are dents, replace the print 
cartridge.
See “Replacing Print Cartridges” 
on page 334.

Stains are printed. Paper is moist. Replace with a new paper.

Paper not suitable. Check the roll paper specifications, 
and then use paper that is 
described on the roll paper 
specifications.

The surface of the roller in the feed 
path is dirty.

If foreign matter is found on the 
surface of the roller in the feed 
path, remove the dirt with a soft 
cloth or tissue paper.

Symptom Cause Troubleshooting
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The entire paper is printed black. The device might have broken 
down.

Contact Technical Support.

Nothing is printed. The device might have broken 
down.

Contact Technical Support.

White spaces occur. Paper is moist. Replace with a new paper.

Paper not suitable. Check the roll paper specifications, 
and then use paper that is 
described on the roll paper 
specifications.

Scraps of paper from the labels are 
stuck to the belt unit.

Replace the belt unit.
The belt unit is replaced together 
with the 2nd transfer roller, which is 
a wear item.
See “Replacing the Belt Unit and 
2nd Transfer Roller” on page 338.
Implement protection against 
foreign matter and do daily 
maintenance (cleaning). Or, check 
the cutting position; if it has shifted, 
readjust the cutting position.

If it is near the leading edge of the 
roll paper, it may be the remains of 
the tape that has peeled off the roll 
paper.

Cut off the end part of the paper 
that has any tape left on it, and do 
not use that paper.

Afterimages are appearing.

Paper feed direction

The print quality setting is not 
appropriate.

Set Smooth in Screen for the print 
quality settings in the printer driver.

Symptom Cause Troubleshooting

?



Troubleshooting

QL-300 User Guide 325
 

Blank pages are being inserted. An image that is less than 4 inches 
long is being printed.

When setting User-defined paper 
in the printer driver, if you set less 
than 4 inches for the following, then 
a blank piece of paper will be 
inserted after cut pages when you 
print.
• For continuous paper, Paper 

length
• For die-cut labels, die-cut labels 

with black marks and continuous 
labels, Label length

• For continuous paper with black 
marks and continuous labels 
with black marks, Black mark 
interval

This occurs because an image that 
is shorter than the length of the 
paper that can be fed is printed; so 
it is a limit.

The position that printing starts on 
the leading edge is misaligned.

The belt has stretched Adjust the registration and execute 
paper interval detection before you 
start printing, and install the printer 
in a room that has humidity that is 
as stable as possible.

The gap interval between labels is 
different between each label.

Rolls of labels that have different 
intervals between labels cannot be 
used. Use rolls of labels that have 
regular intervals.

There is a join in the roll paper. If there is a join in the roll paper, the 
position that printing starts on the 
leading edge may be 
misaligned.We cannot recommend 
media that has joins.

The paper size specified in the 
printer driver is different from the 
paper size that is loaded.

Specify the correct paper size in 
the printer driver.

The black mark sensor position or 
gap sensor position is skewed.

For black marks, adjust the position 
of the sensor to the center of the 
black mark. For gaps, adjust the 
position of the sensor to the center 
of the label.

Symptom Cause Troubleshooting
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The position that printing starts on 
the leading edge is misaligned.

(The first page is misaligned)
The paper and media form that you 
are using have been switched.

Do fine adjustments to the print 
position.
Set Cut Mode-Specified 
Interval-Cut Interval to “1”. Then 
print 5 pages of your content on the 
media you are actually using and 
use them to measure the 
differences in the position you want 
to print and the actual printed 
positions, and then calculate the 
average of these 5 measurements.
Use this difference to finely adjust 
the print position using the print 
position correction (Y position).

(The second and following pages 
are misaligned)
Immediately after doing paper 
interval detection, replacing the roll 
of paper, or changing the print 
pattern, the print position 
adjustment (auto) was not done 
well enough.

Print 20 continuous pages of the 
actual print pattern you are using 
(set Cut Mode-Specified 
Interval-Cut Interval to “20”) so you 
can compensate for the position 
that printing starts.

Printing extends off the trailing 
edge of the paper.

The paper size specified in the 
printer driver is different from the 
paper size that is loaded.

Specify the correct paper size in 
the printer driver.

The compensation value specified 
for the print position correction (Y 
position) is too large.

Specify a correction value that is 
within a range that the printing 
does not extend off the trailing 
edge of the paper.
If the image extends off the trailing 
edge of the paper, clean the 2nd 
transfer roller.

Pages are cut on a different page 
than the specified page.

Last of the paper was detected. Replace the paper with a new roll 
of paper. When reprinting, paper is 
output from the page where the 
error occurred up to the cut page. 
So, if you want to justify the 
number of pages up to the cut, 
temporarily cancel printing and 
send print data starting from the 
page you want to reprint.

Symptom Cause Troubleshooting
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Paper Feed Is Poor

There is an abnormality in the print 
results on the Test Page.

You are printing image data that is 
an inappropriate size.

The layout of the image skews in 
the printed results when you do the 
Print Test Page from the printer 
driver, depending on the type of OS 
that you are using.
This is not a problem with the 
printer driver or the equipment. It is 
caused by the OS transmitting the 
images on A4 or letter size paper, 
which are paper sizes that the 
device does not support.

Symptom Cause Troubleshooting

Symptom Cause Troubleshooting

Paper jam occurs frequently. Device is tilted. Install on a stable and a flat 
surface.

The paper feed path is dirty. Clean the paper feed path.
See “Cleaning the Inside of the 
Printer” on page 379.

Position of the roll paper guide is 
not aligned.

Align the roll paper guide to the 
position of the paper size that is 
set.

Papers are not set correctly. Remove the roll paper and reset.

The position of the roll paper is 
misaligned.

Remove the roll paper and reset it, 
and then turn the roll paper position 
adjustment dial to adjust the 
position.

The leading edge of the paper is 
curled. Or, the paper that is loaded 
does not have cuts in the gaps 
between the labels.

Correctly cut the leading edge of 
the paper and reset it.
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Paper jam occurs frequently. Printer driver sensor settings are 
not specified correctly.

Specify Sensor settings in Paper 
settings of the printer driver so it is 
the same as where the results of 
the sensor calibration are 
registered.
Furthermore, if several of the same 
model printer are connected to a 
single computer and if the same 
paper settings are specified on the 
printer driver for the various 
printers, then in Sensor settings 
the same registration number 
should be specified for all the 
printers.
Register the sensor adjustment 
results from each printer so they 
match the Sensor settings 
numbers that are in the paper 
settings on the printer driver as the 
above countermeasures.

The width of the paper being used 
and the width of the paper guide do 
not match. Or, the paper width set 
in the printer driver and the width of 
the paper being used do not match.

Use paper that is as wide as the 
paper width that is set in the printer 
driver.
Align the width of the paper guide 
to the width of the paper you are 
using.

An appropriate paper is not set. Match the settings of the paper on 
which you want to print with the 
settings in the printer driver. Do a 
sensor calibration for the paper on 
which you want to print.

There are traces of sealing tape on 
the roll paper that is being used.

Do not use the part of the roll paper 
on which there are traces of 
sealing tape. Feeding may not be 
normal because of the glue stuck 
to the paper.

Symptom Cause Troubleshooting
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Paper jam occurs frequently. The positions of the machine and 
the unwinder sensors do not 
match.

Align the position of the sensor with 
the paper.

Labels are missing from the roll of 
paper that is being used.

Load a suitable roll of paper.
If the cause described on the left is 
correct, there may be toner on the 
fuser unit, so you should clean it.

Only when paper feed is started by 
pressing the FEED button
Stiff continuous labels are being 
used (or, die-cut labels that are 
longer than 600 mm).

Fold the media about 200 mm from 
the leading edge of the media 
(liner) to make a crease that forms 
a valley in the printed face, and 
then feed the paper.

The roll of paper is old so its color 
or quality has changed.There are 
large differences in the 
reflectiveness of the black marks or 
the transmittance of the liner.

Calibrate the sensor.

Paper is not fed. The paper settings for the printer 
are different from the paper 
settings in the printer driver.

Check the message on the display 
screen, and if there is no problem, 
press the OK button on the control 
panel.

Glue has smeared on the liner. Do not use a liner on which glue is 
smeared. It will not feed normally. 
In the worst case, it could damage 
the equipment.

Device is not restored even after 
removing the jammed paper.

Open the top cover at once, and 
the close it again.

Paper gets curled. Creases appear 
on the paper.

Paper contains moisture or static 
electricity.

Use paper that has been stored at 
appropriate temperature and 
humidity.

Thin paper is used. Correct Media Weight in the 
control panel to the appropriate 
value. Or, change Media Weight to 
a thicker value than the present 
value.

Paper winds around the roller of 
the fuser and exit unit.

Type and thickness setting of paper 
is inappropriate.

Correct Media Weight in the 
control panel to the appropriate 
value. Or, change Media Weight to 
a thicker value than the present 
value.

Thin paper is used. Use thicker paper.

Symptom Cause Troubleshooting
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The space between labels is not 
cut; the labels are cut.

The position of the cut is 
misaligned.

Readjust the cutting position.

The leading edge of the label and 
the black mark positions are not 
aligned.

Labels cannot be used if the 
leading edge of the label and the 
black mark positions do not align. 
Use labels whose leading edges 
align with the black mark.

The gap interval between labels is 
different between each label.

Rolls of labels that have different 
intervals between labels cannot be 
used. Use rolls of labels that have 
regular intervals.

The gap interval between labels is 
not from 3 to 10 mm.

A gap between labels from 3 to 10 
mm can be used. Do not use any 
others.

The paper size specified in the 
printer driver is different from the 
paper size that is loaded.

Specify the correct paper size in 
the printer driver.

Paper has stopped feeding. Last of the paper was detected 
during warm up while paper was 
feeding.

Replace the paper with a new roll 
of paper.

Paper is not fed, even when the 
FEED button is pressed.

Last of the paper was detected 
while feeding paper.

Replace the paper with a new roll 
of paper.

Paper is not unloaded, even when 
the UNLOAD button is pressed.

Last of the paper was detected 
while unloading paper.

Replace the paper with a new roll 
of paper.

The rear edge of the paper is 
skewed.

Paper is not set on the roll shaft. Replace the paper with a new roll 
of paper.

Symptom Cause Troubleshooting
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Replacing Wear Items

Checking Service Life and Remaining Amounts of Wear 
Items

You can check the service life and remaining quantities of the print cartridge, belt unit, fuser and 
exit unit, and waste toner box.

1. Press the scroll button ▼ several times to select Configuration, and then press the OK 
button.

2. Select Supplies Life, and press the OK button.

3. Select the wear items to check (print cartridge, belt unit, fuser and exit unit, or waste toner 
box).
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4. Press the OK button.

If you want to continue to check other items, press the BACK button to return to the 
previous step.

5. Press the ON LINE button to return to the standby screen.

Replacing Wear Items
This section describes the service life and replacement method of wear items.

About the Service Life of Wear Items
Guidelines for replacement of wear items are as follows. Service life estimates are for 
reference. The actual service life will vary based on label design, usage status, powering on/off, 
and adjustment operations.

Wear item Approximate service life

Print Cartridge (CMYK) 52,200 linear inches at 20% toner density.
Print quality will decline one year after 
opening the package.
Monochrome printing (black and white) is 
possible even if cyan, magenta, or yellow 
cartridge life has been reached. See 
“Monochrome (Black and White) Printing” 
on page 237.
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Toner density is the proportion of area having toner on printable area of 1 page.

When the Replacement Period Is Approaching
When the scheduled replacement of wear items approaches, the following message will appear 
and the ATTENTION lamp will blink.

Replace wear items when “Install New...“ appears in the message.

Pressing the HELP button on the control panel will display the replacement procedure. You can 
easily replace the wear items according to the guidance. See “Operating the Help Screen” on 
page 271.

Print Cartridge (W)
The white print cartridge is for the QL-300s 
only.

26,100 linear inches at 20% toner density.
Print quality will decline one year after 
opening the package.
CMYK printing is possible even if the white 
cartridge life has been reached. See 
“Printing Using the Specified Print Cartridge 
Only (Lift Up)” on page 184.

Belt Unit 2,610,000 linear inches at 5% toner density.

2nd Transfer Roller 2,610,000 linear inches at 5% toner density.
The 2nd transfer roller is included in the belt 
unit, which is a wear item.

Fuser and Exit Unit 870,000 linear inches.

Waste Toner Box 435,000 linear inches at 5% toner density.

Paper Guide/Feed Unit 5,800,000 linear inches.

Cutter Unit (Unwinder) 1,000,000 cuts.

F0 Roller Unit (Unwinder) 5,800,000 linear inches.

Wear item Approximate service life

Item

Message displayed on the display screen

When the replacement period 
approaches When it is time for replacement

Print cartridges
See “Replacing Print Cartridges” 
on page 334.

[COLOR]*1 Print Cartridge Near 
End of Life

Install New [COLOR]*1 Print 
Cartridge
Print Cartridge Life
Please see HELP for details

Belt Unit
See “Replacing the Belt Unit and 
2nd Transfer Roller” on page 338.

Belt Unit Near Life Install New Belt Unit
Belt Unit Life
Please see HELP for details
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*1: [COLOR]: Either yellow, magenta, cyan, black, or white is displayed. (White appears only 
for the QL-300s.)

Replacing Print Cartridges

Precautions Related to Print Cartridge Replacement

Fuser and exit unit
See “Replacing the Fuser and Exit 
Unit” on page 359.

Fuser Unit Near End of Life Install New Fuser and Exit Unit
Fuser and Exit Unit Life
Please see HELP for details

Waste Toner Box
See “Replacing Waste Toner 
Boxes” on page 348.

Waste Toner Near Full Install New Waste Toner Box
Waste Toner Full
Please see HELP for details

Item

Message displayed on the display screen

When the replacement period 
approaches When it is time for replacement

Symbol Warning

Do not put toner or print cartridges in fire. The toner may spray out 
and cause burns.

Do not store print cartridges in locations exposed to open flame. They 
could ignite, burn, and cause burn injuries.

Do not clean spilled toner with a vacuum cleaner. If cleaning spilled 
toner with a vacuum cleaner, it may catch fire due to the sparks from 
electric contact. Toner spilled on the floor should be wiped up with a 
wet cloth.

Symbol Caution

Some parts inside the machine are very hot. Do not touch the areas 
near the “High Temperature Warning” labels. Doing so may cause 
burns.

Keep the print cartridges away from children.

If toner is ingested, follow the direction from a doctor if necessary.

If toner is inhaled, gargle with plenty of water and move to a location 
where the air is fresh. Follow the direction from a doctor if necessary.
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Replacing Print Cartridges
The following example describes how to replace the yellow (Y) print cartridge. Adjust the 
procedure based on the print cartridge you are replacing.

1. Grasp the top cover open lever and open the top cover.

If toner gets on your hands or skin, carefully wash it off with soapy 
water.

If toner gets into your eyes, flush them with large amount of water. 
Follow the direction from a doctor if necessary.

Be careful to not get toner on your clothes or hands when you are 
clearing paper jams or replacing the print cartridges. If toner gets on 
your hands or skin, carefully wash it off with soapy water.
If it gets on your clothes, rinse it off with cold water. If you wash them 
with warm water or heat the toner, it will stain the clothes permanently.

Do not disassemble or forcibly open the print cartridge. It may scatter 
the toner, which people may inhale or may stain clothes and hands.

Store used print cartridges in a bag so that the toner does not scatter 
around.

Toner spilled on the floor should be carefully wiped up with a wet cloth 
so the toner does not scatter around.

Gently wipe the dirt stuck to the brown tube in the print cartridge with a 
soft tissue paper.
Do not use alcohol or other solvents to wipe it. If alcohol or some other 
solvent is used to wipe it, the irregularities left from wiping it will 
degrade print quality.

Symbol Caution
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2. Check the position of the print cartridge to replace, by the text and color of the label.

3. Pull out the print cartridge.
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4. Remove the new print cartridge from the packing bag, and then shake it vertically and 
horizontally.

5. Check the position where a label with the same text and colors has been applied, and 
firmly and levelly push the print cartridge in as far as it will go.
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6. Close the top cover.

Caution: When closing the top cover, there is a risk of pinching your fingers or hands in 
the top cover or the top cover’s support. Press on the top of the top cover to close it.

Caution: There is a risk of pinching your fingers or hands if you hold the LED head while 
closing the top cover. Press on the top of the top cover to close it.

If the Print Cartridge Life message does not disappear even though you have replaced 
the print cartridge, the print cartridge may not be securely installed. Install it correctly.

If Error709 appears after you replace a print cartridge, refer to “Messages about Other 
Issues” on page 301.

7. Please support the recycling of used print cartridges.

If you must dispose of a used print cartridge, put it in a plastic bag and be sure to dispose 
of it according to the local laws and government regulations.

Use the box and packing bag from the new print cartridge to recycle the used print 
cartridge.

Replacing the Belt Unit and 2nd Transfer Roller
A new 2nd transfer roller is supplied with the new belt unit in the same package.

Also, a new waste toner box is mounted inside the belt unit.

1. If roll paper has been fed through the printer, press the UNLOAD button to cut the roll 
paper.

The cut paper will be fed to the supply side and the feeding side.
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2. Grasp the top cover open lever and open the top cover.

3. Remove the print cartridge set.

4. Place the removed print cartridge set on a flat surface covered with newspaper or 
something similar, and cover it with paper so it is not exposed to direct light.



Replacing Wear Items

QL-300 User Guide 340
 

5. Turn the two belt locking keys counterclockwise to release the lock.
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6. Hold the belt unit handles (blue) on the left and right, and remove the belt unit at an angle.

Caution: Be careful not to spill waste toner while removing the belt unit.

Caution: Be careful to not pinch your hands or fingers between the handle and the 
machine while removing the belt unit.

Caution: When removing the belt unit, do not tilt it further than is needed to remove it.
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7. Place the belt unit with the right side down on a flat surface covered with paper.

Caution: Place the belt unit on a flat surface, as shown in the diagram above. Do not 
stand it on its side.

Caution: Do not touch the belt surface or damage the belt.
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8. Hold the 2nd transfer roller unit (1) knob (blue) and remove it.

9. Remove the 2nd transfer roller from its packaging.
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10. Set the new 2nd transfer roller (1) into the printer.

Note: Do not touch the roller part (sponge part) of the 2nd transfer roller. Touching it 
damages the surface of the roller, which degrades print quality.

Caution: Be careful, the fuser unit is very hot immediately after printing.
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11. Remove the new belt unit from its packaging.

Caution: Do not touch the belt surface or damage the belt.
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12. Tilt the belt unit and align the arrow labels (red) on the belt unit and printer to position it, 
and then open the belt unit handles (blue) on the left and right.

Caution: Be careful to not pinch your hands or fingers between the handle and the 
machine while installing the belt unit.

Note: When the belt unit is replaced, the waste toner box is also replaced at the same 
time.
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13. Turn the two belt unit locking keys clockwise to lock it.

14. Put the print cartridge set back into the printer.

Caution: There is a risk of pinching your fingers or hands when repositioning the print 
cartridge set. Hold the handle parts of the basket for this operation.

15. Close the top cover.

Caution: When closing the top cover, there is a risk of pinching your fingers or hands in 
the top cover or the top cover’s support. Press on the top of the top cover to close it.

Caution: There is a risk of pinching your fingers or hands if you hold the LED head while 
closing the top cover. Press on the top of the top cover to close it.

16. Please support the recycling of used belt units and 2nd transfer rollers.

Caution: You cannot clean the belt unit yourself. To protect the equipment against dirt 
and foreign matter, do daily maintenance (cleaning) as described in “Cleaning Schedule” 
on page 367. Also, do not use alcohol or other solvents to wipe the surfaces. If alcohol or 
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some other solvent is used to wipe it, the irregularities left from wiping it will degrade print 
quality.

Caution: Do not disassemble the belt unit and the waste toner box, and do not force 
them open. Doing so may cause toner to spray out, to be inhaled, or to soil your clothing 
and hands.

If you must dispose of a used belt unit or 2nd transfer roller, put them in a plastic bag and 
be sure to dispose of them according to the local laws and government regulations.

Use the box and packing bag from the new belt unit and 2nd transfer roller for when the 
used belt unit and 2nd transfer roller are recycled.

Replacing Waste Toner Boxes
1. Grasp the top cover open lever and open the top cover.
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2. Remove the print cartridge set.

3. Place the removed print cartridge set on a flat surface covered with newspaper or 
something similar, and cover it with paper so it is not exposed to direct light.
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4. Turn the two belt locking keys counterclockwise to release the lock.
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5. Hold the belt unit handles (blue) on the left and right, and remove the belt unit at an angle.

Caution: Be careful not to spill waste toner while removing the belt unit.

Caution: Be careful to not pinch your hands or fingers between the handle and the 
machine while removing the belt unit.

Caution: When removing the belt unit, do not tilt it further than is needed to remove it.
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6. Place the belt unit with the right side down on a flat surface covered with paper.

Caution: Place the belt unit on a flat surface, as shown in the diagram above. Do not 
stand it on its side.

Caution: Do not touch the belt surface or damage the belt.
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7. Remove the waste toner box from the back of the belt unit.
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8. Remove the new waste toner box from its packaging.

9. Insert the new waste toner box into the belt unit, and firmly push it inside.
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10. When facing the belt unit, hold the handles (blue) on its left and right sides.

 



Replacing Wear Items

QL-300 User Guide 357
 

11. Tilt the belt unit and align the arrow labels (red) on the belt unit and printer to position it, 
and then open the belt unit handles (blue) on the left and right.

Caution: Be careful to not pinch your hands or fingers between the handle and the 
machine while installing the belt unit.
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12. Turn the two belt unit locking keys clockwise to lock it.

13. Put the print cartridge set back into the printer.

Caution: There is a risk of pinching your fingers or hands when repositioning the print 
cartridge set. Hold the handle parts of the basket for this operation.

14. Close the top cover.

Caution: When closing the top cover, there is a risk of pinching your fingers or hands in 
the top cover or the top cover’s support. Press on the top of the top cover to close it.

Caution: There is a risk of pinching your fingers or hands if you hold the LED head while 
closing the top cover. Press on the top of the top cover to close it.
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15. Please support recycling of the used waste toner boxes.

Caution: Do not disassemble the waste toner box, and do not force it open. Doing so 
may cause toner to spray out, to be inhaled, or to soil your clothing and hands.

When disposing of the used waste toner box in unavoidable circumstances, put it in a 
plastic bag, and ensure to dispose according to the instructions provided by the local 
municipality.

Use the box and packing bag from the new waste toner box for when the used waste 
toner box is recycled.

Replacing the Fuser and Exit Unit

1. If roll paper has been fed through the printer, press the UNLOAD button to cut the roll 
paper.

The cut paper will be fed to the supply side and the feeding side.

Warning: There is a risk of burns.
Work carefully because the fuser and exit unit is very hot. Be sure 
to hold the fuser unit handle when you lift it. When it is hot, wait 
until it cools down before starting the work.
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2. While pulling the fuser and exit unit locking lever towards you, pull out the fuser and exit 
unit.
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3. While supporting the fuser and exit unit with one hand, lift up the fuser unit handle.
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4. Hold the fuser and exit unit with both hands to remove it.

5. Remove the new fuser and exit unit from its packaging.
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6. Pull the fuser and exit unit locking lever on the new fuser and exit unit towards yourself, 
and lift the fuser unit handle.

7. Lift the new fuser and exit unit with both hands and put it into the printer.
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8. Push down the fuser unit handle, and firmly push it inside.
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9. Lift up the fuser and exit unit locking lever.

10. Please support recycling of the used fuser and exit units.

Caution: Do not disassemble the fuser output unit, and do not force it open.

If you must dispose of the used fuser and exit unit, put it in a plastic bag and be sure to 
dispose of it according to the local laws and government regulations.

Use the box and packing bag from the new fuser and exit unit for when the used fuser 
and exit unit are recycled.
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Cleaning

Required Materials for Cleaning
Prepare the following things for cleaning the various parts of the printer.

• Clean, lint-free cloth

• Cleansing solvent/IPA (isopropyl alcohol)

• Water or neutral cleanser

• Screwdriver

• Tweezers

• Cotton swabs
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Cleaning Schedule
Check the condition of the equipment at the start and end of operations, and clean it as needed. 
Cleaning guidelines are noted below.

Cleaning schedule

Every day
When dirt is 
noticeable

Unwinder Surface No Yes

Flange Yes Yes

Side-Guide-8Inch No Yes

Tension Bar Yes Yes

Guide-Side-Roller-F Yes Yes

Paper Guide Yes Yes

Sheet Guide Yes Yes

Roll Paper Guide Yes Yes

F0 Roller Unit Yes Yes

Sensor Cover (Upper) Yes Yes

Sensor Cover (Lower) Yes Yes

F1 Roller Unit Yes Yes

Cutter Unit Yes Yes

Printer Surface No Yes

Paper Guide Yes Yes

Feed Unit Yes Yes

Sensor Cover (Lower) Yes Yes

Sensor Cover (Upper) Yes Yes

Exit Unit No Yes

LED Heads No Yes

Fuser Unit No Yes*



Cleaning

QL-300 User Guide 368
 

* Clean the feed path (including rollers) and fuser unit when changing the width of the roll paper. 
Streaks may appear when printing, particularly after changing the paper width from narrow to 
wide, because of the traces (paper dust etc.) left along the width of the paper.

When you change the width of the roll paper, check the conditions of the fuser unit and feed 
path and clean them, and then restart printing.

Cleaning the Unwinder
This section describes how to clean the various parts of the unwinder.

Cleaning the Surfaces of the Unwinder
Items to be prepared: Water or neutral washing agent, two sheets of soft, dry cloth

Note: Do not use Benzene or thinner as it may damage plastic parts and coating.

Note: Only use water or neutral washing agent.

Note: It is not necessary to oil the unwinder. Do not oil it.

1. Press and hold the POWER button for approximately 1 second to switch off the power 
supply.

Wait a moment, and the LED lamp on the POWER button will turn OFF.
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2. Take water or neutral washing agent on one piece of cotton cloth, and wipe with 
thoroughly squeezed cloth.

Furthermore, wipe off with another dry cotton cloth.

Cleaning the Inside of the Unwinder
1. Press and hold the POWER button for approximately 1 second to switch off the power 

supply.

Wait a moment, and the LED lamp on the POWER button will turn OFF.
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2. Press down the flange locking lever.

3. Remove the flange.
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4. Rotate the roll paper holder knob to narrow the axial diameter of the roll paper holder.

5. Remove the roll paper.
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6. Use a clean, lint-free cloth moistened with alcohol to wipe any dirt off the sides of the 
flange and Side-Guide-8Inch.

7. Mount the roll paper.

8. Press up on the tension bar open lever until it clicks.
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9. While restraining the tension bar with one hand, use a lint-free cloth moistened with 
alcohol to wipe, in one direction, the dirt off the tension bar (1).

Use the hand that is restraining the tension bar to rotate it (2) as you finish cleaning each 
side, until the entire tension bar is clean.

10. While rotating the guide-side-roller-F, use a lint-free cloth moistened with alcohol to wipe 
any dirt off the sides and corners of the guide-side-roller-F.

11. Press down on the tension bar open lever until it clicks.
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12. Lower the unwinder cover open lever to open the unwinder cover.

Note: Securely open the unwinder cover so it does not close while cleaning.
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13. If there are scraps of paper or glue from the labels on the sheet guide, use a lint-free cloth 
moistened with alcohol to wipe it off.

14. Use a lint-free cloth moistened with alcohol to wipe, in one direction, the dirt off the sheet 
guide.

15. Move the roll paper guide to confirm that there is no glue or paper scraps on it. If there 
are scraps of paper or glue from the labels on it, use a lint-free cloth moistened with 
alcohol to wipe it off.

16. If there are scraps of paper or glue from labels on the ends of the paper guide, undo the 
screw and remove the paper guide.
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17. Use a lint-free cloth moistened with alcohol to wipe the dirt off the sides of the paper guide 
(1) and ends of the sheet guide (2).

18. Install the paper guide and secure the screw.

19. Remove the screws, two places, for the F0 roller unit.

20. Remove the F0 roller unit.

21. As you rotate the gears with one hand, use a lint-free cloth moistened with alcohol to 
clean the top and bottom rollers on the F0 roller unit by wiping in just one direction.

Note: Lower the set lever on the rollers to rotate the top and bottom roller at the same 
time.
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22. Install the F0 roller unit, and fasten the two screws.

23. Use a lint-free cloth moistened with alcohol to wipe, in one direction, the dirt off the sensor 
cover (upper).

24. Use a lint-free cloth moistened with alcohol to wipe, in one direction, the dirt off the sensor 
cover (lower).

25. Close the unwinder cover.

Caution: There is a risk of pinching your fingers or hands while closing the unwinder 
cover. Press on the top of the unwinder cover to close it.
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Cleaning the Printer
This section describes how to clean the various parts of the printer.

Cleaning the Surfaces of the Printer
Items to be prepared: Water or neutral washing agent, two sheets of soft, dry cloth

Note: Do not use Benzene or thinner as it may damage plastic parts and coating.

Note: Only use water or neutral washing agent.

Note: It is not necessary to oil the device. Do not oil it.

1. Press and hold the POWER button for approximately 1 second to switch off the power 
supply.

Wait a moment, and the LED lamp on the POWER button will turn OFF.

2. Take water or neutral washing agent on one piece of cotton cloth, and wipe with 
thoroughly squeezed cloth.

Furthermore, wipe off with another dry cotton cloth.
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Cleaning the Inside of the Printer
1. Press and hold the POWER button for approximately 1 second to switch off the power 

supply.

Wait a moment, and the LED lamp on the POWER button will turn OFF.

2. Grasp the top cover open lever and open the top cover.
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3. Remove the print cartridge set.

4. Place the removed print cartridge set on a flat surface covered with newspaper or 
something similar, and cover it with paper so it is not exposed to direct light.
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5. Turn the two belt locking keys counterclockwise to release the lock.
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6. Hold the belt unit handles (blue) on the left and right, and remove the belt unit at an angle.

Caution: Be careful not to spill waste toner while removing the belt unit.

Caution: Be careful to not pinch your hands or fingers between the handle and the 
machine while removing the belt unit.

Caution: When removing the belt unit, do not tilt it further than is needed to remove it.
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7. Place the belt unit with the right side down on a flat surface covered with paper.

Caution: Place the belt unit on a flat surface, as shown in the diagram above. Do not 
stand it on its side.

Caution: Do not touch the belt surface or damage the belt.
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8. Pull up the paper guide release lever.

9. While the paper guide release lever is lifted, slide the paper guide in the direction of the 
arrow to remove it.
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10. Turn the paper guide over.

11. Use a lint-free cloth moistened with alcohol to wipe the dirt off the F4 roller, F3 roller, F2 
roller, and feed surface of the paper guide.

Caution: Do not touch the rollers (sponge areas) on the 2nd transfer roller.

Caution: Do not allow cloth or cotton swabs moistened with alcohol to touch the rollers 
(sponge areas) on the 2nd transfer roller.

Caution: Cleaning the rollers (sponge areas) on the 2nd transfer roller is prohibited. 
Touching or cleaning them could damage the surfaces of the rollers and affect print 
quality.

Caution: When you clean the rollers on the 2nd transfer roller, perform the 2nd transfer 
roller cleaning from the menu screen on the control panel (Print Adjust > Transfer 
Roller Cleaning). See “Menus” on page 152.

Caution: If the area around the 2nd transfer roller is dirty, clean it carefully without 
touching the rollers.
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12. If the rollers and feed surface of the feed unit on the bottom of the paper guide are dirty, 
gently wipe them clean with a lint-free cloth or cotton swabs moistened with alcohol.

Caution: Do not apply force to the sensor lever.

Caution: Rotate the rollers slowly.

Note: While rotating the F4 roller with one hand, hold a lint-free cloth against the F3 roller 
and F2 roller to wipe off any dirt on them.

Note: The F2 roller and the F3 roller are positioned in difficult to see locations. Use a 
mirror to check the insides before you clean them. Also, use a light to brightly illuminate 
the relevant areas; after checking their conditions, clean them.

13. Open the sensor cover.

14. Use a lint-free cloth moistened with alcohol to wipe, in one direction, the dirt off the sensor 
cover (lower and upper).
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15. While pulling the fuser and exit unit locking lever towards you, pull out the fuser and exit 
unit.
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16. While supporting the fuser and exit unit with one hand, lift up the fuser unit handle.
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17. Hold the fuser and exit unit with both hands and remove it to a level spot.

Caution: Be careful, the fuser unit is very hot immediately after printing.
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18. Lower the release lever and open the exit feed cover.

Note: If you take your hand off the exit feed cover, the exit feed cover will close.

Note: Do not remove your hand from the exit feed cover while you are cleaning.

Note: The inlet of the fuser unit may be stained by toner during use. However, this does 
not particularly affect printing.

19. Use a lint-free cloth moistened with alcohol to wipe the dirt off exit 1 roller/paper feed 
surface.
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20. Close the exit feed cover.

21. Use a lint-free cloth moistened with alcohol to wipe the dirt off exit 2 roller from the 
outside.

22. Lift the fuser and exit unit with both hands and put it into the printer.
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23. Push down the fuser unit handle, and firmly push it inside.
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24. Lift up the fuser and exit unit locking lever.
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25. Align the positions of the paper guide’s edge (1) and the guide notch on the printer.
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26. Firmly push the paper guide all the way in the direction of the arrow, and then push on 
the A position to lock it.
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27. Tilt the belt unit and align the arrow labels (red) on the belt unit and printer to position it, 
and then open the belt unit handles (blue) on the left and right.

Caution: Be careful to not pinch your hands or fingers between the handle and the 
machine while installing the belt unit.
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28. Turn the two belt unit locking keys clockwise to lock it.

29. Put the print cartridge set back into the printer.

Caution: There is a risk of pinching your fingers or hands when repositioning the print 
cartridge set. Hold the handle parts of the basket for this operation.

30. Close the top cover.

Caution: When closing the top cover, there is a risk of pinching your fingers or hands in 
the top cover or the top cover’s support. Press on the top of the top cover to close it.

Caution: There is a risk of pinching your fingers or hands if you hold the LED head while 
closing the top cover. Press on the top of the top cover to close it.

Cleaning LED Heads
Clean the LED heads if the print results are blurry, white stripes appear, or if text is bleeding.
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Clean the LED heads if the printed results show lengthwise white lines, if images are omitted 
lengthwise, or if there is bleeding around text. If the LED heads are dirty, it could cause a paper 
jam.

Caution: Do not use methyl alcohol or thinner. Doing so could damage the LED heads.

1. Press and hold the POWER button for approximately 1 second to switch off the power 
supply.

Wait a moment, and the LED lamp on the POWER button will turn OFF.

2. Grasp the top cover open lever and open the top cover.
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3. Check if the LED heads are dirty because toner or something is on them.

4. Lightly wipe the lenses of the LED heads with a clean, lint-free cloth.

Caution: Do not use methyl alcohol or thinner. Doing so could damage the LED heads.

5. Confirm that the dirt has been removed from the LED heads.
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6. Close the top cover.

Caution: When closing the top cover, there is a risk of pinching your fingers or hands in 
the top cover or the top cover’s support. Press on the top of the top cover to close it.

Caution: There is a risk of pinching your fingers or hands if you hold the LED head while 
closing the top cover. Press on the top of the top cover to close it.

Cleaning the Fuser Unit
This procedure describes how to clean the inside of the fuser unit.

Streaks may appear when printing, particularly after changing the paper width from narrow to 
wide, because of the traces (paper dust etc.) left along the width of the paper.

When you change the width of the roll paper, check the condition of the fuser unit and clean it, 
and then restart printing.

1. Set a roll of paper on the unwinder. Use continuous paper that is 5” wide. See “Loading 
Media” on page 92.

2. Press the scroll button ▲ or ▼.

3. Select Print Information, and press the OK button.
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4. Select Cleaning Page, and press the OK button.

5. Select Execute, and press the OK button. The printing for cleaning starts.

Dispose of the paper that you print during cleaning.

After cleaning is finished, remove the paper roll, load new paper, and start printing.

Cleaning the Cutter Unit
Do not dismantle any parts other than those specified in this procedure. Malfunctions could 
occur.

You should do daily maintenance to keep the machine in good condition as you use it. Check 
the condition of the machine when you start and stop using it, and clean it if needed.

Cleaning the Cutter Blades
Glue on the labels gradually accumulates on the cutter’s blades while cutting roll paper. This 
causes problems with cutting and feeding.

Glue is more likely to accumulate on the cutter’s blades when using continuous label paper 
(because the part being cut has glue on it). Clean the cutter’s blades periodically to prevent 
cutting and feeding problems from occurring.

There is no specified frequency for cleaning, it depends on the type of roll paper being used 
(liner/glue materials). If cutting or feeding problems occur, clean the cutter’s blades.
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• Always turn off the power to the printer and remove the power cord from the electric outlet 
before you start work.

• Use the specified tools for cleaning work.

• Do not touch the blades of the cutter with your bare hands. There is a risk of injury.

• Do not use any solvents other than alcohol or isopropyl alcohol.

• After cleaning, wipe the machine dry.

Prepare the following things to clean the cutter’s blades.

• Cleaning swab

• Wiping solvent (alcohol-based solvent)

• Flathead screwdriver

• Tweezers

• Soft cloth

The cleaning swabs and wiping solvent should be the recommended products. Contact 
Technical Support to purchase the recommended products.

1. Press and hold the POWER button for approximately 1 second to switch off the power 
supply.

Wait a moment, and the LED lamp on the POWER button will turn OFF.

2. Remove the power cord from the printer.

3. Remove the paper that is loaded in the unwinder.
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4. Lower the unwinder cover open lever to open the unwinder cover.

Note: Securely open the unwinder cover so it does not close while cleaning.
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5. Raise the cutter unit lock levers at both ends of the cutter unit.
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6. Hold the handle of the cutter to remove the cutter unit.

Note: Be careful that the cutter unit does not hit the sensor cover (upper) when removing 
it.
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7. Remove any paper left in the cutter unit.

If there is paper left inside the cutter unit after you have removed it, remove that paper.

8. Disassemble the cutter unit.

a. Use a flathead screwdriver to remove the 3 screws.
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b. Remove the F1 roller unit.

Hold the F0 roller unit.

Slide the F0 roller unit in the direction of the arrow.

Slide the F0 roller unit at an angle (arrow direction) and remove it.

Caution: There are blades inside the cutter unit for cutting roll paper. Do not touch 
the blades of the cutter with your hands. There is a risk of injury.
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9. Remove any paper left inside the cutter unit.

If there is paper left inside the cutter unit after you have disassembled it, use the tweezers 
to remove that paper.

10. Clean the blades of the cutter.

a. If there is glue stuck to the inside of the cutter unit, use the tweezers to remove as 
much as possible.

b. Clean the glue off the cutter blades.

There are two types of cutter blades; the spiral blade (rotating blade) and the 
straight blade (fixed blade).

Caution: There are blades inside the cutter unit for cutting roll paper. Do not touch 
the blades of the cutter with your hands. There is a risk of injury.
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c. Clean the fixed blade.

Apply alcohol solvent to a cleaning swab and press it against the straight blade 
(fixed blade) to remove glue stuck to the blade.

d. Clean the rotating blade.

Apply alcohol solvent to a cleaning swab and press it against the spiral blade 
(rotating blade) and move it back and forth as you manually turn the gears so the 
spiral blade faces towards the front so you can remove any glue stuck to the blade.

e. After cleaning the blades:

Confirm that there is no glue stuck to the blade of the cutter. If there is any glue 
remaining, clean the blades of the cutter again in the same way.

Confirm that there are no scraps or threads from the cloth left inside the blades of 
the cutter or the cutter unit. If there are any left, wipe the machine again.

After cleaning, wipe the machine dry.

11. Clean the F1 roller unit.

The F1 roller unit feeds paper through the cutter unit. When cleaning the cutter blades, 
check the surfaces of the top and bottom rollers of the F1 roller unit and clean them if 
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there is any glue, paper dust, or scraps of paper on the surfaces of the top and bottom 
rollers.

Rotate the gears with one hand and use your other hand to clean with a soft cloth to which 
alcohol-based solvent has been applied.

When wiping, wipe in one direction, and never wipe back and forth.

Lower the levers on both sides to rotate both the top and bottom rollers at the same time.

Cleaning the lower roller:

Cleaning the upper roller:
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12. Assemble the cleaned cutter unit.

Caution: There are blades inside the cutter unit for cutting roll paper. Do not touch the 
blades of the cutter with your hands. There is a risk of injury.

a. Assemble the F1 roller unit.

Hold the F0 roller unit and insert it at an angle (arrow direction).

Slide the F0 roller unit in the direction of the arrow.
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b. Use a flathead screwdriver to tighten the 3 screws.

13. Put the cutter unit into the unwinder.

a. Align the positions of the cutter unit lock levers on both ends of the cutter unit with 
the notches in the unwinder.
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b. Lower the cutter unit lock levers at both ends of the cutter unit.

14. Close the unwinder cover.
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Web Utility

Operating Environment
Computer with Microsoft Internet Explorer, Safari, Google Chrome, or Firefox installed

Computer running TCP/IP

Note: Check to make sure that the security setting of the web browser is MEDIUM.

Starting Up
1. Start up a web browser on your PC.

2. In the address bar, enter the following URL then press Enter: http://<printer IP address>/.

This displays the printer status screen.

If the IP address includes a one-digit or two-digit number, do not enter leading zeros. 
Doing so may cause communication problems.

Example: Correct: http://192.168.0.2/

Incorrect: http://192.168.000.002/

Logging in as an Administrator
To change printer settings using a web browser, you need to log in as a printer administrator.

1. Click Administrator Login.
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2. For Username enter “root”, for Password enter the current password, and then click OK.

The password is the same as the control panel “Administrator Password”. The factory 
default setting of the administrator password is 999999.

3. Specify the configuration information that can be checked on the network, and then click 
OK or SKIP.

Note: You can skip configuring settings by clicking SKIP.

Note: Selecting the Do not show this page again checkbox, and then clicking OK or 
SKIP will cause this page not to be displayed any more.

4. This will display the screen below.
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Item List
Appears for a person logged in as a printer administrator.

View Information

Item Description

Status Shows the current printer status. All warnings and errors 
generated by the printer are shown as “problem information”. You 
can also check the operational status of each network service, a 
configuration list, and the IP address assigned to the printer.

Tray Count Shows the print count.

Supplies Life Shows the remaining life of wear items.

Usage Report Shows usage reports.

Network Can be used to check general information, TCP/IP status, 
maintenance information, and other network-related setup 
information.

System Shows versions, memory capacity, flash memory capacity, and 
system related information.
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Print Information

Printer Menu

Item Description

Information Print Can be used to configure print and check information about the 
network, the font list, and other printer settings.

Item Description

General Printer 
Settings

Can be used to configure the printer name, asset number, 
installation location, and other printer settings.
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Admin Setup

Unwinder Config You can do settings related to the unwinder and the paper loaded 
in the unwinder.

Cutter Setup You can set the cutter operations and the cutting interval. Appears 
when the unwinder is mounted.

System Adjust Can be used to configure the power save time, and for clearing 
warnings, timeout printing, and other printer operations.

Print Adjust Can be used to configure print position adjustment, print quality, 
and to adjust other settings.

Unit of Measurement You can set the units that are displayed.

Item Description

Network Setup Can be used to configure TCP/IP and other protocol settings.

Print Setup Can be used to configure toner saving and other printer settings.

PCL Setup Can be used to configure PCL font and other PCL settings.

Color Setup Can be used to configure PostScript settings for the CMYK data 
conversion process and other color settings.

Management Can be used to configure the power setup, job cancel setup, and 
other printer settings.

Item Description
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Calibration

Links

Item Description

Normal Setting Adjusts the density of each color and other print quality settings.

Customize Menu Used to perform density and registration adjustment.

Item Description

Links Displays links configured by the administrator and links 
configured by the manufacturer.
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Changing an Administrator Password
You can use the procedure below to change the password for logging in to the printer as an 
administrator.

1. Click Admin Setup > Management.

2. Click Change Password.

Edit Links Allows administrator to set any URL. Up to five support links and 
five other links can be registered. Be sure to include http:// when 
entering the URL.

Item Description
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3. In New Password, enter the new password. In Verify Password, enter the new 
password again.

The password will appear on the screen as a series of dots as you enter it.

You can enter from 6 to 12 alphanumeric English characters for a password.

Note that passwords are case-sensitive, so enter upper-case and lower-case letters 
correctly.

4. Click Submit.

5. This saves the settings on the printer.

You do not need to re-start the printer. Use the new password the next time you log in as 
an administrator.

Checking Printer Settings From a Computer
You can use the procedures below to check the printer status from a computer over a network.
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To check using the “Status Screen”
1. Access the printer web page and open the “Status” screen.
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To check using the “Status Window”
1. Click Status Window, which will display the screen shown below.

Information about the printer and its status is displayed in this window. Click Refresh to 
update the window with the latest information.

The color of the printer status icon indicates whether printing is possible.

• Green - No error, online

• Yellow - Minor malfunction (printing still possible)

• Red - Serious malfunction (printing not possible)

• Gray - Offline
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Changing Printer Settings From a Computer
You can use the procedure below to change printer settings.

1. Access the printer web page and log in as an administrator.

2. After changing the settings you want, click Submit.

Encrypting Communication (SSL/TLS)
Communication between the computer (client) and printer can be encrypted when configuring 
settings, performing IPP printing, and when receiving print data with FTP protocol.

(Encryption of SSL/TLS Communication)

Configuring Settings
The procedure below shows how to use the web to create a certificate with the printer.

The two types of certificates below can be created.

• Self-signed certificate
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• CA certificate (CSR creation)

Note: If the printer's IP address is changed from what it was when a certificate was created, 
that certificate become invalid. Do not change the printer's IP address after creating a 
certificate.

1. Log in as an administrator. See “Logging in as an Administrator” on page 414.

2. Click in the following sequence: Admin Setup > Network Setup > Security.

3. Click SSL/TLS.

4. Select the type of the certificate to create in Step 1.

5. Enter information for the Common Name, Organization, and other items.

• If you selected “Use a certificate issued by a certificate authority”, perform detailed 
content input and other certificate issuing procedures in accordance with issuing 
authority procedures.
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• If you selected a self-signed certificate, the printer's IP address will be set for 
Common Name.

If you want to change the key exchange method and key size, click Key Exchange 
method. (The initial default setting is RSA, 1024 bits. Normally, you should use this 
setting without modifying it.)

6. Click Submit.

7. Self-signed Certificate

Note: This step applies only to self-signed certificates. To create a CA certificate, 
proceed to step 8.

a. This displays the input.

Check the contents, and then click OK. This creates the certificate.

This completes self-signed certificate creation.

Settings are saved on the printer and the network function is restarted.

b. Perform steps 1 through 3 of this procedure to display the encryption (SSL/TLS) 
setup screen, and then configure protocol settings to enable encryption.

c. Click Submit.

8. CA Certificate

Note: This step applies only to CA certificates.

a. This displays the input.

Check the contents, and then click OK.

b. Extract the CSR and send it to the issuing authority. (For a CA certificate)

Copy the contents of the text box from "----- BEGIN CERTIFICATE REQUEST -----" 
to "----- END CERTIFICATE REQUEST -----". Depending on the CA, sending the 
CSR may mean pasting it into web page, sending it as a file, attaching it to a mail 
message, etc.

c. This installs the certificate issued by the CA (using the web). (For a CA certificate)

Perform steps 1 through 3 of this procedure to display the encryption (SSL/TLS) 
setup screen.

Paste the part of the generated certificate from "----- BEGIN CERTIFICATE -----" to 
"----- END CERTIFICATE -----" into the text box, and then click Send.

This completes CA certificate creation.

Settings are saved on the printer and the network function is restarted.

d. Perform steps 1 through 3 of this procedure to display the encryption (SSL/TLS) 
setup screen, and then configure protocol settings to enable encryption.

e. Click Submit.
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Usage Method
1. Start up the web browser, and then enter “https://<printer IP address>” as the address to 

connect.

Printing with IPP
Printing can be performed using IPP.

To enable IPP printing
1. Access the printer web page and log in as an administrator.

2. Select Admin Setup.

3. Select the following: Network Setup > IPP > Setup.

4. Follow the instructions that appear on the display to configure the setup.

5. Click Submit.

To set up the printer as an IPP printer (Windows)
1. Click Start and select Control Panel in Windows.

2. Select View devices and printers > Add a printer.

3. On the Add a device wizard, select Add a network, wireless or Bluetooth printer.

4. From the list of usable printers, select The printer that I want isn't listed.

5. Select Select a shared printer by name.
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6. Enter “http://<printer IP address>/ipp” or “http://<printer IP address>/ipp/lp”, and then 
click Next.

7. Click Have Disk.

8. Download the driver installation software. You can obtain the software from 
www.QuickLabel.com/downloads.

9. For Copy manufacturer's files from, browse to the appropriate folder, and then click 
Find.

PCL driver: \Drivers\PCLXL

10. Select the INF file, and then click Open.

11. Click OK.

12. Select the printer name, and then click Next.

13. Click Next.

14. Click Finish.

15. A test page is printed after installation is complete.

Encrypting Communication (IPsec)
You can configure the settings in this section to encrypt and prevent tampering with 
communication between the computer (client) and printer at the network layer level.

The IKE protocol supported by this printer is “IKEv1”. The communication mode supported by 
this printer is “Transport Mode”. It does not support “Tunnel Mode”. Printer response may slow 
down while IPsec is enabled, depending on network communication conditions.

Note: IPsec does not operate with the mail send function or SNMP Trap function.

Setup Flow
Configure printer settings before configuring computer settings.
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To configure the printer setup
The procedure below shows how to use the web to enable IPsec.

1. Log in as an administrator. See “Logging in as an Administrator” on page 414.

2. Click in the following sequence: Admin Setup > Network Setup > Security.

3. Click the IPsec tab.

4. Under STEP1, enable IPsec.

• Set Enable for IPsec to encrypt communications from the computer with the IP 
address you specify in STEP2.

• The web page will not open if IPsec setup fails because the configured parameters 
do not match the computer, or because of some other reason. If this happens, use 
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the control panel Network Setup item to disable IPsec, or perform network initial-
ization to disable IPsec.

5. Under STEP2, enter the host IP address.

• Use an IP address to specify a host that is allowed to print and configure settings.

• For the IPv4 address, use single-byte numerals separated by periods (.).

• For the IPv6 address, use single-byte alphanumeric characters separated by 
colons (:). Abbreviated notation is not supported.

• Entry of IP address 0.0.0.0. is invalid.

6. Under STEP3, configure the settings of the Phase1 Proposal parameters.

• For IKE Encryption Algorithm, select one of the following settings: AES-CBC 
256, AES-CBC 192, AES-CBC 128, 3DES-CBC, DES-CBC.
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• For IKE Hash Algorithm, select SHA-1 or MD5.

• For Diffie-Hellman Group, select Group2 or Group1.

• For Lifetime, enter and set a value in the range of 600 (seconds) to 86,400 
(seconds).

7. Under STEP4, set the pre-shared key.

For Pre-Shared Key, enter at least one and no more than 64 single-byte alphanumeric 
characters. Here, we will show an example where “ipsec” is entered for the character 
string.
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8. Under STEP5, set the Key PFS.

a. For Key PFS, select KEYPFS or NOPFS.

b. If Key PFS is selected, select one of the following settings for Key PFS 
Diffie-Hellman Group: Group 2, Group 1, None.

9. Under STEP6, configure Phase2 Proposal settings.

To configure ESP settings

a. For ESP Encryption Algorithm, select one of the following settings: AES-CBC 
256, AES-CBC 192, AES-CBC 128, 3DES-CBC, DES-CBC.

b. For ESP Authentication Algorithm, select SHA-1, MD5, or OFF. If you select 
OFF, the ESP verification algorithm will not be applied.

To configure AH settings

a. For AH Authentication Algorithm, select SHA-1 or MD5.

b. For LifeTime, enter and set a value in the range of 600 (seconds) to 86,400 
(seconds).

10. Click Submit.

11. Settings are saved on the printer and the network function is restarted.

To configure computer settings
1. Click Start, and then select Control panel in Windows.

2. Click System and Security.

3. Click Administrative Tools.
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4. Double-click Local Security Policy.

5. Select Windows Firewall with Advanced Security - Windows Firewall with 
Advanced Security - Local Group Policy Object, right-click Connection Security 
Rules, and then select New Rule.

6. Select Custom, and then click Next.
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7. Select Endpoint 1 and 2. Configure as required, and then click Next.

8. Select Require authentication for inbound connections and request authentication 
for outbound connections, and then click Next.

9. Select Advanced, and then click Customize.
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10. In the First authentication section, click Add.

11. Select Preshared Key and enter the key, and then click OK.

12. Click OK.

13. Click Next.
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14. Click Next.

15. After confirming that all of the check boxes are selected, click Next.

16. Enter a name, and then click Finish.
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17. Open the Local Security Policy of the Administrative Tools.

18. Select Windows Firewall with Advanced Security, right-click, and then select 
Properties.

19. Select the IPsec Settings tab. Next, in the IPsec defaults section, click Customize.



Web Utility

QL-300 User Guide 438
 

20. In the Key exchange (Main Mode) section, select Advanced, and then click 
Customize.

21. Change the Security Methods as required, and then click OK.

22. In the Data protection (Quick Mode) section, select Advanced, and then click 
Customize.
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23. Configure the settings you want, and then click OK.

Note: Support is provided only for time indicated by the key lifetime. To disable 
session-specific (IPsec communication data size) conditions, set the maximum value.

24. In the Authentication method section, select Advanced, and then click Customize.

25. In the First authentication section, click Add.
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26. Select Preshared Key and enter the key, and then click OK.

27. Click OK.

28. Click OK to exit Customize IPsec Settings.

29. Click OK.
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Controlling Access by IP Address (IP Filter)
Access to the printer can be managed using IP addresses.

Note: IP Filtering is set to Disable under the printer initial default settings.

Note: Take care to enter the IP address correctly. An incorrectly entered IP address can make 
it impossible to access the printer using IP protocol.

1. Log in as an administrator. See “Logging in as an Administrator” on page 414.

2. Click in the following sequence: Admin Setup > Network Setup > Security.

3. Click IP Filtering.
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4. Under STEP1, select Enable for IP Filtering.

Note: Enabling IP filtering disables all access from hosts that are outside the range of IP 
addresses specified in STEP2.

5. Under STEP2, specify the IP address range.

• Using IP addresses, enter the range of hosts that are allowed to print and configure 
settings.

• For the IP addresses, use single-byte numerals separated by periods (.).

• Entry of IP address 0.0.0.0. is invalid.

• When there is overlap of IP addresses, the address range with the highest level set 
in Priority is given priority.

• Regardless of what is specified in STEP2, you can use STEP3 to specify adminis-
trator addresses for which printing and setting configuration are enabled.
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6. Click Address Range Bar Display/Refresh.

If you want to modify an IP address range, re-enter the applicable IP addresses, and click 
Address Range Bar Display/Refresh again.

7. Under STEP3, specify the Administrator’s IP Address setting.

Even if the wrong settings are configured in STEP2 due to administrator IP address entry 
in Administrator’s IP Address setting, the administrator can re-configure the setting 
from a host with the IP address specified with Administrator’s IP Address setting.

• If the printer is being accessed via a proxy, the intermediate device's address will 
be displayed as Your Current Local Host/Proxy IP Address. Consequently, the 
address shown by Your Host IP Address may be different from your actual host 
address.

• If nothing is registered for the administrator IP address, the setting in STEP2 may 
make the printer completely inaccessible.

• If you do not want to register an administrator IP address, leave Administrator’s 
IP Address setting blank.

8. Click Submit.

9. Settings are saved on the printer and the network function is restarted.
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Controlling Access by MAC Address
Access to the printer can be managed using MAC addresses.

Note: Incorrectly entering a MAC address can make it impossible to access the printer using 
a network. Exercise caution when entering an address.

1. Log in as an administrator. See “Logging in as an Administrator” on page 414.

2. Click in the following sequence: Admin Setup > Network Setup > Security.

3. Click MAC Address Filtering.
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4. Under STEP1, select Enable for MAC Address Filtering.

5. Under STEP2, You can select Accept or Deny for communication from specific MAC 
addresses.

• Using MAC addresses, enter the range of hosts whose communications are 
allowed or rejected.

• For the MAC addresses, use single-byte numerals separated by periods (.).

• Regardless of what is specified in STEP2, you can use STEP3 to specify adminis-
trator addresses for which communication is enabled.
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6. Under STEP3, specify the Administrator’s MAC Address setting.

Even if the wrong settings are configured in STEP2 due to administrator MAC address 
entry in Administrator’s MAC Address setting, the administrator can re-configure the 
setting from a host with the MAC address specified with Administrator’s MAC Address 
setting.

• If the printer is being accessed via a proxy, the intermediate device's address will 
be displayed as Your Host MAC Address. Consequently, the address shown by 
Your Host MAC Address may be different from your actual host address.

• If nothing is registered for the administrator MAC address, the setting in STEP2 
may make the printer completely inaccessible.

• If you do not want to register an administrator MAC address, specify 
00:00:00:00:00:00 for Administrator’s MAC Address setting.

7. Click Submit.

8. Settings are saved on the printer and the network function is restarted.
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Sending Error Notifications by Mail
The printer comes with a mail sending function (SMTP) built-in. It can be configured to send a 
mail message whenever an error occurs. You can select whether to send a periodic mail 
message about errors, or to send a mail message as soon as an error occurs.

1. Log in as an administrator. See “Logging in as an Administrator” on page 414.

2. Click: Admin Setup > Network Setup.

3. Click: Email > Send Settings.
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4. Under STEP1, select Enable for SMTP Send.

5. Under STEP2, specify the required addresses.

a. For SMTP Server, specify the mail server domain name or IP address.

b. For Printer Email Address, specify the mail address assigned to the printer.

• To configure SMTP server settings with a domain name, you need to configure 
DNS server settings with the TCP/IP setup.

• The mail server needs to be configured to allow the printer to send mail. For infor-
mation about mail server settings, consult with your network administrator.

• Internet Explorer 7 configured with its initial default setup will not perform a send 
test.

To perform a send test, you need to change the setup of Internet Explorer 7.

Select Tools > Security Level Customization, and then enable Allow websites 
to prompt for information using scripted windows.
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6. To configure more advanced settings from this point, click Set detail of the SMTP 
Protocol. for STEP3.

Otherwise, jump to step 16 of this procedure.

7. Click Security Settings.

8. For SMTP Port Number, specify the mail server port number.

9. Select Enable for SMTP-Auth.

a. For User ID, specify the user ID for connection to the mail server.

b. For Password, specify the password for connection to the mail server.

10. Click OK.

11. Click Configure attached information.
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12. Select or enter the information you want to add to the end of the message text.

13. Click OK.

14. Click Others.

15. For Reply-To Address, specify the return address for the mail sent from the printer. 
Normally, specify the mail address of the printer administrator.

16. Click OK.

17. Click Submit.

18. Settings are saved on the printer and the network function is restarted.

Note: The authentication method is automatically selected from among authentication 
methods supported by the mail server.

Sending Error Notifications by Periodic Mail
For periodic notification, disable the sleep mode setting.

To send periodic notifications about problems
1. Log in as an administrator. See “Logging in as an Administrator” on page 414.

2. Click: Admin Setup > Network Setup.
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3. Click: Email > Alert Settings.

4. Enter the mail address of the malfunction notification recipient.

5. Click Setting of the mail address you want to specify.

Malfunction notification condition settings can be copied to another addressee by clicking 
Copy. This is useful when sending malfunction notifications to multiple recipients with 
similar mail addresses.
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6. Select the Periodically check box, and then click To STEP2.

7. For Email Alert Interval, specify the mail send interval.

Mail is not sent if there are no reportable errors within the period.

8. Under Setting Events Used for Sending Email Alerts, select the check boxes of the 
error types for you to be notified of.

9. Click OK.

10. Check the configuration of the malfunction notification conditions.

• To display as a list, click Show current settings table. Check the configuration, 
and then close the window.

• To compare the setting conditions of two recipients, use the list box to select each 
of the recipients you want to compare. Check the displayed configuration.

You can change notification condition settings by clicking inside the setting condition 
comparison table.

11. Click Submit.

12. Settings are saved on the printer and the network function is restarted.
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To send alerts when problems occur
1. Click: Email > Alert Settings.

2. Enter the mail address of the malfunction notification recipient.

3. Click Setting of the mail address you want to specify.

Malfunction notification condition settings can be copied to another addressee by clicking 
Copy. This is useful when sending malfunction notifications to multiple recipients with 
similar mail addresses.
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4. Select the Upon occurrence of an event check box, and then click To STEP2.

5. Under Setting Events Used for Sending Email Alerts, select the check boxes of the 
error types for you to be notified of.

6. Specify the delay after an error occurs until the message is sent, and then click OK.

• Setting a delay time makes it possible to send notifications only of errors that are 
generated only over a long period of time.

• Setting “0 hours, 0 minutes” for the delay time causes the message to be sent 
immediately after an error occurs.

7. Click OK.

8. Check the configuration of the malfunction notification conditions.

• To display as a list, click Show current settings table. Check the configuration, 
and then close the window.

• To compare the setting conditions of two recipients, use the list box to select each 
of the recipients you want to compare. Check the displayed configuration.

You can change notification condition settings by clicking inside the setting condition 
comparison table.

9. Click Submit.

10. Settings are saved on the printer and the network function is restarted.
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Using SNMPv3
This printer implements an SNMPv3 compatible agent.

You can use an SNMPv3 compatible SNMP manager to encrypt printer administration with 
SNMP for greater security.

1. Log in as an administrator. See “Logging in as an Administrator” on page 414.

2. Click: Admin Setup > Network Setup.

3. Click SNMP > Settings.
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4. Select the check box of the SNMP version to be used in STEP1, and then click To 
STEP2.

If SNMPv3 is selected, you will not be able to view or configure settings with SNMPv1. If 
SNMPv3+v1 is selected, you will be able to view settings with either SNMPv1 or 
SNMPv3, but you can configure settings using SNMPv3 only.

5. In STEP2, enter an SNMPv3 user name for User Name.

6. Enter the passphrase for verification in Passphrase for Authentication Settings.

7. Select Algorithm.

8. Enter the passphrase for encryption in Passphrase for Privacy (Encryption) Settings.

You can select DES only for the encryption algorithm.

9. Click Submit.
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10. Settings are saved on the printer and the network function is restarted.

Note: For the context key of the SNMP manager to be used, specify “v3context”.

Using IEEE802.1X
Authentication is in accordance with IEEE802.1X.

IEEE802.1X Setup Flow
To configure IEEE802.1X settings on the printer, first connect the printer and computer via a 
normal hub for setup. After completing the IEEE802.1X setting configuration procedure, 
connect the printer to the authentication switch.

1. Connect the printer to a computer.

2. On the computer, specify an IP address for setting up.

3. On the printer, specify an IP address for setting up.

4. On the printer, configure IEEE802.1 settings.

5. Connect the printer to the authentication switch.

To configure IEEE802.1 settings
1. Log in as an administrator. See “Logging in as an Administrator” on page 414.

2. Click: Admin Setup > Network Setup.
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3. Click IEEE802.1X.

If PEAP is to be used, proceed to “To use PEAP”. If EAP-TLS is to be used, proceed to 
“To use EAP-TLS”.

To use PEAP
1. For the IEEE802.1X setting, select Enable.

2. For EAP Type, select PEAP.

3. In EAP User, enter the user name.

4. In EAP Password, enter the password.

5. Select the Authenticate Server check box.
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6. Click Import of CA Certificate.

Note: If the Not authenticate Server check box is selected, import of a CA certificate is 
not required. If the Not authenticate Server check box is selected, there is no 
confirmation to determine if the connection is to a properly authenticated server.

This displays the “Import of CA Certificate” screen.

7. Enter the file name of the CA certificate, and then click OK.

• The imported CA certificate is a certificate of the server certificate issuing authority 
of the RADIUS server.

• Supported import file formats are PEM, DER, and PKCS#7.

The CA certificate is imported by the printer.

8. Click Submit.

9. Settings are saved on the printer and the network function is restarted.

When the standby screen appears on the control panel, turn off the printer.

Advance to “To connect the printer to an authentication switch”.

To use EAP-TLS
1. For the IEEE802.1X setting, select Enable.

2. For EAP Type, select EAP-TLS.

3. In EAP User, enter the user name.

4. Select the Not use SSL/TLS Certificate for EAP authentication check box.
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5. Click Import of Client Certificate.

This displays the “Import of Client Certificate” screen.

6. Enter the file name of the client certificate.

• The importable certificate file format is PKCS#12.

7. Enter the client certificate password, and then click OK.

The client certificate is imported by the printer.

8. Select the Authenticate Server check box.

9. Click Import of CA Certificate.

Note: If the Not authenticate Server check box is selected, import of a CA certificate is 
not required. If the Not authenticate Server check box is selected, there is no 
confirmation to determine if the connection is to the correct authenticated server.

This displays the “Import of CA Certificate” screen.

10. Enter the file name of the CA certificate, and then click OK.

• The imported CA certificate is a certificate of the server certificate issuing authority 
of the RADIUS server.

• Supported import file formats are PEM, DER, and PKCS#7.

The CA certificate is imported by the printer.

11. Click Submit.

12. Settings are saved on the printer and the network function is restarted.

When the standby screen appears on the control panel, turn off the printer.

Advance to “To connect the printer to an authentication switch”.

To connect the printer to an authentication switch
Note: Confirm that the printer is turned off.

1. Plug a LAN cable into the printer's LAN (network) interface connector.

2. Plug the LAN cable into the authentication switch's authentication port.

3. Turn on the power supply of the printer.

4. Confirm that the standby screen is displayed on the control panel.

5. Configure settings in accordance with the operating environment, such as the printer's IP 
address, etc.
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Color Correct Utility

Changing Palette Colors
The Color Correct Utility can be used to specify palette colors selected with Microsoft Excel, 
Word, and other applications within the adjustment range.

• To print using the sample print function or the test print function of the Color Correct 
Utility, load 130-mm wide Continuous Paper in the printer's unwinder.

• Configure settings for each of the printer drivers.

• For test printing, use paper that is a size supported by the printer being used.

• This utility cannot be used for a printer that is connected for printer sharing.

• PC administrator privileges are required to use the Color Correct Utility.

Note: This utility requires the latest versions of the QL-300 PostScript and PCL drivers.

Use the Color Correct Utility to Perform Color Adjustment
1. Perform the following operation to start up the Color Correct Utility: Start > QL-300 > 

Color Correct Utility.

2. Select Office Palette Tuning, and then click Next.
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3. On the “Select Printer” screen that appears, select the printer to be used, and then click 
Next.

Note: This displays a list of installed printer drivers. Configure settings for each of the 
printer drivers
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4. On the “Select setting” screen that appears, select a setup, and then click Print Sample.

This prints the “Color Sample”.

5. Click Next.

This displays the “Office Palette Tuning” screen.
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6. Click Print Palette.

This prints the “Palette Color Sample”.

Note: Items that are crossed out (×) cannot be adjusted.
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7. Compare the palette (screen colors) of the “Office Palette Tuning” screen with the printed 
“Palette Color Sample”. If the colors are different, adjust them. The example below shows 
palette color adjustment of the color circled.

Palette Color Sample:

Office Palette Tuning Screen
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8. On the “Office Palette Tuning” screen, click the color to be adjusted (screen color).

This displays the “Adjustment values input” screen.

9. Use the X-value and Y-value pull-down menus to check their allowable setting ranges, 
and then click CANCEL.

Note: In order to preserve overall balance, the allowable adjustment ranges depend on 
the color.

10. For the adjustment color (screen color) of the “Office Palette Tuning” screen, search the 
“COLOR SELECTION SAMPLE” for the desired color within the adjustment range, and 
note the X-direction (hue) and Y-direction (brightness) values (X-value and Y-value).
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11. On the “Office Palette Tuning” screen, click the color to be adjusted (screen color).

This displays the “Adjustment values input” screen.

12. On the “Adjustment values input” screen, select the X-value and Y-value you found in 
step (10) of this procedure, and then click OK.

The display will return to the “Office Palette Tuning” screen.
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13. Click Print Palette to print the “Palette Color Sample”. After confirming that the changed 
“Palette Color Sample” color is closer to the color sample color for the configured 
settings, click Next.

For other colors you want to adjust, repeat steps (8) through (13) of this procedure.

14. Enter the setting name, and then click Save.

15. Click OK.

Note: If you update or re-install the printer driver, created color adjustment names will 
be re-imported when you start up the Color Correct Utility. After confirming that the Color 
Adjustment name is shown for Select Setup, click Exit.
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16. Click Finish to exit the Color Correct Utility.

Use a Printer Driver to Select a Setup Name and then Print

Windows PCL Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties).

4. On the Color tab, click Detail, and then select Simple Adjustment.

5. Select the Color Correct Utility Settings check box, select the settings you created with 
the Color Correct Utility, and then click OK.

6. Print.

Changing the Gamma Value and Hue
You can use the Color Correct Utility to adjust the gamma value and/or hue for color matching.

• To print using the sample print function or the test print function of the Color Correct 
Utility, load 130-mm wide Continuous Paper in the printer's unwinder.

• Configure settings for each of the printer drivers.

• For test printing, use paper that is a size supported by the printer being used.

• This utility cannot be used for a printer that is connected for printer sharing.

• PC administrator privileges are required to use the Color Correct Utility.
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Use the Color Correct Utility to Change the Gamma Value, Hue, and Other 
Settings

1. Perform the following operation to start up the Color Correct Utility: Start > QL-300 > 
Color Correct Utility.

2. Select Hue & Saturation Tuning, and then click Next.

3. On the “Select printer” screen that appears, select the printer to be adjusted, and then 
click Next.

Note: This displays a list of installed printer drivers. Configure settings for each of the 
printer drivers
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4. On the “Select setting” screen that appears, select the mode you want to use as the 
standard, and then click Next.

5. To adjust, move the Gamma, Hue, and Saturation sliders.

The Gamma slider can be used to adjust overall brightness, while the Brightness/ Satu-
ration slider adjusts the output color.

Brightness is increased by sliding the Gamma slider to the left.

The Hue slider adjusts each color in the color wheel forward (+) direction or reverse (-) 
direction. For example, moving the slider in the plus (+) direction while Y (Yellow) is 
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selected will move towards G (Green), while moving in the minus (-) direction moves 
towards R (Red). 

The Use printer's unadjusted color option adjusts based on use of colors that are 
100% toner primary colors. Selecting the check box for this option fixes the Gamma slider 
for the selected color and performs adjustment so printing uses the toner blends shown 
below.

Printer Color Result

Cyan (C) Cyan toner 100%

Magenta (M) Magenta toner 100%

Yellow (Y) Yellow toner 100%

Red (R) Magenta toner 100% + Yellow toner 
100%

Green (G) Cyan toner 100% + Yellow toner 100%

Blue (B) Cyan toner 100% + Magenta toner 100%
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6. Click Print Test.

This prints the “Test Printing Sample”.

7. Check the color adjustment result.

If adjustment results are not what you expected, repeat steps (5) and (6) of this proce-
dure.

8. Click Next.

9. Enter the setting name, and then click Save.
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10. Click OK.

Note: If you update or re-install the printer driver, created color adjustment names will 
be re-imported when you start up the Color Correct Utility. After confirming that the Color 
Adjustment name is shown for Select Setup, click Finish.

11. Click Finish to exit the Color Correct Utility.

Use a Printer Driver to Select a Setup Name and then Print

Windows PCL Printer Driver
1. Open the file to be printed.

2. Select Print in the File menu.

3. Click Preferences (or Properties). 

4. On the Color tab, click Detail, and then select Simple Adjustment.

5. Select the Color Correct Utility Settings check box, select the settings you created with 
the Color Correct Utility, and then click OK.

6. Print.

Saving a Color Adjustment Setup
You can use the Color Correct Utility to save a setup to a file.

• Configure settings for each of the printer drivers.

• This utility cannot be used for a printer that is connected for printer sharing.

• PC administrator privileges are required to use the Color Correct Utility.
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1. Perform the following operation to start up the Color Correct Utility: Start > QL-300 > 
Color Correct Utility.

2. Select Import/Export Color Settings, and then click Next.
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3. Select the printer whose setup you want to save, and then click Next.

This displays the “Import/Export Color Settings” screen.
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4. Click Export.

5. On the “Export Settings” screen, select the settings you want to export, and then click 
Export.

Note: You can select multiple setups by holding down your computer's Ctrl or Shift key 
as you select.
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6. Select the save location, enter the name of folder for storing the setup, and then click 
Save.

7. Click OK.

8. Click Finish to exit the Color Correct Utility.

Importing a Color Adjustment Setup
You can use the procedure below to import a color adjustment setup from a file.

• Configure settings for each of the printer drivers.

• This utility cannot be used for a printer that is connected for printer sharing.

• PC administrator privileges are required to use the Color Correct Utility.
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1. Perform the following operation to start up the Color Correct Utility: Start > QL-300 > 
Color Correct Utility. 

2. Select Import/Export Color Settings, and then click Next.
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3. Select the printer whose setup you want to import, and then click Next.

This displays the “Import/Export Color Settings” screen.
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4. Click Import.

5. In the folder where the setup you want to import is stored, select the appropriate CCM 
file, and then click Open.

6. On the “Import Settings” screen that appears, select the setup you want to import, and 
then click Import.

Note: You can select multiple setups by holding down your computer's Ctrl or Shift key 
as you select.
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7. After confirming that the setup has been imported, click Finish.

Deleting a Color Adjustment Setup
You can use the procedure below to delete color adjustment setups you no longer need.

1. Perform the following operation to start up the Color Correct Utility: Start > QL-300 > 
Color Correct Utility. 

2. Select Import/Export Color Settings, and then click Next.
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3.  Select the printer whose setup you want to delete, and then click Next.

4. From the list, select the setup you want to delete, and then click Delete.

5. Click Yes to delete the setup.
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6. After confirming that the setup has been deleted, click Finish.
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Color Swatch Utility

Operating Environment
The Color Swatch Utility prints RGB color samples for the printer. Printed color samples can be 
used to determine the RGB value settings that need to be specified with an application in order 
to obtain desired printed colors.

Note: The Color Swatch Utility is installed along with the printer drivers.

Note: The results of the color test print are printed according to the paper settings in the printer 
driver, so use paper that allows for the largest printout.

Note: This utility requires the latest versions of the QL-300 PostScript and PCL drivers.

Printing RGB Color Samples
1. Perform the following operation to start up the Color Swatch Utility: Start > QL-300 > 

Color Swatch Utility.

2. Click Print.

3. Select this printer.

4. Click OK or Print. This prints a three-page color sample.

Note: The RGB values below each color block show the component quantity (0 to 255) 
of R (red), G (green), B (blue) in the block.

5. Find the color in the color sample that you want to print, and make a note of its RGB 
values.

Note: If you cannot find the color you want in the color sample, perform the procedure 
below to customize the color sample manually.

6. Click Switch to switch to the custom color sample.
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7. Click Detail to display the Edit Custom Color Swatch dialog box.

8. Adjust the positions of the three bars until the desired color is shown on the monitor 
screen, and then click Close.

Hue: Changes the hue. 0 displays red, while a higher value moves on the color wheel 
towards green.

Saturation: Changes the vividness. A higher value increases vividness, while a lower 
value makes the color more cloudy (gray).

Brightness: Changes the density. Maximum (100%) brightness is white, while minimum 
(0%) brightness is black.

9. Click Print.

10. Select this printer.

11. Click OK or Print. This causes a single page to be printed by the printer.

12. If you cannot find the color you want in the color sample, repeat this procedure.
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Use the Application to Print the Desired Color
1. Open the file to be printed.

2. Use the application to select text or graphics, and change the RGB values to those of the 
color sample block that is the color you want.

Note: For information about how to specify colors with an application, see the 
application's user documentation.

3. Print.

Note: When printing a desired color from an application, use the same printer driver 
settings as those that were used when printing the color sample.



QL-300 User Guide 488

18

 

Upgrades

Upgrading the Printer Firmware
Use the following instructions to upgrade the QL-300 printer firmware.

1. Download the QL-300 firmware upgrade package from the QuickLabel website 
(www.quicklabel.com). The file will be named QuickLabel_QL-300_Firmware-x.xx.zip 
(where x.xx indicates the firmware version number).

2. Unzip the firmware upgrade package file. A self-extracting executable file named 
QuickLabel QL-300 Firmware-x.xx.exe (where x.xx indicates the firmware version 
number) will be saved to your PC.

3. Launch the self-extracting executable file and save its contents to a folder on your PC.

4. Launch the FWUpdateTool.exe file.

5. At the language prompt, select your desired language. Then choose OK.

6. In the software license agreement screen, accept the agreement and choose Next.

7. In the precautions screen, observe the warnings and precautions. Then choose Next.
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8. In the next screen, select Specifies and updates the downloaded firmware.

Select References. Browse to and select the file QuickLabel QL-300 Firm-
ware-B0x.xx_x_x.bin (where x.xx indicates the firmware version number). Then choose 
Next.

9. In the next screen, you will search for the printer you want to upgrade.

Select whether your printer is connected with a Network or USB interface. Then choose 
Start Search.

Note: Any printers listed after a canceled search may not upgrade properly. Please run 
the search again if a search has been canceled
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10. After the search completes, the installed QL-300 printers will be displayed. Select the 
printer you want to upgrade.

From the top list, select the printer model. From the bottom list, select the printers you 
want to upgrade. Then choose Next.

11. In the next screen, you will be prompted to enter the administrator password for the 
printers.

Enter the administrator password. The factory default setting is 999999. See “Changing 
the Administrator Password” on page 265.

Choose Start update.
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12. The firmware upgrade process will begin. The upgrade status will be indicated by 
progress bars and informational messages.

If an error occurs, you will be notified of the failure. In this situation, you can access the 
help system for assistance resolving the error.

13. When the firmware update is complete, choose Next to close the firmware update 
program.
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Safety

Be sure to carefully read and follow the instructions in this manual before installing the machine.

Cautions Related to Safety

Residual Risk Map
The numbers shown in the diagrams indicate the numbers for the residual risk associated with 
the relevant locations, as described in the “List of Risks” for the product. For details about the 
various risks, refer to the “List of Risks”.

Warning Mishandling due to ignoring this symbol 
may cause death or serious injury.

Caution Mishandling due to ignoring this symbol 
may cause personal injury.
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List of Risks
The letters shown under “Locations on machine” indicate the locations on the machine as 
indicated by the letters on the “Residual Risk Map” for the product. Refer to the “Residual Risk 
Map” for the specific location on the machine.

No Job

Qualifications 
and training 

needed for job

Location 
on 

machine
Extent of 
hazard

Description of 
hazard

Protective 
measures 

implemented 
by machine 
installer and 

user

1 Installation / 
transportatio
n

Carefully read 
User Guide

A CAUTION Because the 
machine (the 
printer alone) 
weighs 43 kg, 
there is a risk of 
injury while 
lifting it.

Two or more 
people are 
required to lift 
the machine.

2 Installation / 
transportatio
n

Carefully read 
User Guide

A CAUTION Because the 
machine (the 
printer alone) 
weighs 43 kg, 
there is a risk of 
injury if it falls 
while workers 
are holding the 
OP-Assy.

Workers must 
hold the 
machine at the 
specified 
handholds while 
working.

3 Installation / 
transportatio
n

Carefully read 
User Guide

A CAUTION Because the 
machine (the 
printer and 
unwinder) 
weighs up to 62 
kg, there is a 
risk of injury if 
the machine is 
installed on a 
table that is 
unstable or 
unable to bear 
the load, such 
that the table 
overturns or 
breaks.

The machine 
must be 
installed so that 
the table on 
which it is 
installed is 
stable.The 
machine must 
be installed on a 
table capable of 
bearing the 
weight of the 
machine.
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4 Installation / 
transportatio
n

Carefully read 
User Guide

A CAUTION There is a risk of 
injury if the 
machine (printer 
and unwinder) 
extend past the 
edge of the 
table, such that 
it could catch on 
a person and fall 
off.

The machine 
must be 
installed on a 
table that is 
large enough to 
leave empty 
space around 
the machine.

5 Usage / 
maintenance

Carefully read 
User Guide

B CAUTION There is a risk of 
injury from 
fingers or hair 
being twisted 
into the rollers 
on the fuser and 
exit unit.

Workers must 
not touch the 
output roller 
area on the 
fuser and exit 
unit with their 
hands while the 
printer is 
operating.
Workers must 
not put their 
faces close to or 
look into the 
output roller 
area on the 
fuser and exit 
unit while the 
printer is 
operating.

6 Electrical 
connections

Carefully read 
User Guide

C CAUTION There is a risk of 
electric shock 
from the electric 
power cord.

Workers must 
not touch the 
power plug or 
power cord if 
their hands are 
wet.

7 Electrical 
connections

Carefully read 
User Guide

C CAUTION There is a risk of 
electric shock 
from the electric 
power 
connectors.

Workers must 
not insert any 
metal objects, 
such as a 
screwdriver, into 
the power 
connectors.

No Job

Qualifications 
and training 

needed for job

Location 
on 

machine
Extent of 
hazard

Description of 
hazard

Protective 
measures 

implemented 
by machine 
installer and 

user
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8 Usage / 
maintenance

Carefully read 
User Guide

D CAUTION Workers could 
pinch their 
hands if they 
grip the LED 
head while 
closing the top 
cover.

Workers must 
press on the top 
of the top cover.

9 Usage / 
maintenance

Carefully read 
User Guide

E CAUTION Workers could 
pinch their 
fingers or hands 
in the top cover 
or the top 
cover's support 
while closing the 
top cover.

Workers must 
press on the top 
of the top cover.

10 Usage / 
maintenance

Carefully read 
User Guide

F CAUTION There is a risk of 
injury if the fuser 
and exit unit falls 
while it is being 
pulled out.

Workers must 
grip the handle 
on the fuser unit 
when lifting the 
fuser and exit 
unit.

11 Usage / 
maintenance

Carefully read 
User Guide

G CAUTION There is a risk of 
injury if the print 
cartridge set 
falls while it is 
being pulled out.

Workers must 
grip the handles 
on the toner 
cartridge basket 
for the print 
cartridge set 
when lifting it.

12 Installation / 
transportatio
n

Carefully read 
User Guide

H CAUTION There is a risk of 
injury if the 
unwinder falls 
while it is being 
lifted.

Workers must 
hold the 
machine at the 
specified 
handholds while 
working.

13 Usage / 
maintenance

Carefully read 
User Guide

I CAUTION There is a risk of 
injury if the belt 
unit falls while it 
is being 
removed.

Workers must 
grasp the handle 
on the belt unit 
when removing 
the belt unit.

No Job

Qualifications 
and training 

needed for job

Location 
on 

machine
Extent of 
hazard

Description of 
hazard

Protective 
measures 

implemented 
by machine 
installer and 

user
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14 Installation / 
transportatio
n

Carefully read 
User Guide

J CAUTION There is a risk 
that fingers or 
hands could be 
pinched 
between the 
unwinder and 
the printer while 
installing the 
unwinder.

Workers must 
hold the 
machine at the 
specified 
handholds while 
working.

15 Usage / 
maintenance

Carefully read 
User Guide

I CAUTION There is a risk 
that hands or 
fingers could be 
pinched 
between the 
handle and the 
machine while 
removing or 
installing a belt 
unit.

Confirm the 
procedures for 
removing and 
installing the belt 
unit.

16 Usage / 
maintenance

Carefully read 
User Guide

K CAUTION There is a risk 
that hands could 
be pinched in 
the cover of the 
unwinder.

Workers must 
press on the 
cover of the 
unwinder.

17 Usage / 
maintenance

Carefully read 
User Guide

K CAUTION There is a risk 
that hands or 
fingers could be 
pinched while 
removing the 
cutter unit of the 
unwinder.

Workers must 
confirm the 
procedure for 
installing and 
removing the 
cutter unit.

18 Usage / 
maintenance

Carefully read 
User Guide

K CAUTION There is a risk of 
injury if the 
cutter unit of the 
unwinder falls 
while it is being 
removed.

Workers must 
confirm the 
procedure for 
installing and 
removing the 
cutter unit.

No Job

Qualifications 
and training 

needed for job

Location 
on 

machine
Extent of 
hazard

Description of 
hazard

Protective 
measures 

implemented 
by machine 
installer and 

user
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19 Maintenance Carefully read 
User Guide

L CAUTION There is a risk 
that hands may 
touch the cutter 
blade and be cut 
while 
dismantling the 
cutter unit of the 
unwinder and 
washing the 
cutter blade.

Confirm the 
procedure for 
cleaning before 
you dismantle 
the cutter unit 
and wash the 
cutter blade.

20 Usage Carefully read 
User Guide

M CAUTION There is a risk of 
injury if the roll 
paper is 
dropped or 
overturned.

Workers must 
wear rubber 
gloves or similar 
gloves while 
installing or 
removing roll 
paper.
Workers must 
confirm the 
storage and 
installation 
procedures so 
they do not drop 
or overturn the 
roll paper.

21 Usage Carefully read 
User Guide

M CAUTION There is a risk 
that hands could 
be cut on the 
edge of roll 
paper.

Workers must 
wear rubber 
gloves or similar 
gloves while 
handling roll 
paper.

No Job

Qualifications 
and training 

needed for job

Location 
on 

machine
Extent of 
hazard

Description of 
hazard

Protective 
measures 

implemented 
by machine 
installer and 

user
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22 Usage Carefully read 
User Guide

M CAUTION There is a risk 
that hands or 
fingers could be 
pinched by the 
roll paper and 
the roll paper 
holder while 
loading roll 
paper onto the 
roll paper holder.

Workers must 
confirm the 
procedure for 
attaching and 
removing roll 
paper.
Workers must 
turn the knob on 
the roll paper 
holder so it is 
sufficiently loose 
when loading 
roll paper.

23 Usage / 
maintenance

Carefully read 
User Guide

M CAUTION There is a risk of 
injury from 
fingers or hair 
being twisted 
into the roll 
paper or roll 
paper holder 
while the 
machine is 
operating.

Workers must 
not touch the 
shaft of the roll 
paper holder 
while the printer 
is operating.
Workers must 
not put their 
faces close to or 
look into the 
shaft of the roll 
paper holder 
while the printer 
is operating.

24 Usage Carefully read 
User Guide

N CAUTION There is a risk of 
injury if the roll 
paper falls off 
because the roll 
paper could not 
be secured to 
the roll paper 
holder.

Workers must 
confirm the 
procedure for 
attaching and 
removing roll 
paper.
Workers must 
turn the knob on 
the roll paper 
holder so it is 
sufficiently loose 
when loading 
roll paper.

No Job

Qualifications 
and training 

needed for job

Location 
on 

machine
Extent of 
hazard

Description of 
hazard

Protective 
measures 

implemented 
by machine 
installer and 

user
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25 Maintenance Maintenance 
technology

O WARNING There is a risk of 
injury, accident, 
or reduced 
performance of 
the product if it 
is dismantled or 
assembled by a 
person who 
does not have 
the tools or 
maintenance 
technology.

Workers must 
request repairs 
from Technical 
Support.

26 Usage Carefully read 
User Guide

O WARNING There is a risk of 
electric shock 
when printing on 
metal foil or 
electrically 
conductive 
paper if the 
paper is touched 
while printing.

Workers must 
not use metal 
foil or electrically 
conductive 
paper.

27 Usage Carefully read 
User Guide

P CAUTION There is a risk of 
injury by 
stepping on the 
cores of roll 
paper or on rolls 
of paper that are 
left on the floor.

Workers must 
confirm the 
storage and 
installation 
procedures so 
they do not drop 
or overturn the 
roll paper.

28 Installation / 
transportatio
n

Carefully read 
User Guide

P CAUTION There is a risk of 
injury from the 
silica gel used in 
the packing 
materials.

Workers must 
be careful when 
handling the 
silica gel used in 
the packing 
materials.

29 Installation / 
transportatio
n

Carefully read 
User Guide

P CAUTION There is a risk of 
injury from the 
plastic bags 
used in the 
packing 
materials.

Workers must 
be careful when 
handling the 
plastic bags 
used in the 
packing 
materials.

No Job

Qualifications 
and training 

needed for job

Location 
on 

machine
Extent of 
hazard

Description of 
hazard

Protective 
measures 

implemented 
by machine 
installer and 

user
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30 Installation / 
transportatio
n

Carefully read 
User Guide

P CAUTION There is a risk of 
injury to fingers 
and hands from 
the cardboard 
used in the 
packing 
material.

Workers must 
be careful when 
handling the 
cardboard used 
in the packing 
materials.

31 Installation / 
transportatio
n

Carefully read 
User Guide

P CAUTION There is a risk of 
injury from 
dropping the 
printer while 
removing the 
plastic bags and 
cushioning used 
in the packing 
materials.

Workers must 
confirm the 
procedure for 
unpacking the 
machine.

32 Usage Carefully read 
User Guide

P CAUTION Smoke or fire 
could occur if 
the air vents are 
blocked.

The air vents 
must not be 
blocked.

No Job

Qualifications 
and training 

needed for job

Location 
on 

machine
Extent of 
hazard

Description of 
hazard

Protective 
measures 

implemented 
by machine 
installer and 

user
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General Warnings and Cautions

Symbol Warning

Do not touch the safety switch inside this machine. High voltage may 
occur, resulting in electric shock. Also, a gear may rotate, resulting in 
injury.

Do not use a highly combustible spray near this machine. Some parts 
inside the machine become very hot, possibly resulting in fire.

If the cover becomes extremely hot, the machine emits smoke or odor, 
or you hear a strange sound, unplug the power plug from the outlet, 
and contact your dealer.
Fire may result.

If liquid such as water gets inside the machine, unplug the power plug 
from the outlet, and contact your dealer.
Fire may result.

If you drop a clip or other foreign objects into the machine, unplug the 
power plug from the outlet, and take the foreign objects out.
Electric shock, fire, or injury may result.

Do not perform any operation or disassembly other than instructed in 
manuals.
Electric shock, fire, or injury may result.

There is a risk of explosion if the battery is replaced with the wrong 
type of battery. The battery in the machine does not need to be 
replaced. Do not touch the battery.

If the machine is dropped or the cover is damaged, unplug the power 
plug from the outlet, and contact your dealer.
Electric shock, fire, or injury may result.

Unplug the power plug regularly, and clean the bases of and in 
between the plug blades.
If the power plug is left plugged into the outlet for an extended period 
of time, dust adheres on the bases of the plug blades, and a short may 
occur, possibly resulting in fire.

Do not connect the power cord, cables, or the ground wire in any way 
other than instructed in manuals.
Fire may result.

Do not put a cup with liquids such as water on the machine. Doing so 
may cause electric shock and/or fire leading to personal injuries.

Do not let liquid get inside this machine, or allow this machine to get 
wet. Electric shock or fire may result.
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Do not insert any object into a vent hole.
Electric shock, fire, or injury may result.

Do not throw print cartridges or waste toner boxes into a fire. The 
toner may ignite, resulting in burns.

Do not vacuum spilled toner with an electric vacuum cleaner. 
Vacuuming spilled toner with an electric vacuum cleaner may result in 
ignition due to sparks from electric contacts or other reasons.
If toner spills on the floor or other places, wipe the toner gently with a 
damp rag or other cloth while using care not to scatter the toner.

When the machine cover is opened, do not touch the fuser unit. Burns 
may result.

Operation using an UPS (uninterruptible power supply) or inverter is 
not guaranteed. Do not use an uninterruptible power supply or 
inverter.
Fire may result.

Symbol Caution

Do not go near the paper output part when you turn the power on or 
when printing is in progress. Injury may result.

Do not disassemble the print cartridge, or force it open. You may 
inhale the scattered toner, or the toner may land on your hands or 
clothes, making them dirty.

Symbol Warning
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Emergency First Aid
Take care with toner powder:

If you inhale it Move to an area with fresh air and 
rest in a posture that allows you to 
breath freely.

If it gets on your skin Wash with plenty of soap and 
water.

If it gets in your eyes Very carefully wash with water for 
several minutes. Next, if you are 
wearing contact lenses and can 
easily remove them, then remove 
them. Then, continue washing.

If you drink it If you feel bad, contact a 
physician.
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Specifications

Major Specifications

Item Specification

Model Number QL-300
QL-300s

RAM (standard/maximum) 2GB/2GB

Weight Approx. 62 kg (including unwinder)

Power 110 - 127 VAC (Range 99 - 140 VAC), 50/60 Hz ± 
2%
220 - 240 VAC (Range 198 - 264 VAC), 50/60 Hz ± 
2%

Power consumption When operating: Maximum 1200 W/Average 710 
W

In standby: Average 27 W

In power conservation modes
Power save mode: 25 W or less
Auto power off: 1 W or less
*This product does not consume power if the main 
power switch is turned off, even if it is plugged into 
an electric outlet.

Operating environment Temperature: 10 to 30 °C, humidity: 20 to 70% RH
Maximum wet-bulb temperature is 25 °C (to 
assure high-quality full color printing, temperature 
should be 17 to 27 °C, and humidity at 50 to 70% 
RH)

Network connections 1000BASE-T/100BASE-TX/10BASE-T
(Network Factory Defaults: 
100BASE-TX/10BASE-T)

Local connections USB 2.0 interface (suitable for Hi-Speed USB)

Supported operating systems Windows 8.1/Windows 8/Windows 7/Windows 
Server 2012 R2/Windows Server 2012/Windows 
Server 2008 R2/Windows Server 2008
Refer to the operating environment for details.
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Printing method QL-300: Full-color dry-type electrophotographic 
method using 4 consecutive digital LED heads
QL-300s: Full-color dry-type electrophotographic 
method using 5 consecutive digital LED heads

Printable width Paper width Roll paper: 25.4 mm (1 inch) - 130 mm (5.1 
inches), including liner

Printable width Roll paper: 21.16 mm (0.83 inches) - 125.76 mm 
(4.95 inches)

Reference position Right edge facing feed direction

Resolution Print resolution 1200 × 1200 dpi (2-tone)/600 × 600 dpi (2-tone)

LED dot-pitch 1200dpi

Print colors Yellow, magenta, cyan, black, and white*1

Print languages PCL5c, PCL6(PCLXL), PostScript

Print speed Color QL-300 (CMYK) roll paper: 6 ips
QL-300 (CMYK+W) roll paper: 6 ips

Media Type Standard Media, die-cut label paper

Feed capacity Roll diameter: 203.2 mm (8 inches)
Core size: 3 inches

Assured print range 2.12 mm from edge of paper. 2.12 mm from edge 
of label for label paper

Print accuracy ±0.5 mm accuracy at leading edge print start point 
(2σ N ≥20 When using recommended media and 
recommended operating conditions)
±0.5 mm accuracy at right edge print start point 
(When using recommended media and 
recommended operating conditions)
Image stretching: Less than 0.5% of length of 
paper (When using recommended media and 
recommended operating conditions)

Warmup time Approx. (within) 50 seconds after turning power on 
(at room temperature of 25 °C and rated voltage)*2

Wear items and maintenance parts Wear items: Print cartridge, belt unit (3-piece set of 
belt, waste toner box, and 2nd transfer roller), 
waste toner box, fuser and exit unit
Maintenance products: Cutter unit, F0 roller unit, 
paper guide, feed unit

Item Specification
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*1: QL-300s only.

*2: Not including correction operations.

*3: Equipment service life varies depending on your operating environment.

Roll Paper Specifications
Continuous paper (normal printing)

Service life of equipment*3 5 years or 500 km

Storage environment Temperature: -10 to 43 °C
Relative humidity: 10 to 90%

Item Specification

Item Specification

Paper weight 0.07 to 0.25 mm (0.003 to 0.0098 inches)
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Roll core Inner diameter: 76.2 mm (3 inches)

Outer diameter 203.2 mm (8 inches) or less

Other W2: Paper width 25.4 to 130 mm (1 to 5.12 inches)

L2: Paper length 12.7 to 1320.8 mm (0.5 to 52 inches)

L4: Cut size when in cut 
mode

101.6 mm (4 inches) or more
However, if the length of one label is less than 101.6 mm 
(4 inches), then the shortest length is 101.6 mm (4 inches) 
as multiple sheets are cut

L5: Upper edge cutting 
margin

2.12 mm (0.0835 inches)

L6: Lower edge cutting 
margin

2.12 mm (0.0835 inches)

A: Top margin 2.12 mm (0.0835 inches) or more

B: Bottom margin 2.12 mm (0.0835 inches) or more

C: Left margin 2.12 mm (0.0835 inches) or more

D: Right margin 2.12 mm (0.0835 inches) or more

Item Specification



Specifications

QL-300 User Guide 509
 

Continuous paper (printing on large size paper)

Item Specification

Paper weight 0.07 to 0.25 mm (0.003 to 0.0098 inches)

Roll core Inner diameter: 76.2 mm (3 inches)

Outer diameter 203.2 mm (8 inches) or less
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Other W2: Paper width 25.4 to 130 mm (1 to 5.12 inches)

L2: Paper length 12.7 to 1320.8 mm (0.5 to 52 inches)

L4: Cut size when in cut 
mode

101.6 mm (4 inches) or more
However, if the length of one label is less than 101.6 mm 
(4 inches), then the shortest length is 101.6 mm (4 inches) 
as multiple sheets are cut

L5: Upper edge cutting 
margin

2.12 mm (0.0835 inches)

L6: Lower edge cutting 
margin

1.5 mm (0.0591 inches)

A: Top margin 0 mm (0 inches)

B: Bottom margin 0 mm (0 inches)

C: Left margin 2.12 mm (0.0835 inches) or more

D: Right margin 2.12 mm (0.0835 inches) or more

Item Specification
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Continuous paper (with black marks)

Item Specification

Paper weight 0.07 to 0.25 mm (0.003 to 0.0098 inches)

Roll core Inner diameter: 76.2 mm (3 inches)

Outer diameter 203.2 mm (8 inches) or less
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Other W2: Paper width 25.4 to 130 mm (1 to 5.12 inches)

L1: Black mark interval 15.9 to 1324.0 mm (0.626 to 52.126 inches)
* The black marks contain carbon.

L2: Paper length 12.7 to 1320.8 mm (0.5 to 52 inches)

L4: Cut size when in cut 
mode

101.6 mm (4 inches) or more
However, if the length of one label is less than 101.6 mm 
(4 inches), then the shortest length is 101.6 mm (4 inches) 
as multiple sheets are cut

L5: Upper edge cutting 
margin

1.7 mm (0.067 inches)

L5 ': Position of leading 
edge of paper

1.2 to 4.0 mm (0.0472 to 0.1575 inches)
Length of leading margin when paper is loaded

L6: Lower edge cutting 
margin

1.5 mm (0.059 inches)

BW: Black mark width More than 5 mm (0.197 inches) from edge of paper;
maximum is width of paper W1 from edge of paper

BL: Black mark length 3 mm (0.12 inches)

A: Top margin 2.12 mm (0.0835 inches)

B: Bottom margin 3.2 mm (0.126 inches) * In practice, it is the length of the 
gap

C: Left margin 2.12 mm (0.0835 inches) or more

D: Right margin 2.12 mm (0.0835 inches) or more

Item Specification
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Die-cut label paper

Item Specification

Paper weight 0.07 to 0.25 mm (0.003 to 0.0098 inches)

Roll core Inner diameter: 76.2 mm (3 inches)

Outer diameter 203.2 mm (8 inches) or less
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Other W1: Liner width 29.4 to 130 mm (1.1575 to 5.12 inches)

W2: Label width 25.4 to 126 mm (1 to 4.9606 inches)

W3: Right liner width 2 to 25.4 mm (0.0787 to 1 inch)

W4: Left liner width 2 to 25.4 mm (0.0787 to 1 inch)

L1: Label pitch 15.7 to 1330.8 mm (0.618 to 52.3937 inches)

L2: Label length 12.7 to 1320.8 mm (0.5 to 52 inches)

L3: Gap between labels 3 to 10 mm (0.12 to 0.3937 inches)

L4: Cut size when in cut 
mode

101.6 mm (4 inches) or more
However, if the length of one label is less than 101.6 mm 
(4 inches), then the shortest length is 101.6 mm (4 inches) 
as multiple sheets are cut

L5: Upper edge cutting 
margin

1.7 mm (0.067 inches)

L5': Position of leading 
edge of paper

1.2 to 6.5 mm (0.0472 to 0.2559 inches)
Length of leading liner when paper is loaded

L6: Lower edge cutting 
margin

1.3 to 8.3 mm (0.051 to 0.3268 inches)

A: Top margin 2.12 mm (0.0835 inches) or more

B: Bottom margin 2.12 mm (0.0835 inches) or more

C: Left margin 2.12 mm (0.0835 inches) or more

D: Right margin 2.12 mm (0.0835 inches) or more

Item Specification
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Die-cut label paper (with black marks)

Item Specification

Paper weight 0.07 to 0.25 mm (0.003 to 0.0098 inches)

Roll core Inner diameter: 76.2 mm (3 inches)

Outer diameter 203.2 mm (8 inches) or less
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Other W1: Liner width 29.4 to 130 mm (1.1575 to 5.12 inches)

W2: Label width 25.4 to 126 mm (1 to 4.9606 inches)

W3: Right liner width 2 to 25.4 mm (0.0787 to 1 inch)

W4: Left liner width 2 to 25.4 mm (0.0787 to 1 inch)

L1: Black mark interval 15.7 to 1330.8 mm (0.618 to 52.3937 inches)
* The black marks contain carbon.

L2: Label length 12.7 to 1320.8 mm (0.5 to 52 inches)

L3: Gap between labels 3 to 10 mm (0.12 to 0.3937 inches)

L4: Cut size when in cut 
mode

101.6 mm (4 inches) or more
However, if the length of one label is less than 101.6 mm 
(4 inches), then the shortest length is 101.6 mm (4 inches) 
as multiple sheets are cut

L5: Upper edge cutting 
margin

1.7 mm (0.067 inches)

L5': Position of leading 
edge of paper

1.2 to 4.0 mm (0.0472 to 0.1575 inches)
Length of leading margin when paper is loaded

L6: Lower edge cutting 
margin

1.3 to 8.3 mm (0.051 to 0.3268 inches)

BW: Black mark width More than 5 mm (0.197 inches) from edge of paper;
maximum is width of paper W1 from edge of paper

BL: Black mark length 3 mm (0.12 inches) or more Upper edge is the same as 
position of leading edge of label

A: Top margin 2.12 mm (0.0835 inches) or more

B: Bottom margin 2.12 mm (0.0835 inches) or more

C: Left margin 2.12 mm (0.0835 inches) or more

D: Right margin 2.12 mm (0.0835 inches) or more

Item Specification
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Full sheet labels (normal printing)

Item Specification

Paper weight 0.07 to 0.25 mm (0.003 to 0.0098 inches)

Roll core Inner diameter: 76.2 mm (3 inches)

Outer diameter 203.2 mm (8 inches) or less
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Other W1: Liner width 29.4 to 130 mm (1.1575 to 5.12 inches)

W2: Label width 25.4 to 126 mm (1 to 4.9606 inches)

W5: Left liner area (dry 
edge)

2 to 25.4 mm (0.0787 to 1 inch)

W6: Right liner area 
(dry edge)

2 to 25.4 mm (0.0787 to 1 inch)

L2: Paper length 12.7 to 1320.8 mm (0.5 to 52 inches)

L4: Cut size when in cut 
mode

101.6 mm (4 inches) or more
However, if the length of one label is less than 101.6 mm 
(4 inches), then the shortest length is 101.6 mm (4 inches) 
as multiple sheets are cut

L5: Upper edge cutting 
margin

2.12 mm (0.0835 inches)

L6: Lower edge cutting 
margin

2.12 mm (0.0835 inches) or more

A: Top margin 2.12 mm (0.0835 inches) or more

B: Bottom margin 2.12 mm (0.0835 inches) or more

C: Left margin 2.12 mm (0.0835 inches) or more

D: Right margin 2.12 mm (0.0835 inches) or more

Item Specification
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Full-sheet labels (printing on large size paper)

Item Specification

Paper weight 0.07 to 0.25 mm (0.003 to 0.0098 inches)

Roll core Inner diameter: 76.2 mm (3 inches)

Outer diameter 203.2 mm (8 inches) or less
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Other W1: Liner width 29.4 to 130 mm (1.1575 to 5.12 inches)

W2: Label width 25.4 to 126 mm (1 to 4.9606 inches)

W5: Left liner area (dry 
edge)

2 to 25.4 mm (0.0787 to 1 inch)

W6: Right liner area 
(dry edge)

2 to 25.4 mm (0.0787 to 1 inch)

L2: Paper length 12.7 to 1320.8 mm (0.5 to 52 inches)

L4: Cut size when in cut 
mode

101.6 mm (4 inches) or more
However, if the length of one label is less than 101.6 mm 
(4 inches), then the shortest length is 101.6 mm (4 inches) 
as multiple sheets are cut

L5: Upper edge cutting 
margin

2.12 mm (0.0835 inches)

L6: Lower edge cutting 
margin

1.5 mm (0.0591 inches)

A: Top margin 0 mm (0 inches)

B: Bottom margin 0 mm (0 inches)

C: Left margin 2.12 mm (0.0835 inches) or more

D: Right margin 2.12 mm (0.0835 inches) or more

Item Specification
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Full-sheet label paper (with black marks)

Item Specification

Paper weight 0.07 to 0.25 mm (0.003 to 0.0098 inches)

Roll core Inner diameter: 76.2 mm (3 inches)

Outer diameter 203.2 mm (8 inches) or less
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Other W1: Liner width 29.4 to 130 mm (1.1575 to 5.12 inches)

W2: Label width 25.4 to 126 mm (1 to 4.9606 inches)

W5: Left liner area (dry 
edge)

2 to 25.4 mm (0.0787 to 1 inch)

W6: Right liner area 
(dry edge)

2 to 25.4 mm (0.0787 to 1 inch)

L1: Black mark interval 15.9 to 1324.0 mm (0.626 to 52.126 inches)
* The black marks contain carbon.

L2: Paper length 12.7 to 1320.8 mm (0.5 to 52 inches)

L4: Cut size when in cut 
mode

101.6 mm (4 inches) or more
However, if the length of one label is less than 101.6 mm 
(4 inches), then the shortest length is 101.6 mm (4 inches) 
as multiple sheets are cut

L5: Upper edge cutting 
margin

1.7 mm (0.067 inches)

L5': Position of leading 
edge of paper

1.2 to 4.0 mm (0.0472 to 0.1575 inches) Length of leading 
margin when paper is loaded

L6: Lower edge cutting 
margin

1.5 mm (0.0591 inches)

BW: Black mark width More than 5 mm (0.197 inches) from edge of paper;
maximum is width of paper W1 from edge of paper

BL: Black mark length 3 mm (0.12 inches)

A: Top margin 2.12 mm (0.0835 inches) or more

B: Bottom margin 3.2 mm (0.126 inches) * In practice, it is the length of the 
gap

C: Left margin 2.12 mm (0.0835 inches) or more

D: Right margin 2.12 mm (0.0835 inches) or more

Item Specification
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